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Documentation Updates

The title page of this document contains the following identifying information:
e Software Version number, which indicates the software version.

e Document Release Date, which changes each time the document is
updated.

e Software Release Date, which indicates the release date of this version of
the software.

To check for recent updates or to verify that you are using the most recent
edition of a document, go to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and signin. To register
foran HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html
Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the
appropriate product support service. Contact your HP sales representative for
details.
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Support

Visit the HP Software Support Online web site at:
http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products,
services, and support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It
provides a fast and efficient way to access interactive technical support tools
needed to manage your business. As a valued support customer, you can
benefit by using the support web site to:

e Search for knowledge documents of interest

e Submit and track support cases and enhancement requests
e Download software patches

e Manage support contracts

e Look up HP support contacts

e Review information about available services

e Enterinto discussions with other software customers

e Research and register for software training

Most of the support areas require that you register as an HP Passport user
and sign in. Many also require a support contract. To register for an HP
Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html
To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Creating Application
Components

Concepts

e "Creating Application Components Overview" on page 15

e "Application Component Design" on page 16

e "The Application Component Tree Hierarchy" on page 19
Tasks

e "How to Define Components " on page 22

Reference

e "ALM Direct Links " on page 25

e "Application Components Module User Interface" on page 27
e "Alerts Dialog Box" on page 28

e "Details " on page 30

e "Interaction Tab" on page 33

e "Find Dialog Box" on page 37

e "Modeling Tab" on page 39

e "Dependency Details Dialog Box" on page 44

e "New Folder Dialog Box" on page 46

e "New Application Component Dialog Box" on page 47

e "Application Components Module Icons " on page 51

e "Application Components Module Window" on page 52

e "Application Components Module Menus and Buttons" on page 54

"Troubleshooting and Limitations - Application Components" on page 59
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Concepts

This section includes:
e "Creating Application Components Overview" on page 15
e "Application Component Design" on page 16

e "The Application Component Tree Hierarchy" on page 19
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Creating Application Components
Overview

You add entities to the Application Components tree by manually adding a
new components. After you add a component, you can describe it through a
contract.

Once you define application components, you can link them to requirements.
This linkage allows you to connect the component to other Application
Lifecycle Management entities, such as tests, test sets, and defects.

This section also includes:

e "The Application Component Tree Hierarchy" on page 19
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Application Component Design

Stage 1 - Prepare to collaborate

The QA (Quality Assurance) and Dev (Software Development) managers
prepare to collaborate in describing the components or the AUT (Application
Under Test).

QA will use that information to track changes, execute tests, and report on the
quality of the product.

Stage 2 - Set a methodology

Set a methodology to describe the application:

e What are the application areas in the AUT, to be translated into folders in
the component hierarchy?

e What will constitute a component? For example, only high-level interfaces
may be considered components, or its centrality or importance in the
application?

e What component types to define? This could be based on technology,
usage, and so forth.

e What fields (and possibly UDF) to associate with the component types?

Stage 3 - Quality policies

Determine quality policies to be implemented through rules and testing
aspects. These policies are necessary to insure that components are tested
based with the correct data.

Stage 4 - Create a project and customize it

Create an Service Test Management project or enable the extension on an
existing ALM project. Open Customization and define component types and
their fields, as well as UDFs for component and changes. Define the
necessary rules and testing aspects.

Stage 5 - Create the application components

Open the Application Components module and create a folder structure to
represent the application areas decided on above. Create component groups
for cross-area functionality or deployment. If possible, define high-level
components based on the planned strategy. If not possible, the developers
can define them at a later time.

Page 16 HP Service Test Management (11.50)



Service Test Management User Guide

The projectis ready for the QA and the software development teams may
begin using it.

Stage 6 - Report changes to QA

Developers use the IDE add-on to report changes back to QA. Developers
implement requirements and fix defects. They can create new components or
application areas as required. These actions will be reported to Service Test
Management and assigned to an existing or new application component. They
can also be linked to the work item such as a requirement or defect, if one
exists.

W hen making changes, developers describe their risk to QA, to assist them in
their testing.

Developers may report a change while still in the process of enacting the
change. This allows QA to prepare for testing the change. Optionally, the
developers can wait until the change has been completed before reporting it to
QA.

Stage 7 - QA processes changes

Before changes are gathered, QA can begin reviewing the application
components and assignh requirements and tests.

QA engineers can create new component groups to facilitate the management
of the components.

After changes are generated, Service Test Management marks the changed
components with alerticons and lists them in the Changes tab. QA uses the
information in the Interaction tab to create tests for the changed components,
using the change description to verify the coverage. During this process, QA
can set the following fields:

e Change status to /n test.

e Assigned to developerto determine the developer regarding an aspect of
the component's functionality.

e Created by in the Change tab, to determine the developer who is
responsible for updating the component's functionality.

QA can see the changes for one or more components:

e Select a component to view the changes specific to that component, and
review its Changes tab,
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e Selectagroup or folder to view an aggregated list of changes in the
Changes tab. The Changes grid provides the context of the change which
can assist QA in understanding the issue.

Stage 8 - Run tests

QA executes tests on the AUT in the testing environment. Based on the test
results, they can set the status to verified or keep the In test status. if a
change was tested it is considered verified, even if causes defects in the
component.

Stage 9 - Reporting

QA uses the graphs and reporting capabilities to summarize the status of the
components of the AUT and the changes. They send this report back to the
development team. The developers can decide how to act upon QA's
recommendations.

The on-going reporting should show a trend of more changes being verified in
less time, and a downward trend in the number of defects on the components.

In conclusion, the Application Components module allows QA and the
developers to verify the quality of the AUT in a comprehensive fashion.
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The Application Component Tree
Hierarchy

Service Test Management provides you with tools to define components and
modify their details.

You organize your application components in a graphical hierarchy.

At the top level of the tree is the Application Components root folder, which
contains sub folders. You can create custom folders that represent the
structure of components in your application. For example, you might create
separate folders to represent different types of users.

You can reorganize related entities in folders and subfolders, and drag and
drop folders or subfolders to other locations in the tree.

The Obsolete folder contains components that were removed, but are still
being used by tests stored in Application Lifecycle Management. For details
about the Obsolete folder, see "How to Manage Components " on page 95.

You cannotrename, move, or delete the Application Components root or
Obsolete folders.

Component Dependencies

Component dependency defines a relationship between two or more
components. As the operations of these linked components change, you can
detect changes and track their impact on the linked components.

You can define the dependencies using Service Test Management's
Modeling tab. The Modeling tab displays a diagram of the component
dependencies.

An arrow indicates a dependency:

e An arrow pointing to the base component, indicates a Dependency From
another component—the added component impacts the base component.

e An arrow pointing away from the base componentindicates a Dependency
To another component—-the added componentis impacted by the base
component.
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You select components and add them to a modeling diagram. In the following
example, the DataType component is dependent on both NTLMAuth and
BasicAuth.

J;;r Select | 3 | = | Yo@ &

i i >
NTLMAuth DataType BasicAuth

Although you add dependent components onto the canvas, the dependencies
are per operation. For details, see "How to Define Components " on page 22.
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Tasks

This section includes:

e "How to Define Components " on page 22
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How to Define Components

This task describes how to set up your components in Service Test
Managements. After you set them up, you can test them and check their
functionality and compliance.

This task includes the following steps:

e Create a folder - optional

e Create anew component

e Specify a contract

e Import multiple components - optional

e Define dependencies - optional
Create a folder - optional

£i Click the New Folder button to open the New Folder dialog box. Add new
folders and subfolders to create a tree hierarchy for your components. For

details, see the "New Folder Dialog Box" on page 46.

You can create folders at any time and drag or copy components from folder
to folder.

Create a new component

Select Components > New > New Component to create an new
component. Select a component type and provide whatever details are
available to you. For details, see the "New Application Component Dialog
Box" on page 47.

Specify a contract

In the New Application Component Dialog Box, click the Interaction link in the
left pane. Click Browse to locate a contract file. For details, see the "New
Application Component Dialog Box" on page 47.

Import multiple components - optional

Select Components > Generate Components to open a wizard, which
guides you how to import multiple contracts at once. For details, see
"Generate Components Wizard" on page 102.
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Define dependencies - optional

1. Selectthe Modeling tab. For a description, see the "Modeling Tab" on
page 39.

2. Click the Select Entities button to open the Components list in the right
pane. Expand the folders and select a component.

3. Click the arrow © to open the transfer menu.

a. Toadd acomponent thatis dependent on the base component, click
Add Component Dependency (Dependency To).

b. Toadd acomponentupon which the base componentis dependent, click
Add Component Dependency (Dependency From).

The Dependency Details dialog box opens. Select the operation that affects
the dependency. If you do not know which operation to select, specify all of
them. For details, see the "Dependency Details Dialog Box" on page 44.
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Reference

This section includes:

e "ALM Direct Links " on page 25

e "Application Components Module User Interface"” on page 27
e "Alerts Dialog Box" on page 28

e "Details " on page 30

e "Interaction Tab" on page 33

e "Find Dialog Box" on page 37

e "Modeling Tab" on page 39

e "Dependency Details Dialog Box" on page 44

e "New Folder Dialog Box" on page 46

e "New Application Component Dialog Box" on page 47
e "Application Components Module Icons " on page 51

e "Application Components Module Window" on page 52

e "Application Components Module Menus and Buttons" on page 54

Page 24 HP Service Test Management (11.50)



Service Test Management User Guide

ALM DirectLinks

You can use direct links to access specific views and components. You enter
the direct link into your browser to access the desired view. You can save
these links for future reference, or send them to others by e-mail so that they
may access a specific view or component.

When working with Systinet, you can use a direct link to access the import
screen, enabling you to locate services quickly.

The direct links use the following form at:
td://<project name>.<domain>.<server:port>/gcbin/

The following table describes the shortcut syntax to be added to the above
string. ltalic text indicates optional parameters.

View Description

Systinet 100?Action=ImportSystinet&SystinetID=
Import [SYSTINET_
KEY]&Environment=<ENVIRONMENT>&Uuid=<UUID>

Component | StmModule--00000000000031306742797
EntityType=IStm Service&EntitylID=<component
id>&View=<service tab type>

<component tab type> values:
e Changes

e Modeling

e TestingStatus

e AspectStatus

e OperationStatus

e StatusDashboard

Component | StmModule--00000000000031306742797
Group EntityType=IStm Group&EntitylD=<group id>&View=<group
tab type>

<group tab type> values:
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View Description

Modeling
TestingStatus
AspectStatus

StatusDashboard
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Application Components Module User
Interface

Service Test Management provides a user interface to organize your
application components and customize the ALM project hosting them.

This section includes:

"Alerts Dialog Box" on page 28

e "Details "on page 30

e "Interaction Tab" on page 33

e "Find Dialog Box" on page 37

e "Modeling Tab" on page 39

e "Dependency Details Dialog Box" on page 44

e "New Folder Dialog Box" on page 46

e "New Application Component Dialog Box" on page 47
e "Application Components Module Icons " on page 51

e "Application Components Module Window" on page 52

e "Application Components Module Menus and Buttons" on page 54
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Alerts Dialog Box

This dialog box displays all alerts and rule violations associated with the
selected component and enables you to resolve or disregard them.

I Alerts

Alerts for XSD_NTLM

Changes ® show

: Changes Alert

This component has undergone changes that require wour attention. We recommend that wou run the
Create Change Impact Test Set utility.

To access Click the red exclamation point ! ,adjacent to the
component name in the Application Components tree.

Relevant tasks "How to Perform Change Analysis " on page 276

See also "Change Analysis "on page 267

The following elements are included (unlabeled Ul elements are shown in
angle brackets):

Ul Elements Description

(A-Z)

& Removes the current rule violation in the Rule Violations
pane:

Note: When clearing a rule violation, Service Test
Management disregards it— it does not delete it.

Alerts for A link to the componentin the Application Components tree.
<component
name>

Changes An expandable/collapsible list of all change alerts specific to
the selected component. Indicates a change to the
component file since its last import or update.
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Ul Elements

(A-2)

Clear

Description

Clears all rule violations in the Rule Violations pane:

Note: When clearing the rule violations, Service Test
disregards them—it does not delete them.

Resolve

For rule violations, this button opens the Create
Requirements Test wizard in order to resolve the violation.
For details, see the "Generate Requirements and Tests
Wizard" on page 185.

Rule
Violations

An expandable/collapsible list of all rule violations for the
selected component. A common rule violation is missing
coverage for a testing aspect.

Show

For change alerts, this button opens the Changes tab listing
all of the changes. Use the Create Test Set utility to resolve
the changes.

For details, see the "Create Change Impact Test Set
Wizard" on page 292.
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Details

This tab displays and enables you to edit a component's details.

Details | Interaction | Testing Status # | Changes * | Modeling * | Aftachments

* Componen... | XSD_NTLM | *req 123414 |
Assigned to... |jonesj =|w| Assionedio.. | |=]
Component... |15 | Component... | wWeb Service |
Created by. | admin =] Creation date: | 1/16/2011 |
Developmen .. | |v | Keep upto. . |N |v |
Last updated: | |=| Update time: | |
Visibility: ' Internal > |

To access

Do the following:
1. Open the Application Components module,
2. Highlight a folder, component, or group

3. Click the Details tab.

Important
inform ation

The Details tab fields differ, depending on the entity you
select: folder, component, or group, and the component type.

Relevant "How to Manage Components " on page 95
tasks
See also "Modeling Tab" on page 39

Details Tab for Components

The following elements are displayed when you select a componentin the

Application Components tree.

Ul Elements

Description

(A-Z)
<user- User-defined fields defined in customization. The required
defined> fields are displayed in red text.
Assigned to The name of the developer to whom the component
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Ul Elements Description

(A-Z)

Dev implementation is assigned.

Assigned to The name of the QA engineer responsible for validating
QA the component.

Authentication | Use the default user credentials: Y or N.
default
credentials

Authentication | The user name to use for authentication when accessing
user name the contract file.

Component ID | Aread-only ID assigned to the component.

Component The native component name as provided by the user.
name

Component The type of component. The built-in components are
type name General, Web Service, and JMS. If you defined a new

component type, it will be displayed.

Created by The name with which you logged in. You can edit this field
and specify a different name. This is useful for sorting the
components in reports.

Creation date The date the component was created in the Component
tree.

Development The development status of the component: Development,

status Maintenance, QA ready, or Stable.
Keep up to Keep the component up to date: Y or N. When enabled,
date instructs Service Test Management to update the

component from its source each time you select it in the
Application Component's tree.

Last updated The last time the component was updated.

Visibility The component's visibility level—Internal or External.

Details Tab for Groups

The following elements are displayed when you select a group in the
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Application Components tree.

ul Description

Elements

(A-Z)

Assigned The name of the user to whom the group implementation is
to assigned.

Created by | The name with which you logged in. You can edit this field and
specify a different name. This is useful for sorting the groups

in reports.
Creation The date the group was created in the Application
date Components tree.

Description [ A description of the group.

Name The name of the group.

Details Tab for Folders

The following elements are displayed when you select a folder in the
Application Components tree:

Ul Elements (A-Z) Description

Folder ID A read-only ID assigned to the folder.
Name The folder name in the Application Components tree.
Description A meaningful description of the folder.

Page 32 HP Service Test Management (11.50)



Service Test Management User Guide

Interaction Tab

The Interaction tab displays the component's contract details and allows you
to edit them. For Web services, this tab contains additional information about

the WSDL and

Details | Interaction | Testing Status | Aftachments | Changes | Modeling

Contract Details

Contract file:
Import type:
Service address:
Interaction Fields

WEDOL nati...

the Spot Tester to test the functionality of an operation.

| hitp:flocalhost8731 AwciService sl |

|URL |

| hitp:fflocalhost 8731 M cfService/mutualCert

| [ Owerride address

WefService |

Operations

5 [ Web Serice Call.. & Security &2 Ping Server

Name Descrintion
- & Port: mutualCert

H- @ Part mutualCertwse2vysal408

- & Port mutualCertTripleDES

H- & Part narmal

- & Fort mutualCertése3

B @ Port wsHttpWindowsNego

B & Port ananymousClient

information

To access Do the following:
1. Open the Application Components module.
2. Highlight a folder, component, or group.
3. Click the Interaction tab.
Important Only available when selecting a component in the tree. The

information differs depending on the component type:

Relevant "How to Manage Components " on page 95
tasks
See also "Modeling Tab" on page 39.
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The Interaction tab contains the following information:

Ul
Elements

(A-2)

Contract
Details

Description

e Contract file. The location of the contract file defining the
application component.

e Browse. Opensthe Open File or Import Service dialog
box—visible for new components whose contracts have not
yet been defined.

e Update from. Opens the Open File dialog box. For Web
Services, it opens the or Import Service dialog box—visible
for components whose contracts have already been
defined.

For more details, see the relevant section:
e "Import Service Dialog Box " on page 78.
e "Select Service from Systinet Dialog Box" on page 72

e "Select Service from UDDI Dialog Box" on page 74

Contract
Details -
Web

Services

e Import type. Contractimport method: File, URL, Systinet,
orUDDI.

e Toolkit. The toolkit associated with the Web service. You
set this in the Customization settings, and it is read-only.

e Service Address. The service deployment location to
which service requests are sent. By default, it displays the
endpoint address specified in the WSDL file.

e Override Address. Enables you to enter an alternate
endpoint for the service in the Service Address box.

Interaction
Fields -
Web
Service

WSDL Native Name. The name of the Service as it appears
in the contract file.

This section will also include any fields you designated in the
Customization for the component type. For details, see
"Component Types Tab" on page 257.
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Ul
Elements

(A-Z)

Interaction
Fields -
JMS

Description

JMS connection factory. The JNDI name of the JMS
connection factory. This setting is unique per test.

JMS destination. The name of the JMS destination—
either the queue or topic name.

JMS provider. The JMS service provider: Apache
ActiveMQ, JBoss Messaging from JBoss, Open Message
Queue, Websphere MQ from IBM, and so forth.

JNDI initial context factory. A The fully qualified class
name of the factory class that will create an initial context.
Provides a list of context factories and allows manual
entries.

JNDI provider URL. The URL of the service provider. For
example: Websphere - iiop://myserver:myport

Messaging Model. The type of JMS message—Point to
Point, or Publish and subscribe.

Operations

& Refresh. Reloads the list of operations.

Web Service Call. Opens the Run <operation-name>
dialog box to send a test request to the server. For details,
see the "Manual Runner Window" on page 83. Note: This
option is only available if Service Test or the Service Test
add-in is installed on the machine.

Security. Opens the Security Setting for Operation
<Operation Name> dialog box, to configure the security
properties for the Web service. For details, see "Web
Service Security " on page 103

Ping Server. Pings the server at the Service address URL
and opens a popup indicating its status: Available or

Unavailable.

<Port/Operation list>. A list of the ports for the selected
application component. Expand the port to see the available
operations.
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Interaction Tab for UDDI and Systinet Services

For services imported through UDDI or Systinet servers, the Interaction tab

shows several additional read-only fields:

Ul Elements Description

(A-Z)

Systinet The URL address and port of the Systinet server from
Server which the service definition is imported.

UDDI Server The URL address and version of the UDDI server from
which the service definition is imported

UDDI/Systinet | A unique identifier of the service on the UDDI or Systinet
Key server, used to locate the service definition when updating
the service

Page 36 HP Service Test Management (11.50)



Service Test Management User Guide

Find Dialog Box

This dialog box enables you to search for a component, group, or folder within
the Application Components tree.

Find

Entity Twpe: |App|i|:atic:n Component |v |
Find in Field: |C0mp0nentname |v |
value to Find: | XSD_NTLM |
hatch Criteria
[T Exact Match [ Use Wilildcard

[ Case Sensitive

To access Select Edit > Find.
Relevant tasks "How to Manage Components " on page 95
See also "How to Manage Components " on page 95

The following elements are included (unlabeled Ul elements are shown in
angle brackets):

ul Description

Elements

(A-Z)

Entity Type of entity in which to perform the search: Folder,
Type ApplicationComponent, or Group.

Find In The field within the Details tab upon which to perform the
Field search. The available fields differ for a folder, group, or
component.

For information about the fields in the Details tab, see "Details "
on page 30.

Page 37 HP Service Test Management (11.50)



Service Test Management User Guide

ul Description

Elements

(A-Z)

Find Searches for the next occurrence of the text, based on the

Next previously used settings.

Less Collapses the Find dialog box to hide the match criteria.

Match Advanced match criteria:, visible when you click More.

Criteria . . .
e Exact Match. Looks for the exact string— not a partial string.
e Case Sensitive. Performs a case sensitive search.
e Use Wildcard. Applies wildcard rules to the search text.

More Expands the Find dialog box to show the match criteria.

Value to | The textto find in the component, group, or folder.

Find
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Modeling Tab

This tab displays component dependencies or component/group relationships
in a visual representation. If you select a folder, it shows all associations and
dependencies in groups and components beneath that folder.

This tab enables you to associate components with one another and assign
them to component groups.

/ NTLMAUth\

& i )
BasicAuth XSD_Basic

To access

Do the following:
1. Openthe Application Components module.
2. Highlight a folder, component, or group.

3. Click the Modeling tab.

Important
information

To display an up to date and complete modeling view, make
sure to refresh the canvas and resize it to show all of the
components.

Relevant e "How to Define Components " on page 22

k
tasks e "How to Manage Component Groups " on page 170
See also "Component Dependencies" on page 19

User interface elements are described below (unlabeled Ul elements are
shown in angle brackets):

Ul Elements (A-Z) Description

® Delete. Removes the selected entity from the visual
area. You cannot delete the base component or group
that is selected in the left pane's Component tree.

= Refresh. Redraws the visual diagram in the visual
area.

Page 39

HP Service Test Management (11.50)



Service Test Management User Guide

Ul Elements (A-Z) Description

¥ Arrange layout. Arranges the layout of all entities in

the current modeling window, in a symmetric fashion.

&, Zoom in. Enlarges the entities in the current drawing.

=k Zoom out. Reduces the size of the entities in the
current drawing.

<modeling A visual area showing component dependencies or
canvas> component/group relationships in a graphical
representation.

Application Details of the component or group selected in the
Component/Group | modeling window.
Details . .
e Forcomponent details, see "Modeling Tab" on
previous page.
e For group details, see "Modeling Tab" on previous
page.
Select Opens the Application Components Tree tab in the

right pane to add more component or groups to the
modeling window. For information about the tree
hierarchy, see the "Modeling Tab" on previous page.

Application Components Tree

The following elements are included (unlabeled Ul elements are shown in
angle brackets):

Ul Elements Description

(A-Z)

“- Add. Opens a drop down list with the following options:

e Associate.Associates the selected component with a
group.

e Add Component Dependency (Dependency To)
e Add Component Dependency (Dependency From)

Note: The Associate option is enabled when you select a
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Ul Elements

(A-Z)

Description

group in the right pane. The Add Dependency options are
enabled when you select a componentin the right pane.

For details about dependencies, see the "Dependency
Details Dialog Box" on page 44.

Q

Refresh. Refreshes the Application Components tree.

FInd.Opens the Find dialog box to search for an
application component by its name.

Set/Clear Filter. Opens a drop down list with the following
options:

e Set Filter / Sort. Opens the Set Filter/Sort dialog box
allowing you to filter and sort the components.

e Clear Filter / Sort. Clears all filters and sorting settings
and displays all components and groups.

Go To Application Component. Goes to an application
component based on its Component ID. The ID is visible in
the Details tab.

Exit. Closes the Application Components Tree panel.

To reopen this view, click the Select button in the
Modeling tab.

<Components
List>

An expandable list of all components by folder and group.

Tip: If a filter is active, there could be hidden components.
To see all components, click Clear Filter.

Application Component Details Pane

The following elements are displayed in the bottom pane of the Modeling tab,

when you select a component in the modeling drawing.
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Ul Elements

(A-Z)

Description

<user- User-defined fields defined in customization. Required
defined> fields are displayed in red.

Assigned to | The name of the developer to whom the component

Dev implementation is assigned.

Assigned to | The name of the QA engineer responsible for validating the
QA component.

Component
ID

A read-only ID assigned to the component.

Component
name

The native component name in the definition files.

Component
type name

The type of component: General, Web Service, and JMS.
If you defined a new component type in Customization, it
will be displayed.

Created by The name with which you logged in. You can edit this field
and specify a different name. This is useful for sorting the
components inreports.

Creation The date the entity was created in the Application

date Components tree.

Development
status

The development status of the component: Developm ent,
Maintenance, QA ready, or Stable.

Has changed

Y or N. Yes indicates that the definition files (for example,
WSDL), changed since the last update.

Keep up to
date

Y or N. When enabled, updates the contract from its source
each time you select the componentin the Application
Component's tree.

Last updated

The last time the WSDL was updated.

Update time

The time the contract was updated.

Visibility

The visibility of the application component: Internal or
External.
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Group Details Pane

The following elements are displayed in the bottom pane of the Modeling tab,

when you select a group in the modeling drawing.

ul Description

Elements

(A-Z)

Assigned | The name of the user to whom the group implementation is
to assigned.

Created The name with which you logged in. You can edit this field and
by specify a different name. This is useful for sorting the groups in

reports.

date

Creation | The date the group was created in the components tree.

Name The name of the group.

Component Dependency Details Pane

The following elements are displayed in the bottom pane of the Modeling tab,
when you select a dependency arrow between two components, in the

modeling canvas.

Ul Elements

(A-2)

Description

Edit. Opens the Dependency Details dialog box for editing
the entry selected in the Dependency list.

X Delete Delete. Removes the selected dependency.

s Refresh. Reloads the Dependency list.

< A list of the dependencies between the components
Dependency | connected by the selected arrow.

list>

New Opens the Dependency Details dialog box for defining a new

dependency between the components. For details, see
"Dependency Details Dialog Box" on page 44.
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Dependency Details D

This dialog box enables you to set the de
modify existing ones.

Dependency Details

"sD_MNTLM" Operation:
A

=]

Calls To "BasicAuth" Operation:

EchoBooleanArrayByRet

HI=IE

ialog Box

pendencies between components or

To access In the Modeling tab:

dependency. The dialo

For an existing depe

dependency, and click

For a new dependency: Click Select to show the list of
application components in the right pane. Select a

component and click the Add button < to create a new

g box opens autom atically.

ndency: Click in the lower

Component Dependency Details pane, select a

the Edit button =% .

Important

information L
e An arrow pointing to th

e An arrow pointing awa

An arrow indicates a dependency:

e base componentindicates a

Dependency From another component—the added
componentimpacts the base component.

y from the base componentindicates

a Dependency To another component—-the added
componentisimpacted by the base component.

Relevant
tasks

"How to Define Components " on page 22

The operation selected in the upper field

, must call the operation selected in

the lower, Calls to, field. The user elements are described below:
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Ul Elements (A-Z) Description

<component_name> | A specific operation of the dependent component.

Operation o
e For Dependency To, this is the component

selected in the main Application Components
tree.

e For Dependency From, this is the component
selected in the components listin the right pane.

Tip: Choose All if you are unsure.

Calls to A specific operation of the called component.
<component_name>

. e ForDependency To, this is the component
Operation

selected in the components list in the right pane.

e ForDependency From, this is the component
selected in the main Application Components
tree.

Tip: Choose Any if you are unsure.
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New Folder Dialog Box

This dialog box page enables you to create a new folder in the Application
Components tree.
New Folder

Folder Mame:

|MyTest Folder |

To access Do one of the following:

e Click the New Folder Eiputton.

e Select Components > New > New Folder.

Important A folder name cannotinclude any of the following
information characters: \/ *
Relevant tasks "How to Define Components " on page 22

User interface elements are described below:

ul Description

Elements

(A-Z)

Folder A name for the new folder, beneath the folder selected in the
Name Application Components tree. You can create several levels of

sub-folders.

Tip: Add a description to the folder in the Details tab.

OK Adds the new folder to the Application Components tree.
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New Application Component Dialog Box

This dialog box enables you to create a new component.

% New Application Component !E
X | % B B .
Component 10: | | * Component narme: I:I* Cormponent type: |General |v |
& Details Details |
= Interaction
§ Attachments Assignedto... | = Assignedto... | =]

Developme ... | | v | Last updated: | |v |
Visitility: | =]

s

Description | Camments

To access Use one of the following:
e SelectComponents > New > New Component.

e Select New > New Component from the shortcut
menu.

Relevant tasks | "How to Define Components " on page 22

The following elements are included:

ul Description
Elements

(A-Z)

X Clear All. Clears all the fields so that you can redefine the
component.
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ul Description

Elements

(A-Z)

¥ Spell Check. Begins a spell check inthe Component name
field.

e Thesaurus. Performs a thesaurus lookup for the term
highlighted in the Component name field.

B Spelling Options. Opens the Spelling Options dialog box for
customizing the spell check in the following areas
e Ignore words in UPPERCASE
e Ilgnore words containing numbers (enabled by default)
e Ignore markup languages (HTML, XML, etc.)

e Ignore Internet addresses (enabled by default)
e Prompt on repeated word (enabled by default)
You can also select the main dictionary and a custom one.

[z Details pane. The component's properties. The displayed
fields differ based on the component type and the fields
enabled in the customization section. For details, see the
"Component Types Tab" on page 257. Some common fields
are:

e Assigned to Dev

e Assigned to QA

e Created by

e Development Status: Development, Maintenance, QA
ready, or Stable.

e Last Updated

e Visibly: External or Internal

» Description tab. An editable area for a description of the
component.

= Comments tab. An editable area for adding remarks.

= Interaction pane. Contract information.
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Ul
Elements

(A-Z)

Description

The displayed fields differ based on the component type and
the fields enabled in the customization section. To display a
field in this section, select it in the customization's
Interaction Field column. For details, see the "Component
Types Tab" on page 257.

e Contract File. The location of the contract.
e Browse button.

m Fornon-Web Service components, opens the Open File
dialog box.

m For Web Services, opens the Import Service dialog box.
For details, see "Import Service Dialog Box " on page 78.

e Operations. A list of the component's operations.

e Parameters. The component's parameters sorted by the
following columns: In/Out, Parameter Name, and Type
(data type).

= for JMS
types

e JMS connection factory. The JNDI name of the JMS
connection factory. This setting is unique per test.

e JMS Destination. The name of the JMS destination—
either the queue or topic name.

e JMS Provider. The JMS service provider: Apache
ActiveMQ, JBoss Messaging from JBoss, Open Message
Queue, Websphere MQ from IBM, and so forth.

e JIJNDI initial context factory. The fully qualified class
name of the factory class that will create an initial context.
Provides a list of context factories and allows manual
entries.

e JNDI provider URL. The URL of the service provider. For
example:

Websphere - iiop://myserver:myport

e Messaging Model. The type of JMS message— Point to
point, or Publish and subscribe.
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Ul
Elements

(A-Z)

Description

Attachments pane. Allows you to attach a file to the
component. For details, see the HP Application Lifecycle
Management User Guide.

Component
ID

A read-only value assigned to each application component.

Component
name

A name for the component. Use the Spell Check or
Thesaurus buttons for the textual strings.

Component

The type of component to create: General, Web Service, or

type JMS. If you created a custom type componentin
Customization, it also appears in the drop down list.
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Application Components Module Icons

This section describes the icons available in the Application Components

module.
To Click the Application Components button on the ALM
access sidebar.

See also e "Application Components Module Window" on page 52

e "Application Components Module Menus and Buttons" on
page 54

The icons are described below:

ul Description

Elements

! Alert. Click to view a summary of the following alert types:
e Changes. The component definition has changed.
e Rule Violations. The component violates a rule.

For more details, see the "Alerts Dialog Box" on page 28.

= Folder. A folder for organizing components.

i Obsolete folder. Contains components that were deleted that
may affect other components.

& Web Service type. A Web Service type application component.
S General type. A General type application component.

B JMS type. A JMS type application component.

i Application Component group.
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Application Components Module
Window

This section describes the Application Components module window.

iz Dashboard ¥ Components  Edit “iew Analysis :I
& Managem... ¥ ‘F_l B % | TP Details| Interaction | Testing Status | Aftachments | Changes  Modeling
Bresesz || comp. creae. [ammn [
. . elease_.
A [ [«
. g BasicAuth Keep... M Lastu...
b {5 %S0 _Basic
& XSO_MNTLM
:NTLM_Default Description | Comments | Contract Description

{5 Updated_chang S " ”

i+ General_sample BI UA a-—']|| =S ETE | P | ). | H 9

£5 IMS_sample

Group_sample
To access Click the Application Components button on the ALM
sidebar.
Relevant "How to Manage Components " on page 95
tasks
See also e "Application Components Module Icons " on page 51
e "Application Components Module Menus and Buttons" on
page 54

User interface elements are described below:

Ul Elements Description

(A-2)

<toolbar and Provides menus and toolbar buttons specific for the
menu> Application Components module. For details, see the
"Application Components Module Menus and Buttons" on
page 54.

<Components | Shows a tree hierarchy of all the components, component
Tree> groups, and folders. For details, see "Application
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Ul Elements

(A-2)

Description

Components Module Icons " on page 51.

Attachments
tab

Lists the files that have been associated with the selected
folder, component, or group as attachments. The tab
includes an icon « if the selected component has
attachments. For details, see the HP HP Application
Lifecycle Management User Guide.

Details tab

Displays general details and attributes of the selected
component, group, or folder. Displays data that is required
to identify the component, including the creation
information. For details, see the "Details " on page 30.

Changes tab

Lists the changes in the components. It also provides an
interface to define new changes that you made to the
components and create test sets to check their impact. For
details, see "Automatic Change Detection Through
Updates" on page 272.

Interaction
tab

Provides the component's contract details, such as the
W SDL location for Web Services. For details, see the
"Interaction Tab" on page 33.

Modeling tab

Provides an interface to graphically associate components
with groups, and to define dependencies between them.
For details, see "Modeling Tab" on page 39.

Testing
Status tab

Provides a coverage summary for aspects, requirements,
operations, tests, rule violations, and defects. For details,
see "Determining Test Coverage" on page 187.
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Application Components Module Menus

and Buttons

This section describes the menus and buttons available in the Application

Components module.

To access

Open the Application Components module on the

Application Lifecycle Management sidebar.

Important
information

All menu items are available from the right-click shortcut

menu.

Relevant
tasks

"How to Manage Components " on page 95

User interface elements are described below.

Ul Elements (A-2) Menu

Ei

Toolbar

Description

New Folder. Opens the New Folder
dialog box to create a folder under the
root or an existing folder.

&

Toolbar

New Component. Opens the New
Application Component dialog box.

Note: This area on the toolbar displays
the last button used: New Component
or New Group.

Toolbar

New Group. Opens the New Group
dialog box.

Toolbar

Delete. Deletes selected components.
Deleting a component also deletes its
children. You cannot delete the root
folder.

Q

Toolbar

Refresh All. Refreshes the Application
Components tree so that it displays the
most up-to-date versions.

Toolbar

Filter/Sort. Enables you to filter and
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Ul Elements (A-Z) Menu

Description

sort the requirements in the
requirements tree or grid. For more
details, see below.

Toolbar

Send By E-mail. Opens the Send E-
mail dialog box, enabling you to send
component URLs and other information
to recipients from a list or to the creator
of the component. Use this in
conjunction with Copy URL. For more
details, see the HP HP Application
Lifecycle Management User Guide.

Copy URL/Paste Edit

Copies a selected component and
pastes its URL as a link. The
component itself is not copied. Instead,
you can paste the address into another
location, such as an e-mail or a
document. Clicking the link opens ALM
and takes you to the requirement. If
you are not already logged in, ALM first
prompts for login details.

Copy/Paste Edit

Copies selected components within the
same project or across projects. When
you copy a folder, its sub-folders are
copied too.

Notes:

e Coverage and modeling data for the
component are not copied.

If you paste a component that has
the same name as an existing
component, the suffix _Copy_x is
added automatically to the end of the
name.

Create Empty Test [ Components

Opens the Create Empty Test dialog
box, prompting you for a location and
name. This is useful for testers who
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Ul Elements (A-Z) Menu

Description

know the required steps, but are
unfamiliar with the technical aspects of
creating tests.

Cut/Paste Edit

Moves selected componentto a
different location in the Application
Components tree.

Tip: You can also move a component
to a new location by dragging it.

Delete # Edit

Deletes the selected component.

Download Components

Contract File

Allows you to download a contract file
from ALM to a local file system.

Requirements/Test

Expand View Expands all or collapses the selected

All/Collapse branches in the Component tree.

Filter/Sort T - View Enables you to filter and sort
application components in the tree. For
more details, click the Help button.

Find Edit Searches for a componentin the
Application Components module.
For details, see "Find Dialog Box" on
page 37.

Generate Components | Opens the Generate Requirements and

Test wizard. For details, see
"Generating Requirements and Tests "

on page 176.
Graphs Analysis Generates one of the following graphs:

e Components Summary - Group
by 'Type’

e Changes Progress - Group by
'Risk’

e Changes Summary - Group by
'Risk
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Ul Elements (A-Z) Menu Description

e Changes Trend - Group by
'Status’

New Components | Enables you to create a new entity:

e New Folder. Enables you to create a
new folder in the Application
Components tree.

e New Group. Opensthe New Group
dialog box.

e New Component. Opens the New
Component dialog box.

Refresh All & View Refreshes the Component tree so that
it displays the most up-to-date
versions.

Rename Edit Renames the selected entity. You
cannotrename the root folder.

Syntax exceptions:

e Folder or group names cannot
include: \*A.

e Component names cannotinclude:\,

/! :1 "1 ?! ly <1 >! |1 *1 %1 !y{! Or}'
Restore Components | Restores a deleted component from
Component the Obsolete folder.
Send by = E-mail [Components | Opens the Send E-mail dialog box,

enabling you to send URLs and other
information to recipients from a list or
to the creator of the component. Use
this in conjunction with Copy URL. For
more details, see the HP Application
Lifecycle Management User Guide.

Update Components | Enables you to update a component
Component from:

Page 57 HP Service Test Management (11.50)



Service Test Management User Guide

Ul Elements (A-Z) Menu Description

e Update Component. Updates the
component from its original location.

e Update Component from. Opens a
dialog box for navigating to a URL or
a file with an updated version of the
contract.
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Troubleshooting and
Limitations - Application
Components

This section describes the general limitations for creating application
components with Service Test Management.

Application Components Module

e When using the Find dialog box to locate an entity in the Application
Components tree, certain fields are read-only and you cannot provide a
value, such as Component ID.

e If yourestore a service from the Obsolete folder, it may not appear in the
application components tree until you perform a new login to the project.

o Certain graphs generated by the Application Lifecycle Management
Dashboard, cannot be filtered by the Component Type Name field.

e After upgrading from a version 9.41 project, the first time you want to
update an application component, you must use the Update Component
from option—not the Update Component option.

Test Plan Module

e When working in the Test Plan module's Application Components tab—
if you select a linkage to a component and press the keyboard's Delete
button, Service Test Management tries to delete the entire test, instead of
just the link.

Requirements Module

e When defining a link between a requirement and application component
through the Requirements module's Application Components tab: if the
requirement is of a type that does not support coverage (such as a folder),
the link is not created and Service Test Management does not issue a
warning.
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Concepts

"Defining Web Services Overview" on page 62

e "Importing Services "on page 63

e "Secure Services and Proxy Servers " on page 64

e "Spot Testing Operations " on page 65

e "Creating Testsin UFT or Service Test " on page 66
Tasks

e "How to Define a Web Service " on page 68

Reference

e "Web Service Components User Interfaces" on page 71
e "Select Service from Systinet Dialog Box" on page 72

e "Select Service from UDDI Dialog Box" on page 74

e "Connection Settings Dialog Box" on page 76

e "Import Service Dialog Box " on page 78

e "Web Service Call - <Operation_Name> Dialog Box " on page 80
e "Manual Runner Window" on page 83

"Troubleshooting and Limitations - Web Services" on page 88
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Concepts

This section includes:

e "Defining Web Services Overview" on page 62

e "Importing Services "on page 63

e "Secure Services and Proxy Servers " on page 64
e "Spot Testing Operations " on page 65

e "Creating Testsin UFT or Service Test " on page 66
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Defining Web Services Overview

W eb services are a specific case of application components, where the
contractis a WSDL file, defining the Web service, its address, and the
operations. Service Test Management's functionality for application
components contains several additional features specific for Web Services,
such as functionality testing, change detection, and specialized reports.

When working with Web Services, you create a component hierarchy as
described in "Creating Application Components Overview" on page 15.

Web Service contracts are typically WSDL files. Service Test Management
allows you to import WSDL files that define the Web service and its
operations.

You can import a definition from a file location, URL, UDDI or Systinet server.
When you import a definition, Service Test Management extracts the service
name, service address (endpoint), and data from the definition file, and stores
itin the Application Lifecycle Management repository.

For defining application components that are not WSDL-based, see the "New
Application Component Dialog Box" on page 47.

This section also includes:
e "Importing Services " on page 63
e "Secure Services and Proxy Servers "on page 64

e "Spot Testing Operations "on page 65
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Importing Services

You can import Web service definitions based on WSDL files from a file
location, URL, UDDI or Systinet server. When importing a WSDL file, Service
Test Management parses the XML code and stores the service in the
Application Lifecycle Management repository.

You can then link the service to other Application Lifecycle Management
entities such as tests, test sets, and defects. These links help you to keep
track of the service and ensure compliance with your requirements throughout
the testing process. For details about requirement coverage, see "Generating
Requirements and Tests "on page 176.

You can specify connection settings for WSDL files that reside in secure
locations or accessible through proxy servers. These settings let you specify
authentication and proxy server details. Once you enter the security or proxy
information, it remains permanently associated with the service, enabling
automatic updates. For details, see "Secure Services and Proxy Servers " on
page 64.

For user interface details, see the "Import Service Dialog Box " on page 78.
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Secure Services and Proxy Servers

When importing WSDL files from a URL or UDDI server, the WSDL may
require authentication if it resides in a secure location. Certain WSDLs may
only be accessed through a proxy server.

Service Test Management supports WSDLs that require authentication and
W SDLs accessed through proxy servers, using basicand NTLM
authentication.

The security or proxy information is always associated with the WSDL, If you
enable the Keep up to date option to allow automatic synchronization,
Service Test Management uses the authentication or proxy server settings to
access the WSDL at its source.

Note: Setting default connection settings in the project customization
area, instructs Service Test Management to use the same settings for all
your services. For details, see "How to Customize a Project" on page 244.
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Spot Testing Operations

The Spot Tester lets you test your operations one by one to verify their
functionality. To test the functionality, you invoke the service call and check its

response.
[@ Web Service Call - CreateFlightOrder !E
Endpoint address: | ifpiflocalhost24240HPFlights_S0AP || [ Bing Server |
Fequest Response
[B Invoke & Security L Sawve as Test Export Request 1 Mew Defect Export Response

i (Grid | =% Text | %) Import Scherma wifload XML % Clear | 8% Grid | Text

5
[nput | value I <?1ml version="1.0" sncoding="utf-8"7> [2]
[EHErwelope z <s:Envelope xmlns:s="http://schemas.xulsoap.org/soap/envelope
= 7 3 <o:Body-
T 4 “<CreateFlightOrderResponse sxulns="HP. 30AQ. Sanpleipp >
P mBeny (aay) i 5 <CreateFlightorderResult xmlns:i="http://www.w3.org/200
Ereody 3 <Orderiumber>17</Orderliumber>
[=+CreateFlightOrder 7 <TotalPrice>492</TotalPrice>
[ Flightrder | gl ] <fCreateFlightOrderResults>
Tl Class First 9 /</Cr:atsFlightOrdErRsspUnsa>
T 1 =/ s:Body>
T cusomeriame  Biohn Doe ) </5: Envelopos

5] DepartureDate 2011-08-11T00:00:00.000
w- [T Flighthiurmber 1161
(TnurmberofTickets 3

=
4| »

o Reguest sent Wed 3 Aug 20117, 14:02:25 « Response received: Wed 3 Aug 2011, 14:02:25

You use the grid to enter request values and submit them to the server. You
can view the SOAP response and export it to a file.

The Spot Tester also lets you save the step with its parameter values as a
Service Test test, provided that Service Test is installed.

For task details, see "How to Define a Web Service " on page 68.

For user interface details, see the "Web Service Call - <Operation_Name>
Dialog Box " on page 80.
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Creating Tests in UFT or Service Test

If you have HP Unified Functional Testing or HP Service Test, you can create
tests to run on the Web services stored in Service Test Management.

In UFT or Service Test, select ALM > ALM Connection to connect to the
ALM project that contains your Web Service type components.

Create a testin the normal way, and save it to the appropriate location in the

ALM repository.

Use the ApplicationComponents tab in the Test Plan module to link the
Web service component to the test. For details, see "Application Components
Tab - Test Plan Module " on page 231.

For additional details, see the HP Application Lifecycle Management User
Guide.
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Tasks

This section includes:

e "How to Define a Web Service " on page 68
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How to Define a Web Service

This task describes how to set up your components in Service Test
Management. After you set them up, you can test them and check their
functionality and compliance.

This task includes the following steps:

o Create a folder

e Create anew component

e Import a service

e Setauthentication or proxy information - optional
e Create dependencies - optional

e Testthe service - optional

e Run the test

1. Create a folder

Open the New Folder dialog box and add new folders and subfolders
based on your design requirements. The development and quality
assurance teams should design a tree hierarchy representing the structure
of the application. For details, see the "New Folder Dialog Box" on page
46.

You can create folders at any time and drag or copy components from
folder to folder.

2. Create a new component

Create a new component. Select Components > New > New
Component.For details, see the "New Application Component Dialog
Box" on page 47.

3. Import a service

In the New Application Component Dialog box, open the Interaction view
and click Browse to open the Import Service dialog box. Importa Web
service. For details, see the "Import Service Dialog Box " on page 78.

4. Set authentication or proxy information - optional

If the WSDL file requires authentication or if it accessible through a proxy
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server, click the Connection Settings button to configure the connection
settings. For details, see the "Connection Settings Dialog Box" on page
76.

5. Create dependencies - optional

Dependencies indicate the reliance of one component upon another.

a. Selectthe Modeling tab. For a description, see the "Modeling Tab" on
page 39.

b. Click the Select Entities button to open the Components listin the
right pane. Expand the folders and select a component.

c. Click the arrow © to open the transfer menu.

o To add a component thatis dependent on the base component, click
Add Component Dependency (Dependency To).

o To add a component upon which the base componentis dependent,
click Add Component Dependency (Dependency From).
The Dependency Details dialog box opens.

d. Selectthe operation that affects the dependency. If you do not know
which operation to select, specify all of them. For details, see the
"Dependency Details Dialog Box" on page 44.

6. Test the service - optional

To generate a Web Service call in order to test your Web Service, click the
Interaction tab, select an operation, and click Web Service Call. In the
grid, enter request values. Send the request to the server and check the
SOAP response. For details, see the "Web Service Call - <Operation_
Name> Dialog Box " on page 80.

7. Run the test

After you verify that your service is valid, run the test or test set as you
would run any testin ALM, from the Test Lab module. For details, see the
HP Application Lifecycle Management User Guide.

The manual running option provides an interface for working with Web
Services. For details, see the "Manual Runner Window" on page 83.
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Reference

This section includes:

e "Web Service Components User Interfaces" on page 71

e "Select Service from Systinet Dialog Box" on page 72

e "Select Service from UDDI Dialog Box" on page 74

e "Connection Settings Dialog Box" on page 76

e "Import Service Dialog Box " on page 78

e "Web Service Call - <Operation_Name> Dialog Box " on page 80

e "Manual Runner Window" on page 83
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Web Service Components User
Interfaces

Service Test Management provides a user interface to import Web Service
contracts and test the Web Service Calls.

This section includes:

"Select Service from Systinet Dialog Box" on page 72

e "Select Service from UDDI Dialog Box" on page 74

e "Connection Settings Dialog Box" on page 76

e "Import Service Dialog Box " on page 78

e "Web Service Call - <Operation_Name> Dialog Box " on page 80

e "Manual Runner Window" on page 83
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Select Service from Systinet Dialog Box

This dialog box enables you to select and import services from a Systinet
server.

Select service from Systinet !E

Systinet Settings

Systinet address: || - Envirunment:| -

| Fefresh List |

Available Services

SErvIiCE name: | | Filter

Component | Component ID | Description | Contract File LUID
Ok ‘ ‘ Cancel
To access In the Import Service dialog box, choose Import WSDL

from: Systinet and click the Browse [] button.

Important Note: Only ALM Governance 4.0 (Systinet 4.0) is supported
information for Service Test Management 11.00.

Relevant "How to Define a Web Service " on page 68
tasks
See also e "Import Service Dialog Box " on page 78

e "Select Service from UDDI Dialog Box" on page 74

The following elements are included:

Ul Elements Description

(A-Z)
Available A list of the services that match the filter criteria in
Services alphabetical order. The grid shows the following information:

e Component Name
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Ul Elements Description

(A-2)

Component ID

Description

e Contract File

e UUID (Universally Unique Identifier)

Environment | The Systinet environment and version.

Filter Filters the list of services to show only those services
containing the string specified in the Service name field.

Refresh List | Reloads the list of the services on the Systinet server, in the
Available Services pane.

Service A string in the service name by which to filter the list.
name

Systinet The name or IP address of the Systinet server.
Address

For Example: http://pumpkin:8080/soa
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Select Service from UDDI Dialog Box

This dialog box enables you to select and import services from aa UDDI
(Universal Description, Discovery, and Integration) server.

Select service from UDDI !E

UDDI Settings

LDDI address: | T Yersian:

| Refresh List ‘

Available Services
Service name: | | Filter

Component | Component ID | Description | Contract File LD

(D] | | Cancel

To access

In the Import Service dialog box, choose Import WSDL from:

UDDI and click the Browse Ebutton.

Relevant "How to Define a Web Service "on page 68
tasks
See also "Select Service from Systinet Dialog Box" on page 72

The following elements are included:

Ul Elements

Description

(A-Z)
Available A list of the services that match the filter criteria. The grid
Services shows the following information:
e Component Name
e Component ID
e Description
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Ul Elements

(A-2)

Description

e Contract File

e UUID (Universally Unique ldentifier)

Environment

The UDDI version—2 or 3.

Filter

Filters the list of services to show only those services
containing the string specified in the Service name field.

Refresh List

Reloads the list of the services from the UDDI, in the
Available Services pane.

Service A string in the service name by which to filter the list.
name

UDDI The name or IP address of the UDDI server inquiry API.
address

For Example: http://lab1.devlab.ad:8090/juddi/inquiry.
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Connection Settings Dialog Box

This dialog box enables you to provide authentication credentials and proxy

server details for the machine hosting a Web Service's WSDL file.

Connection Settings

Authentication

W Access the WSDL, located in & secure location, using the following
authentication credentials:

[ Use default credentials

User name:

Password:

Proxy

[T Access the WSDL using the following proxy server and credentials:

Froxy Server:

N Use default credentials

M= E3

|j0hndoe |

| |

| Port: | |

Lser name:
Fasgword: | |
‘ Load Customization Settings |
IC—ox || concel |
To access e Foranew service: Inthe New Component window
(Components > New > New Component), select the
Interaction node and click the Browse button. In the
Import Service dialog box, click the Connection Settings
button.
e For existing services: Select the Interactions tab, click
Update from, and click Connection Settings.
e In Customization: Select Service Test Management link >
General Tab > Default Connection Settings.
Important Available only for services imported through a URL and
information | UDDI.
Relevant "How to Define a Web Service "on page 68
tasks
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See also You can set the default WSDL connection settings in the
Project Customization window. For details on customizing the
connection settings, see .

The following elements are included:

Ul Elements

(A-Z)

Authentication

Description

Access the WSDL located in a secure location, using
the following authentication credentials. Enables you
to enter credentials for authentication:

e Use default credentials. Authenticates withthe
Windows logon credentials of the user logged on to the
machine.

e User name, Password. The user name and password
to be used for authentication. For users not in the
default domain, type the domain name before the user
name. For example, domainl/qgc userl.

Proxy

Access the WSDL using the following proxy server
and credentials. Enables you to enter proxy details and
credentials:

e Proxy server. Name or IP address of proxy server.
e Port. Port through which to access the WSDL.

e Use default credentials. Connects to the proxy server
withthe Windows logon credentials of the user logged
on to the machine.

e User name, Password. The user name and password
to be used for authentication. For users not in the
default domain, type the domain name before the user
name. For example, domainl/gc userl.

Restore
Defaults

Restores the default connection settings—user name
authentication and no proxy server.
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Import Service Dialog Box

For Web Service type application components, this dialog box enables you to
import WSDLs from a file system, a URL, a UDDI, or Systinet.

Import Service !E

Irmport'¥SDLfrom: O File @ URL © Systinet O UDDI

WEDL Location: | ||_|

Connection Settings... |

‘ Ok H Cancel
To e Fornew Web services: Inthe New Application Component
access window (Components > New > New Component), select

the Interaction link. Click Browse.

e For existing Web services: Select the Interaction tab and
click Update From.

Relevant | "How to Define a Web Service " on page 68
tasks

See also |« "Connection Settings Dialog Box" on page 76
e "Select Service from Systinet Dialog Box" on page 72

e "Select Service from UDDI Dialog Box" on page 74

The following elements are included (unlabeled Ul elements are shown in
angle brackets):

ul Description
Elements

(A-Z)

o] Lets you locate the WSDL by opening one of the following:
e File. An Open File dialog box

e URL. A new browser window

e Systinet. Select Service from Systinet dialog box

e UDDI. Select Service from UDDI dialog box
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ul Description

Elements

(A-Z)

Connection | Opens the Connections Settings dialog box for configuring

Settings the authentication and proxy settings of the server hosting the
WSDL. For details, see "Connection Settings Dialog Box" on
page 76.

Import The WSDL source:

WSDL from . .
e File. The file system
e« URL.A URL
e Systinet. A Systinetregistry
e« UDDI.AUDDI server

WSDL Location of WSDL:

L ti

ecation 1 . File: full path and file name
e URL: Complete URL
e Systinet: Systinet ID
e UDDI: Server key
Use the Browse button to locate the WSDL.
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Web Service Call - <Operation_Name>
Dialog Box

This Spot Tester dialog box allows you to test individual operations of a
service. You set up arequest and view the SOAP response to see if the
operation functioned properly.

For details, see "Spot Testing Operations " on page 65.

Web Service Call - EchoArr !E
Endpoint address: | httg:fflocalhostihdAdiebServdces/Serices/SimpleService asrrx | - | #  Ping Server
Reguest Response

‘[? Invoke 2 Security 1 Save as Test Export Request ‘ ] Mew Defect Export Response

20 Grid |%% Text | %) Import Schema wifload XML 3 Clear | |25 Grid [+ Text || ©
|'Input |~.\,.-a|uE | 1 No response to display =
[EHErwelope
EI- 7
LR (array) S
lél-Bud\;
él-EchoArr
Sarr 4
Ehin + —
y “n

Reguest has not heen sent Mo response to display

To access To open the Spot Tester for a specific operation:
1. Select an operation in the Interaction tab.
2. Clickthe Web Service Call button.

To open the Spot Tester with a view of all available
operations:

1. Right-click an operation in the expanded Application
Components tree.

2. SelectInvoke.

Relevant "How to Define a Web Service "on page 68
tasks

User interface elements are described below.
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Ul Elements

(A-2)

<timestamp>

Description

The date and time that the request was sent and the
response received. This appears in the bottom of the
window.

Endpoint
address

The address of the server over which to submit the request.

Ping Server

Pings the server in the Endpoint address URL and opens a
popup indicating its status: Available OrUnavailable.

Request The request values and controls. For details, see the "Web

Pane Service Call - <Operation_Name> Dialog Box " on previous
page.

Response The SOAP response. For details, see the "Web Service Call

Pane - <Operation_Name> Dialog Box " on previous page.

Web Service Call Operation - Request Pane

User interface elements are described below:

ul Description

Elements

(A-Z)

Clear Clears the values you assigned to the arguments in the Grid tab.
Export Exports the request SOAP message to an XML file.

Request

Grid tab | A list of all arguments, and a column for setting their values.

Click on a triangle adjacent to an argument to include/exclude it

from the request.

o A filled-in triangle includes the argument in the request; An
empty triangle excludes the optional argument from the
request.

e An argument with an ABC icon can be parameterized.

e A NIL icon indicates that argument can have a NIL value.

e A green plus sign indicates that you can add array elements.
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ul Description
Elements

(A-Z)

Import Allows you to open an XSD schema file for loading the structure
Schema |oftherequest.

Invoke Sends the request to the server address specified in the
Endpoint address box.

Load Allows you to open a structured XML file, for the purpose of
XML loading values for the request.

Save as Saves the call as a Service Test compatible test, to a location in
Test ALM. The saved test includes the request's property values and
security settings, and the response's values as checkpoints.

Note: This option is only available when Service Test is installed
on the machine.

Security [ Opens the Security Setting for Operation <Operation Name>
dialog box, allowing you to configure the security properties for
the Web service. For details, see "Web Service Security " on
page 103.

Text tab | The requestin XML format.

Web Service Call Operation - Response Pane

User interface elements are described below:

ul Description
Elements

(A-Z)

Export Opens the Save As dialog box, allowing you to export the
Response | SOAP response to an XML file.

Grid tab A list of all response parameters, and their expected values.

New Opens the New Defect dialog box for adding a new defect
Defect relating to this operation, to the current project.

Text Tab A textual (XML) representation of the SOAP response resulting
from the request.
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Manual Runner Window

This window lets you manually run a Web Service test step. This applies
primarily to tests containing Web Service type contract files.

To verify the functionality of a specific operation, use spot testing. For details,
see "Spot Testing Operations " on page 65.

[_E> Manual Runner (Run_6-13_16-1-57)

o055 liile

Service Testing

Available Services and Operation ¥ gpuonin address: | hitp://1654.182. 206/MywebServic |w | |2 Ping Server
B¢ Saity

E-& Port SanityServiceSoa
Echoiddr ‘[} Invoke (= Security ‘I_j Mew Defect [%] Export Response

EchoAdditvithitr  —— ——
Echaddiithany =7 rid @ Text | = Grid L:g el

Request Response

E choaddiithi=m| Input Yalue Output
E chaoAddrithrm hervelope

E choAddrwithChaic :
EchoAddrithChoic A ZEEET -
EchoAddrwithChaic Bany *
EchoAddiwithChaic =) Body
EchoAddiéithChoic EEchoaddray
EchoAddrwithChaic Baddr
E choAddrwithChaic

by EchosAddiéithEnum | ™
il > . o FRequest sent Mon 13 Jun 2011, o Response received: Maon 13 Jun 2011,

To Perform the following steps:
access
e Select atestsetinthe Test Lab module's Test Sets tab.
e Click the Execution Grid tab.

e Select atestand choose Run > Run with Application
Component Manual Runner.

e Click the Service Testing tab (by default this is open).

For tests not based on Web Service WSDL contracts, select Run
with Manual Runner. For details, see the HP Application
Lifecycle Management User Guide.

Relevant [ "How to Define a Web Service "on page 68
tasks

User interface elements are described below.
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ul Description

Elements

& Previous Step. Navigates to the previous test step.

2 Next Step. Navigates to the next test step.

- Set Pass Status. Sets the test status to Pass. The drop down

list provides the following options:
e Pass Selected. Sets status to Pass for selected steps.

e Pass All. Sets status to Pass for all steps of the test.

B~ Set Fail Status. Sets the test status to Fail. The drop down list
provides the following options:

e Fail Selected. Sets status to Fail for selected steps.

e Fail All. Sets status to Fail for all steps of the test.

i Opens the New Defect dialog box for creating a defect for the
current test and test set.

8¢ Add Attachment to Run. Adds an attachment to the test run.
An attachment can be a file, URL, snapshot of your application,
an item from the clipboard, or system information. The drop
down list provides the following options:

e Attachment to Step. Adds an attachment to the current
step.

e Attachment to Run. Adds an attachment to all steps.

[ End Run. Stops the test run.
Note: If you stop a test run before it is complete, you can
resume the test run from the point at which it was stopped. In
the Execution Grid tab, select Run > Continue.

Details Contains the creation and status details of the test run: Run

tab Name, Tester, Execution Time, Status, and Execution Date.
Tip: Set the status based on the result of the manual test run.
You cansetittoBlock, Failed,N/A, No Run, Not
Completed, OrPassed.

Service Displays the properties of the test, its request, and its response.

Testing
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ul Description

Elements

tab

Manual Runner - Service Testing Tab

User interface elements are described below.

Ul Elements Description

<timestamp>

The date and time that the request was sent and the
response received. This appears in the bottom of the
window.

Available
Services and
Operations

A tree hierarchy of all services and operations available for
the test.

Endpoint
address

The address of the server over which to submit the request.
By default, the Manual Runner uses the endpoint from the
contract file. To override it, specify a different endpointin
this field.

Ping Server

Pings the server in the Endpoint address URL and opens a
popup indicating its status: Available OrUnavailable.

Request The request values and controls. For details, see the
Pane "Manual Runner Window" on page 83.

Response The server response. For details, see the "Manual Runner
Pane Window" on page 83.

Manual Runner - Service Testing Tab - Request Pane

User interface elements are described below:

ul Description

Elements

(A-Z)

Clear Clears the values you assigned to the arguments in the Grid tab.

Request

Export Exports the request SOAP message to an XML file.
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ul Description

Elements

(A-Z)

Grid tab | A list of all arguments, and a column for setting their values.
Click on a triangle adjacent to an argument to include/exclude it
from the request.

e A filled-in triangle includes the argument in the request; An
empty triangle excludes the optional argument from the
request.

e An argument with an ABC icon can be parameterized.

e A NIL icon indicates that the argument can have a NIL value.

e A green plus sign indicates that you can add array elements.

Import Allows you to open an XSD schema file for loading the structure

Schema |oftherequest.

Invoke Sends the request to the server address specified in the
Endpoint address box.

Load Allows you to open a structured XML file, for the purpose of

XML loading values for the request.

Save as Saves the call as a Service Test compatible test, to a location in

Test ALM. The saved testincludes the request's property values and
security settings, and the response's values as checkpoints.
Note: This option is only available when HP Service Test is
installed on the machine.

Security | Opens the Security Settings for Operation <Operation Name>
dialog box, allowing you to configure the security properties for
the operation.

e To setthe security for this operation only, clear the Use the
port's security settings check box and provide the security
details.

e To setthe security for all operations on the port, click Edit
port's settings.

For details, see "Web Service Security " on page 103.
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Ul
Elements
(A-2)

Text tab

Description

The requestin XML form at.

Manual Runner - Service Testing Tab - Response Pane

User interface elements are described below:

ul Description

Elements

(A-Z)

Export Opens the Save As dialog box, allowing you to export the

Response | SOAP response to an XML file.

Grid tab A list of all response parameters, and their expected values.
Click on a triangle adjacent to an argument to include/exclude it
from the request.

o A filled-in triangle includes the argumentin the request; An
empty triangle excludes the optional argument from the
request.

e An argument with an ABC icon can be parameterized.

e A NIL icon indicates that argument can have a NIL value.

New Opens the New Defect dialog box for adding a new defect

Defect relating to this operation, to the current project.

Text tab A textual (XML) representation of the SOAP response resulting
from the request.
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Troubleshooting and
Limitations - Web Services

This section describes troubleshooting and limitations for working with Web
Service type application components.

e Issue: An operation runs successfully from the Spot Tester, but when you
try to run the test that you created using the Spot Tester's Save as Test
option, it fails.

Reason 1: The test contains a dynamic parameter, such as Correlation ID,
that changes for every replay.

Workaround 1: In Service Test/UFT, assign the checkpoint a data source
that reflects the changing property value.

Reason 2: The service uses multiple ports. The Spot Tester runs the
operation using the specified port, while the saved test uses the first port,
as it appears in the Interaction tab's Service address field.

Workaround 2: Open the Interaction tab and select Override address.
Paste the endpoint for the port (other than the first) into the Service
address field.

Note: This will modify the endpoint address in all tests that are associated
with this Web service. This may solve the issue for the specific operation,
but will also affect other tests that call the operation using a different port.

e If you add attachments to a defect from the Spot Tester, they will not be
available until you post the defect.

e You can import services from all versions of Systinet, including 4.00.
Importing Service Test Management to Systinet, is only supported for
Systinet 4.00.

e WSDL files with non-English characters in its tags, are not supported.

e You cannotimport WSDL files that are located in a secure shared network.
Workaround: Copy the file to a local folder or to a non-secure location.

e Importing from UDDIs through proxy servers is not supported.

e If you override a Web service address in the Interaction tab, and invoke the
service through the right-click menu, the displayed Endpoint Address in the
Spot Tester window may still show the original endpoint.
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Managing Application
Components

Concepts

e "Managing Application Components Overview " on page 91
Tasks

e "How to Manage Components "on page 95

Reference

e "Update Linked Tests Dialog Box" on page 99

e "Discover Components Wizard" on page 101

e "Generate Components Wizard" on page 102
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Concepts

This section includes:

e "Managing Application Components Overview " on page 91
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Managing Application Components
Overview

After you define an application component, you can view and modify its
definitions and details. You can also resolve alerts and view the changes on
your component. Using the Application Components tree, you can reorganize
the components under different folders.

This section includes:
e Application Component Details

e Locating Application Components

e Handling Rule Violations or Change Alerts
e Copying Components

e Adding Attachments

e Restoring and Removing Components

e E-mailing Components

Application Component Details

In the Application Components tree, you can view and modify the location of
components and folders. For Web service components, you can view
information such as the WSDL location, override the service address, and
modify connection settings.

For details, see "How to Manage Components " on page 95.

Locating Application Components

You can search for a particular entity in the Application Components tree—
folder, component, or group, by one of their Details tab fields. The search
utility allows wildcards and searching by a specific field. For example, you can
search for a component that begins with the letter "s".

Tip: If you applied a filter to the tree, the search is restricted to the folders
and components currently displayed.
For details, see "How to Manage Components " on page 95.

Handling Rule Violations or Change Alerts

Service Test Management uses alert indicators to make you aware of changes
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to the components or rule violations.

The changes can be those entered manually or those detected autom atically
by Service Test Management when you update a contract.

Rule violations are a result of non-compliance with the component's
requirements. To complete your testing, you should try to resolve the alerts.

For additional information, see "How to Manage Components " on page 95.

Updating Components

Service Test Managementenables you to update an application component
from its original location or from a different source. Once you update a
component, any step that calls it from an another application, such as Service
Test/ UFTmay be affected. Service Test/ UFT, marks all steps that were
affected with a warning icon, that allows you to open the Update wizard. This
wizard lets you map service, port, and property names.

In addtion, you can update all tests in your project's Test Plan with calls to
application components stored inService Test Management. When you run
the Update Linked Tests utility, Service Test Management updates all Service
Test/ UFT tests that are linked to application components. If there are
conflicts between the orignal application component and the new one, Service
Test/ UFT marks them with a warning icon. You can resolve the steps using
the Update wizard in Service Test/ UFT. All tests that call unresolved
components are marked with an alerticon in the Test Plan module.

For details, see the "How to Manage Components "on page 95

Copying Components

You can copy an existing folder, component, or group and paste it to another
location in the Application Components tree, or to another project. When
copying a component to another project, the source and target projects must
be open in separate browsers.

For more information, see "How to Manage Components "on page 95.

Adding Attachments

The Attachments tab enables you to associate an attachment with a folder,
component, or group. An attachment can be a file, URL, text from the
clipboard, snapshot, or system information. It is identified by its name,
associated application icon, size, and latest modification date and time. You
can add, modify, and delete attachments.
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The Attachments tab includes an icon « if the selected folder, component, or
group has any attachments.

The Attachments tab for folders, components, and groups has the same
functionality as the Attachments tab for other ALM entity types. For details
on adding attachments, refer to the HP Application Lifecycle Management
User Guide.

Restoring and Removing Components

You can permanently delete folders or components that are not used by a test
orrequirement. To see if acomponentis used by a test, see "Tests Coverage"
on page 195. If you try to delete components that are used by one or more
tests, Service Test Management transfers them to the Obsolete folder. You
cannot copy obsolete components.

You can restore components in the Obsolete folder to their original position in
the Application Components tree if the folder still exists in the tree, or you can
drag them to a different location in the tree.

For task details, see "How to Manage Components " on page 95.

E-mailing Components

You can send e-mail about an entity (folder, component, or group) to other
users. This enables you to routinely inform users about the status of your
components. A link is included in the e-mail message that enables the
recipient to go directly to the component. You can also include your own
shortcuts using one of the formats described in "ALM Direct Links " on page
25.

For task details, see "How to Manage Components " on page 95.
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Tasks

This section includes:

e "How to Manage Components " on page 95
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How to Manage Components

This task describes how to work with your components by changing its details,
updating a WSDL, resolving alerts, copying entities, and so forth.

This task includes the following steps:
e Manage component details - optional
e Find folders and components - optional
e Handle alerts - optional
e Update a Component - optional
e Copy entities - optional
e Remove and restore components - optional
e Mail components - optional
Manage component details - optional
Open the Details tab and modify the component's details as desired.
For more information, see "Details " on page 30.

Find folders and components - optional

1. To search all of the application components, select Filter T ->Clear Filter
to remove any filters.

2. Select Edit > Find. The Find dialog box opens.
3. Selectan Entity Type: Folder, Application Component, Of Group.

4. Selectthe field to search in the Find in Field box. For example to search
for acomponent by its name, select Component Name field and specify a
part or the whole name as a value.

5. Specify a value in the Value to Find box. The search engine is not case-
sensitive and it finds parts of a string.

6. Click Find Next to locate the first and subsequent matches.
For details, see the "Find Dialog Box" on page 37.

Handle alerts - optional

Click on an exclamation point adjacent to a component, to view its alerts ! .
Determine which alerts to resolve. For details, see the "Alerts Dialog Box" on
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page 28.

Update a component - optional

To update a component contract:
1. Selectthe component you want to update.
2. Choose an update option:

s Toupdate a component using its original location, choose Components
> Update Component > Update Component.

s Toupdate a component using a different location, choose Component >
Update Component > Update Component from. Browse for a newer
version of the contract in another location.

The update process begins. Service Test Management checks for changes
in the contract and informs you if the component changed. For details, see
"Change Analysis "on page 267

Update linked tests - optional

To update all linked tests (Testing Status > Tests tab) containing
components:

1. Choose Component > Update Component > Update Linked Tests

2. Inthe Update Tests dialog box, review the list of tests that were detected
for the update

3. Click Update All Tests. The update process begins. The mechanism
updates the components linked to the test from their location in Service
Test Management. The right column shows the update status. For details,
see "Update Linked Tests Dialog Box" on page 99.

4. Toopen atestin Service Test/ UFT, selectitin the grid and click the
Launch Service Test button. This is useful to check a test that could not be
updated or to check if a test step needs to be resolved due to the
component update. Tests that have steps that need to be resolved are
marked with an alert in the Test Plan module's test tree.

5. Toresolve a test step in Service Test/ UFT, click the step's alerticon and
run the Update wizard. For details, see the Service Test/ UFT user guide.
Once you resolve a step, you need to manually remove the alert. In the
Test Plan module's test tree, click on the alert and mark it as resolved. For
details, see "Change Analysis "on page 267
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Copy entities - optional

Using the right-click menu, copy existing folders, components, or groups onto
the clipboard. Open the target folder in the components tree and paste the
entity from the clipboard. To copy it to another project, open the target project
in another browser tab and paste it in.

For details, see the "Application Components Module Window" on page 52.

Remove and restore components - optional

To remove a component, select it and click the Delete ¥ button. If you remove
a folder, its subfolders and all components in those folders are removed too. If

aremoved componentis still being used by an existing test, Service Test
Management stores it in the Obsolete folder.

Tip: To view all application components in the Obsolete folder, select the
folder and click the Refresh button.

Toremove a component entirely, make sure that no tests are using it. Click
the Test Script tab in the Test Lab module to open the testin Service Test/
UFT, and remove all steps calling the component. After you have removed all
calls to the component, delete it from the Obsolete directory.

You can restore components in the Obsolete folder to their original position in
the components tree, if the folder still exists in the tree. If the folder no longer
exists, transfer the component to another location in the tree by dragging it
from the Obsolete folder to the desired location.

Mail components - optional

Select a component and click the Send by e-mail button® . A link included in
the e-mail message enables the recipient to go directly to the component.

Edit the content, select recipients, and perform a spell check. For details
about the Send Mail dialog box, click F1 or see the HP ALM User Guide.
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Reference

This section includes:
e "Update Linked Tests Dialog Box" on page 99
e "Discover Components Wizard" on page 101

e "Generate Components Wizard" on page 102
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Update Linked Tests Dialog Box

This dialog box enables you to update all tests that are linked to application

components, with the current version of its contract.

Update Linked Tests E3

Linked Tests: M
Test D Test Hame Status -
A2 wsz1_Copy_1_Fositive_Sanity... Mat Starked =
A4 wzl_Positive_SanityServiceS .. Mot Started
A8 APITestl Mot Started
41 C1_Fositive_SanityServiceSo..  Mat Starked
J1z C1_Poszitive_SanityServiceSo.. Mot Started
13 C1_Fositive_SanityServiceSo..  Mat Starked
J14 C1_Poszitive_SanityServiceSo.. Mot Started
A 15 C1_Fositive_SanityServiceSo..  Mat Starked -
EAP——
| 0%
Statuz Details;
I
To access Select Components > Update Component > Update
Linked Tests
Important Available only when Service Test/ UFT is installed on

inform ation

the machine.

Relevant tasks

"How to Manage Components " on page 95

See also

"Managing Application Components Overview

page 91

on

The following elements are included:
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Ul Elements Description

Linked Tests A list of tests calling application components stored in

Service Test Management, that are linked to the
components.

e Test ID. The unique ID of the test as it appears in
the Test Details dialog box.

e Test Name. The name the test as it appears in the
Test Plan tree.

e Status. The current status of the update: Not
Updated, Updated, or Failed to Update.

Open Launches Service Test/ UFT with the test selected in
the test list.
Update All Begins the process of updating all tests listed in the

above pane.

Status Details A log indicating the results of the update.

Page 100 HP Service Test Management (11.50)



Service Test Management User Guide

Discover Components Wizard

The Discover Components wizard automatically detects contract files in tests
stored in ALM and creates application components based on these contracts.
You can then organize the application components in Service Test
Management and link them to requirements and tests.

To Do one of the following:

access
e Select an entity in the Application Components tree, and

choose Discover Components from the right-click menu.

e Select Components > Discover Components.

Important | In order to enable this wizard, you need to have HP Unified
Functional Testing or HP Service Test installed on the machine.

Relevant |"How to Define Components " on page 22

tasks
Wizard This wizard contains:
map .
Welcome Page > Select Tests Page > Options Page >
Required Fields Page > Summary Page > Results Page
See also "How to Define a Web Service "on page 68
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Generate Components Wizard

This wizard enables you to generate multiple components at once.

To Do one of the following:

access I L
e Select an entity in the Application Components tree, and

choose Generate Components from the right-click menu.

e Select Components > Generate Components.

Relevant [ "How to Define Components " on page 22
tasks

Wizard This wizard contains:

ma
P Select Source Page > Add Components Page > Set Required

Fields Page > View Summary Page > Show Log Page

See also |"How to Define a Web Service " on page 68
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Concepts

"Setting Security Overview" on page 106

e "Security Levels "on page 107

e "Security Scenarios Overview" on page 108

e "Web Service Security Scenario " on page 109

e "WCF Scenario Settings "on page 112

e "WCF Service (CustomBinding) Scenario Overview" on page 113

e "WCF Service (Federation) Scenario Overview " on page 114

e "WCF Services (WSHttpBinding) Scenario Overview " on page 115

e "Advanced Security Settings " on page 117

Tasks

e "How to Set Security fora Web Service on the Port Level" on page 119
e "How to Set Security for a Specific Web Service Operation" on page 121
e "How to Set Security for a Standard Web Service" on page 122

e "How to Set Security fora WCF Service" on page 124

e "How to Setup Common Web Services Security Scenarios " on page 125
e "How to Customize Security for WCF Type Web Services " on page 129
e "How to Test Web Services that use WS-Security or SSL" on page 133
e "How to Set up Advanced Standards Testing " on page 135

Reference

"Security User Interface" on page 138

e "Security Settings for Port/ Operation <Name> Dialog Box" on page 139
e "Web Service Scenario "on page 141

e "WCF Service (Custom Binding) Scenario" on page 147

e "WCF Service (Federation) Scenario" on page 149
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Web Service Security

e "WCF Service (WSHttpBinding) Scenario" on page 151
e "Advanced Settings Dialog Box" on page 154

e "Encoding Tab" on page 155

e "Advanced Standards Tab" on page 156

e "Security Tab" on page 157

e "HTTP and Proxy Tab" on page 160

e "Select Certificate Dialog Box " on page 162

"Troubleshooting and Limitations - Web Service Security " on page 164
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Concepts

This section includes:

e "Setting Security Overview" on page 106

e "Security Levels "on page 107

e "Security Scenarios Overview" on page 108

e "Web Service Security Scenario " on page 109

e "WCF Scenario Settings "on page 112

e "WCF Service (CustomBinding) Scenario Overview" on page 113

e "WCF Service (Federation) Scenario Overview "on page 114

e "WCF Services (WSHttpBinding) Scenario Overview " on page 115

e "Advanced Security Settings " on page 117
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Setting Security Overview

W hen building Web Service applications, there is a challenge in building
scalable applications that are secure. You can secure Web Services by having
the message sent over a secure transport, such as Secure Sockets Layer

(SSL), or by applying security at the message level, also known as WS-
Security.

For testing a secured service, answering the following questions will help you
define your security scenario.

e Is there transport security, such as SSL? Whatisthe HTTPS URL?
e Is basic authentication required?

e Is mutual authentication required?

e What type of security is required in the SOAP header?

For task details, see "How to Set Security for a Specific Web Service
Operation" on page 121.
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Security Levels

Service Test lets you set the security for a service on two levels—port or
operation. If you define a security for a port, all of its operations use these
settings, by default. When working on an operation, you can override the
default port security and customize the security for a particular operation.

For user interface details, see "Security User Interface" on page 138.
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Security Scenarios Overview

Service Test provides several built-in scenarios for configuring security in
Web Service calls.

A security scenario represents a typical security implementation for a Web
Service. It contains information such as authentication, encoding, proxy,
certificates, and so forth.

A default Web Service scenario can be used for most Web services. It
enables you to configure both transport and message-level security. Service
Test support for message-level security lets you manually configure the
security elements such as tokens, message signatures, and encryption. For
details, see "Web Service Security Scenario " on page 109.

W CF scenarios enables you to configure security for HTTP or custom
bindings and work with advanced specifications, such as WS-
SecureConversation.

The built-in security scenarios are:

e "Web Service Security Scenario "on page 109

e "WCF Service (CustomBinding) Scenario Overview" on page 113
e "WCF Service (Federation) Scenario Overview " on page 114

e "WCF Services (WSHttpBinding) Scenario Overview " on page 115
Use the default Web Service scenario for:

e Simple Web Services where no advanced standards are required.
e Web services using HTTP transport level security.

e Web services using message level security (W S-Security) for SOAP 1.1
Use a WCF scenario for:

e WCF Services that utilize advanced security and W S-Specifications.
e Web services using message level security (W S-Security) for SOAP 1.2

Such services can be written in various platforms such as WCF (Windows
Communication Foundation), Metro (WSIT), and Axis2. Service Test also
supports proprietary standards and transports.
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Web Service Security Scenario

The default Web Service scenario is based on the W S-Security specification.
This scenario lets you place security credentials in the actual SOAP message.

When a SOAP message sender sends arequest, the security credentials,
known as tokens, are placed in the SOAP message. When the Web server
receives the SOAP request, it does not need to send additional requests to
verify the integrity of the sender. The server verifies that the credentials are
authentic before letting the Web Service execute the application. By not
having to go back to the source of the credentials, the application's scalability
improves significantly.

To further secure Web Services, itis common to use digital signatures or
encryption for the SOAP messages. Digitally signing a SOAP message
verifies that the message has not been altered during transmission.
Encrypting a SOAP message helps secure a Web Service by making it difficult
for anyone other than the intended recipient to read the contents of the
message.

The Security Settings dialog box provides the following tabs for the Web
Service scenario: HTTP,WS-Security, and WS-Addressing. The HTTP tab
lets you configure the transport security, the WS-Security tab handles the
message-level security, and the WS-Addressing tab sets the addressing
version.

Transport Level Security

The transport level security includes the authentication and proxy server
information. You can also specify Keep Alive preferences and connection
timeout.

Message Level Security

The WS-Security tab lets you set the message level security through tokens,
signatures and encryption.

To support WS-Security, Service Test enables you to create security tokens
for your script. You can create multiple tokens and set their properties. After
creating a token, you use it to sign or encrypt a SOAP message.

Page 109 HP Service Test Management (11.50)



Service Test Management User Guide

The Web Services security mechanism associates security tokens with
messages. This mechanism supports several security token formats to
accommodate a variety of authentication requirements. For example, a client
might need to provide a proof of identity or a security certificate.

The available tokens are: UserName, X509 Certificate, Kerberos,
Kerberos2, and SAML.

e UserName. The User Name token contains user identification information
for the purpose of authentication: User Name and Password. You can also
specifyPassword Options, indicating how to send the password to the
server for authentication: Text, None, or Hash. and indicate whether to
include a timestamp.

e X509 Certificate. This token is based on an X.509 certificate. To obtain a
certificate, you can either purchase it from a certificate authority, such as
VeriSign, Inc. or set up your own certificate service to issue a certificate.
Most Windows servers support the public key infrastructure (PKI), which
enables you to create certificates. You can then have it signed by a
certificate authority or use an unsigned certificate.

e Kerberos /Kerberos2. (For Windows 2003 or XP SP1 and later) The
Kerberos protocol is used to mutually authenticate users and services on an
open and unsecured network. Using shared secret keys, it encrypts and
signs user credentials. A third party, known as a KDC (Kerberos Key
Distribution Center), authenticates the credentials. After authentication, the
user may request a service ticket to access one or more services on the
network. The ticket includes the encrypted, authenticated identity of the
user. The tickets are obtained using the current user's credentials.

The primary difference between the Kerberos and Kerberos2 tokens, is that
Kerberos2 uses the Security Support Provider Interface (SSPI), so it does
not require elevated privileges to impersonate the client's identity. In
addition, the Kerberos2 security token can be used to secure SOAP
messages sentto a Web Service running in a Web farm.

e SAML Token. SAML is an XML standard for exchanging security-related
information, called assertions, between business partners over the Internet.
The assertions can include attribute statements, authentication, decision
statements, and authorization decision statements.

SAML uses brokered authentication with a security token issued by STS
(Security Token Service). The STS is trusted by the client and the Web
Service to provide interoperable security tokens. SAML tokens are important
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for Web Service security because they provide cross-platform
interoperability and a means of exchanging information between clients and
services that do not reside within a single security domain.

Message Signatures and Encrypted Data

When you add a security token to a SOAP message, itis added to the SOAP
message in the form of an XML element in the WS-Security SOAP header.

The message, however, is exposed and therefore requires additional security.
This is especially true when the credentials, including the password, are sent
in plain text as itis with role-based security.

The two methods used to secure the data are message signatures and
message encryption.

e Message Signatures. Message Signatures are used by the recipients to
verify that messages were not altered since their signing. The signature is
in the form of XML within the SOAP message. The recipient checks the
signature to make sure it is valid.

e Message Encryption. Although the XML message signature offers a
mechanism for verifying that the message has not been altered since it was
signed, it does not encrypt the SOAP message—the message is still plain
textin XML format. To secure the message in order that it should not be
exposed, you encrypt it, making it difficult for an intruder to view and obtain
a user's password.

For task details, see "How to Set Security for a Specific Web Service
Operation" on page 121.
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WCF Scenario Settings

This section describes the WCF security scenarios. It includes:

e "WCF Service (CustomBinding) Scenario Overview" on page 113

e "WCF Service (Federation) Scenario Overview " on page 114

e "WCF Services (WSHttpBinding) Scenario Overview " on page 115
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WCF Service (CustomBinding) Scenario
Overview

The WCFService(CustomBinding) scenario enables the highest degree of
customization. Since it is based upon WCF customBinding standard, it
enables you to test most WCF services, along with services on other
platforms such as Java-based services that use the WS - <spec_name>
specifications.

Use the WCFService(CustomBinding) scenario to configure a scenario that
does not comply with any of the predefined security scenarios. You can
customize the transport and encoding settings:

e Transport. HTTP,HTTPS, TCP, or NamedPipe
e Encoding. Text, MTOM, or WCF Binary
You can also provide additional security information:

e Authentication mode. The type of authentication, such as None,
AnonymousForCertificate, and so forth. The options are available from
the drop down list.

e Bootstrap policy. Forthe SecureConversation authentication mode, you
can specify a bootstrap policy.

e Net security. The network security for TCP and Named Pipe type
transports. Typical values are None, Windows stream security, or SSL
stream security available from the field's drop down list. For services with
HTTP transport, you should set the value to None. To enable SSL for
HTTP, select HTTPS transport.

For task details, see "How to Set Security fora WCF Service" on page 124.

For user interface details, see "W CF Service (Custom Binding) Scenario” on
page 147.

Note: For WSE3 security configurations, use the
WCFService(CustomBinding) Scenario. For details, see "How to
Customize Security for WCF Type Web Services " on page 129.
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WCF Service (Federation) Scenario
Overview

Inthe WCF Service (Federation) scenario, the client authenticates against
the STS (Security Token Service) to obtain a token. The client uses the token
to authenticate against the application server.

Therefore, two bindings are needed, one against the STS and another against
the application server.

You define the bindings in two stages:
e Define an STS binding in the Referenced binding field.

e Provide security details for the application server's security scenario in the
following areas:

s Server. The transport and encoding methods.

» Security. The authentication mode, such as TssuedToken,

SecureConversation, and so forth.
= ldentity. Information about the server certificate and expected DNS.

m STS. Settings related to the STS, such as the endpoint address and
binding.

For task details, see "How to Set Security fora WCF Service" on page 124.

For user interface details, see "W CF Service (Federation) Scenario" on page
149.
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WCF Services (WSHttpBinding) Scenario
Overview

Note: The WCFService(WSHttpBinding) scenario only supports the
testing of WCF services which utilize wsHttpBinding and incorporate some
level of security. To test WCF services that use wsHttpBinding but have no
security, use the WCFService(CustomBinding) scenario.

Inthe WCF Service (WSHttpBinding) scenario, you can select from several
types of authentication: None, Windows, Certificate, or Username (message
protection).

For all of the authentication types, you can apply advanced settings as
described in "Advanced Security Settings " on page 117.

For user interface details, see "W CF Service (W SHttpBinding) Scenario" on
page 151.

No Authentication (Anonymous)

In this scenario, the client uses the server's certificate to encrypt a message;
there is no client authentication. Use this scenario to test Web Services where
the:

e Client uses the server's X.509 certificate for encryption
e Clientis not authenticated

e Communication may utilize advanced standards such as secure
conversation or MTOM.

Windows Authentication

This scenario uses Windows Authentication. If you are testing a WCF service
that has not been customized and uses the default configuration, use this type
of scenario.

Use this scenario to test Web Services where the:
e Client and server use Windows authentication

e Security is based on Kerberos or SPNEGO negotiations
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e« Communication may utilize advanced standards such as secure
conversation or MTOM.

Certificate Authentication

In this WCF WSHttpBinding scenario, the client uses the server's X.509
certificate to encrypt the message and its own certificate for a signature.

Use this scenario to test Web Services where the:
e Clientuses the server's X.509 certificate for encryption.
e Clientuses its own X.509 certificate for signatures.

¢ Communication may utilize advanced standards such as secure
conversation or MTOM.

Username Authentication (Message Protection)

Inthe WCF WSHttpBinding scenario, the client uses the server's X.509
certificate to encrypt the message, and sends a user name and password to
authenticate itself.

Use this scenario to test Web Services where the:
e Clientuses the server's X.509 certificate for encryption.
e Clientis authenticated with a username and password.

e Communication may utilize advanced standards such as secure
conversation or MTOM.
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Advanced Security Settings

This scenario's settings let you customize a WCFService(CustomBinding)
scenario in the areas of Encoding, Advanced Standards, Security, or HTTP
and Proxy.

Not all settings are relevant for all scenarios, so some of them might be
disabled or hidden depending on the scenario.

For details, see the "Advanced Settings Dialog Box" on page 154.
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Tasks

This section includes:

e "How to Set Security fora Web Service on the Port Level”" on page 119

e "How to Set Security for a Specific Web Service Operation" on page 121
e "How to Set Security for a Standard Web Service" on page 122

e "How to Set Security fora WCF Service" on page 124

e "How to Setup Common Web Services Security Scenarios " on page 125
e "How to Customize Security for WCF Type Web Services " on page 129
e "How to Test Web Services that use WS-Security or SSL" on page 133

e "How to Set up Advanced Standards Testing " on page 135

Page 118 HP Service Test Management (11.50)



Service Test Management User Guide

How to Set Security for a Web Service
on the Port Level

This task describes how to configure security settings for a Web service on the
port level. You can override this by modifying the settings for a specific test
step. For details, see "How to Set Security for a Specific Web Service
Operation" on page 121.

This task includes the following steps:
e Prerequisites

e Open the Security Setting dialog box
e Load existing settings - optional

Create a new security scenario

Save the settings - optional

1. Prerequisites

Import at least one Web service.

2. Open the Security Setting dialog box
Select a Web service in the Application Components tree and click the
Interaction tab. Click the Security toolbar button.

3. Load existing settings - optional
To load an existing set of Service Test security settings, click Import and
locate the .stss (Service Test Security Scenario) file.

4. Create a new security scenario

Use the Security Settings dialog box to create a new security scenario or
modify a loaded one:

a. Inthe Service Details box, select a scenario type: Web Service, WCF
Service, and so forth.

b. Configure the security settings for the selected scenario. For details,
see the "Security Settings for Port / Operation <Name> Dialog Box" on
page 139.
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c. For Web Service type scenarios, add tokens, signatures, and
encryption. For details, see "Web Service Scenario "on page 141.

5. Save the settings - optional

Click Save to save the settings to an .stss file.
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How to Set Security for a Specific Web
Service Operation

This task describes how to configure security settings for Web Services.

This task includes the following steps:
e Prerequisites

e Open the Security Setting view
e Enable the Service Settings details
e Specify a scenario type

1. Prerequisites

Importa Web Service and drag an operation onto the canvas.

2. Open the Security Setting view

Select a Web service in the Application Components tree and click the
Interaction tab. Expand the portin the bottom pane, and select an
operation. Click the Web Service Call button. In the Web Service Call
window, click the Security button.

3. Enable the Service Settings details

Clear the Use the port's security settings option.

4. Specify a scenario type

In the Service Details list, select a scenario type: Web Service, WCF
Service, and so forth.

5. Configure the security settings

Configure the security settings for the selected scenario. For task details,
see one of the following sections

= "How to Set Security for a Standard Web Service" on page 122
= "How to Set Security fora WCF Service" on page 124

For user interface information, see the "Security Settings for Port/
Operation <Name> Dialog Box" on page 139.
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How to Set Security for a Standard Web

Service

This task describes how to configure security settings for a standard Web

Service. This mode lets you define the HTTP transport information and
security elements such as tokens. For Ul details, see "Web Service Scenario "
on page 141.

This task includes the following steps:
e Create a Web Service scenario

e Configure the HTTP settings

e Define security elements (optional)

e Setthe WS-Addressing version (optional)

1.

Create a Web Service scenario

Select a Web service in the Application Components tree and click the
Interaction tab. Expand the portin the bottom pane, and select an
operation. Click the Web Service Call button. In the Web Service Call
window, click the Security button.

Configure the HTTP settings

Open the HTTP tab, and set the transport and proxy information. For
details, see the "Web Service Scenario " on page 141.

Define security elements (optional)

Click the WS-Security tab. Add tokens, message signatures, and
encryption.

= To add a token, click B~ and select a token type. Provide the token
details in the lower pane. The fields differ based on the token type. For

details, see "Message Level Security" on page 109.

Note: When adding a SAML token, if you have the complete SAML
token string, you can paste it directly into the AssertionIDReference
field. If you do not have the complete token string and you want to
configure the token manually, make sure that the first row in the
schema contains the Assertion property— not the
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AssertioniIDReference. You can change this using the grid's drop
down menu.

= To add a message signature, (you must first add at least one token),
click ¥ and select a token in the Signing token box, usually an X.509
token. Provide the other required information: For details, see the "Web
Service Scenario " on page 141

= To add a message encryption, (you must first add at least one token),
click & and select the token that will do the encryption in the
Encryption token box. Provide any other required information or
accept the defaults.

s Organize the security elements in their order of priority. Use the Up 1
and Down ! arrows to set the priorities. The basic order is tokens,
followed by message signatures, and then encryption. In addition, your
service may also require a specific order for the tokens.

4. Set the WS-Addressing version (optional)

Click the WS-Addressing tab. Select the relevant version or None if WS-
Addressing is not used.

For details about the security elements, see the "Web Service Security
Scenario " on page 1009.

For user interface details see the "Security Settings for Port / Operation
<Name> Dialog Box" on page 139.
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How to Set Security fora WCF Service

This task describes how to configure security settings for a Web Service using
WCF. For guidelines about selecting a WCF service scenario, see "WCF
Scenario Settings " on page 112.

This task includes the following steps:
e Create a WCF scenario

e Configure the security settings
e Configure advanced settings - optional

e Save the scenario - optional

1. Create a WCF scenario

s For portlevel security, click on the service's portin the Toolbox pane
and select Security Settings from the shortcut menu.

» For step level security, open the Security Settings view in the
Properties pane. Clear the Use the port's security settings option.

Select the desired WCF Service in the Service Details list.

2. Configure the security settings
Configure the settings as described in the "Security Settings for Port /
Operation <Name> Dialog Box" on page 139.

3. Configure advanced settings - optional
Click the Advanced button to configure advanced security settings. For
details, see the "Advanced Settings Dialog Box" on page 154.

4. Save the scenario - optional

Your security scenario is automatically saved with the test. If, however,
you also want to use the settings for another test, without having to
redefine the scenario, you can save it to an .stss file.

To save the scenario, click the Save button. Specify a location for the
scenario file. To use the file in another test, click Import.
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H
S

ow to Setup Common Web Services
ecurity Scenarios

This section illustrates several common security scenarios. The examples
apply when using the default Web Service security scenario. For WCF- based
services, the WCFService(Custom Binding) scenario isrecommended. For
additional examples, see "How to Customize Security for WCF Type Web
Services " on page 129.

You can set security for all operations in a Web service port or for a specific
step in your test.

To set security for a port, see "How to Set Security for a Specific Web Service
Operation" on page 121.

This section includes the following:
Authenticating with a Username Token

Signing with an X.509 Certificate
Signing a Specific Element with an X.509 Certificate
Encrypting with a Certificate

Authenticating with a Username Token and Encrypting with an X.509
Certificate

Encrypting and Signing a Message
Authenticating with a Username Token
To send a message level username/password token (a UserName token):

1. Selectthe Web Service scenario from the Service Details list, and click
the WS-Security tab.

2. Click the Add Token &~ button and add a Usernam e token.

3. Customize the token details, such as username and password.

Signing with an X.509 Certificate

To send a message using a X.509 certificate for a digital signature.

1. Selectthe Web Service scenario from the Service Details list, and click
the WS-Security tab.

2. Select X509 Certificate token from the Security Token &~ drop down
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list.

Fill in the token details to reference your private certificate. Make sure to
enter a value in the Token name field.

Select a Referencetype. Since this token is used for a signature, the most
common typeisBinarySecurityToken.

Click the Add Message Signature button X . In the Signing Token drop
down, select the token you created in the previous steps.

Note: The certificate needs to be installed in the Windows certificate
store. In the example above, you need to set the actual store name,
store location, and subject name of your certificate.

Signing a Specific Element with an X.509 Certificate

It is possible to sign only a specific elementin a message. The following
example signs a specific element using an XPATH expression.

To send a message using an X.509 certificate for a digital signature:

1.

Select the Web Service scenario from the Service Details list, and click
the WS-Security tab.
Select X509 Certificate token from the Security Token &~ drop down list.

Fill the token details to reference your private certificate. Make sure to
enter a value in the Token name field.

Select a Referencetype. Since this token is used for a signature, the most
common typeisBinarySecurityToken.

Click the Add Message Signature button X . In the Signing Token drop
down, select the token you created in the previous steps.

Scroll down to the XPath field. Enter an XPath expression, for example:,
// *[local-name(.)="'Body'].

Encrypting with a Certificate

To encrypt a message using the service's X.509 certificate:

1.

2.

Select the Web Service scenario from the Service Details list, and click
the WS-Security tab.

Select X509 Certificate token from the Security Token - drop down list.
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Fill in the token details to reference the server's public certificate. Make
sure to enter a value in the Token name field.

Since this token is used for encryption, use Referenceas the
Referencetype.

Click the Add Message Encryption button E . In the drop down list,
select the token you created in the previous steps.

Scroll down to the XPath field. Enter an XPath expression, for example:,
// *[local-name(.)="'Body'].

Authenticating with a Username Token and Encrypting
with an X.509 Certificate

The following section describes how to send a Username token to the service

and encrypt it with the server's X.509 certificate:

1.

Select the Web Service scenario from the Service Details list, and click
the WS-Security tab.

Select Username Token from the Security Token B~ drop down list.
Provide the token details.

Select X509 Certificate Token from the Security Token & drop down
list.

Fill the token details to reference the server's public certificate. Make sure
to enter a value in the Token name field. Since this token is used for
encryption, use Referenceas the Referencetype.

Click the Add Message Encryption button E . In the drop down list,
select the X.509 token you created in Step 3.

To encrypt a specific message, scroll down to the XPath field. Enter an
XPath expression, forexample:, // *[local-name (.)="Body'].

Encrypting and Sighing a Message

This example shows how to sign a message using a private key and then

encrypt it using the service's public key.

1.

Select the Web Service scenario from the Service Details list, and click
the WS-Security tab.

Select X509 Certificate Token from the Security Token &~ drop down
list. Fill the token details to reference your private certificate. Make sure to
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enter a value in the Token name field. Select BinarySecurityToken
as a Referencetype, since this token is used for a signature.

3. Select X509 Certificate Token from the Security Token &~ drop down
list to add another X.509 token. Fill the token details to reference your

private certificate. Make sure to enter a value in the Token name field.
Select Reference as a Referencetype, since this token is used for a
encryption.

4. Clickthe Add Message Signature button N . Inthe drop down list, select
the X.509 token you created in Step 2.

5. Click the Add Message Encryption button E . In the drop down list,
select the token you created in Step 3.
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H

ow to Customize Security for WCF

Type Web Services

This section describes how to customize the security settings for Web
services using WCF.

This section describes:
How do | test a WCF service?

How do | testa WCF service that uses WSHttpBinding?
How do | testa WCF service that uses CustomBinding?
How do | test a WCF service that uses netTcp or namedPipe transport?

How do | test a Federation scenario that uses an STS (Security Token
Service)?

How do | test a scenario that uses a WSE3 security configuration with a
server certificate?

How do | test a scenario that uses mutual certificate authentication?

How do | test a WCF service?

In the Service Details list, selecta WCF scenario.

If the Federation or WSHttpBinding scenarios are not appropriate, select the
WCFService (Custom Binding) scenario, as it can handle all other bindings.

How do | test a WCF service that uses WSHttpBinding?

W SHttpBinding is one of the most popular bindings in WCF. In order to use
this binding, selectthe WCFService (Http Binding) scenario from the
Scenario Details list.

In the Client Authentication box, select the client credential type that you use
in your binding— Windows, Certificate, or Username. This value corresponds
to the MessageClientCredentialType property of the WCF's WSHttpBinding.

Windows authentication is the most common value for a WCF services. If you
are using the WCF default settings for your service, use this option. Other

options are username, certificate, Ornone.

For some scenarios you should indicate whether to use the WCF proprietary
negotiation mechanism to get the service credentials.
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Use the Advanced scenario properties to control the usage of a secure
session.

For details, see "W CF Services (WSHttpBinding) Scenario Overview " on

page 115.

How do | test a WCF service that uses CustomBinding?

Open the Security View in the Properties pane and select the WCFService
(Custom Binding) scenario.

You can then customize many binding elements, such as your transport
method, encoding, security, and reliable messaging.

For details, see "How to Set Security fora WCF Service" on page 124.
How do | test a WCF service that uses netTcp or
namedPipe transport?

Selectthe WCFService (Custom Binding) scenario from the Scenario
Details list.

Configure the transportto TCP or NamedPipe.

For details, see "How to Set Security fora WCF Service" on page 124.
How do | test a Federation scenario that uses an STS
(Security Token Service)?

For this scenario, you must define the communication properties for both the
STS and the service. Use the built-in Federation scenario.

Selectthe WCFService (Federation) scenario from the Scenario Details
list.

For this scenario, you must to define the communication properties for both
the STS and the application server.

For details, see "W CF Service (Federation) Scenario” on page 149.
How do | test a scenario that uses a WSE3 security
configuration with a server certificate?

The following procedure describes how to set up a security scenario for
W SES3.

1. Create a new test, importthe WSDL for the W3ES service, and drag the
operation onto the canvas.
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2. Open the Security View in the Properties pane or from the port's
shortcut menu. Selectthe WCFService (Custom Binding) scenario.

3. Setthe Transportto HTTP, and the Encoding to Text.

4. Provide a username and password in the Identities section.

5. Click the Browse button adjacent to the Server Certificate field and
specify the Store Location, Store Name and Search text (optional).
Click Find, select the certificate, and click Select.

6. Provide the Expected DNS.

7. Click the Advanced button and configure the following settings:

a. Encoding tab— Encoding: Text, WS-Addressing: WSA 04/08 (for

example).

b. Security tab:

[¢]

[e]

Enable secure session: Enabled

Negotiate service credentials: Enabled

Protection level: Encrypt and Sign

Message protection order:Sign Before Encrypt

Message security
version:
WSSecurityllWSTrustFebruary2005WSSecureConversationFebruary200

(first entry)

Require Derived keys: Enabled

For all other fields, use the default settings.

For details, see "How to Set Security fora WCF Service" on page 124.

How do | test a scenario that uses mutual certificate

authentication?

The following procedure describes how to set up a security scenario for
mutual certificates and how to comply with a W SE3 security configuration.

1. Selectthe WCFService (CustomBinding) scenario from the Scenario
Details list.

2. Setthe Transportto HTTP, and the Encoding to Text.

3. Setthe authentication mode to MutualCertificate.
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4. In the Identities section, select server and client certificates. For details,
see "Select Certificate Dialog Box " on page 162.

5. Provide the Expected DNS.
6. Click the Advanced button and configure the following settings:

a. Encoding tab— Encoding: Text, WS-Addressing: WsSA 04/08 (fora
W SE3 security configuration).

b. Security tab—Require Derived keys: Disabled
For all other fields, use the default settings.

For details, see "How to Set Security fora WCF Service" on page 124.
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How to Test Web Services that use WS-
Security or SSL

This section provides a summary of using Service Test for general security
testing.

This section includes:
e How do | testa Web Service that uses SSL?

e How do |l testa Web Service that requires Windows authentication at the
HTTP level?

e How do |l testa Web Service that uses WS-Security?

How do | configure the low-level details of my W S-Security tokens?

How do | test a Web Service that uses SSL?

Testing a secure site does not require any special configuration. If your
service URL begins with https,SSL is automatically used.

If in addition to SSL you are using message-level security (for example a
username) then you must configure the security for the message separately.

You can use the basic Web Services security scenario and specify the
message-level security such as tokens and signatures.

You can also use the WCFService (Custom Binding) scenario, or the
WCFService(Http Binding) scenario with the transport credentials.

How do | test a Web Service that requires Windows
authentication at the HTTP level?
1. Selectthe Web Service scenario from the Scenario Details list.
2. Inthe HTTP tab, specify the credentials.

For details, see "How to Set Security for a Standard Web Service" on page
122.

How do | test a Web Service that uses WS-Security?

Use the basic Web Services security scenario and open the WS-Security
tab. Add the message-level security such as tokens, signatures, and
encryption.
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How do | configure the low-level details of my WS-Security
tokens?

In most cases, you can configure the low-level details as described in
"Advanced Settings Dialog Box" on page 154.
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How to Set up Advanced Standards
Testing

This section provides guidelines for using Service Test in advanced standards

testing.

This section includes:
e How do | testa Web Service that uses MTOM?

e How do | change the WS-Addressing version of a service?
e How do | enable support for a service or activity that uses 256-bit SSL
encoding?
How do | test a Web Service that uses MTOM?

1. Selectthe WCFService (Custom Binding) scenario from the Scenario

Details list.
2. Configure the Encodingto MTOM.

If your service requires advanced settings, click the Advanced button. For
details, see the "Advanced Settings Dialog Box" on page 154.

For more information about the scenario, see "How to Set Security for a
W CF Service" on page 124.
How do | change the WS-Addressing version of a service?

1. Selectthe Web Service scenario from the Scenario Details list.
2. Click the WS-Addressing tab and select a version.

For details, see "How to Set Security for a Web Service on the Port Level"
on page 119.
If your service uses WCF, use the appropriate scenario and configure the

addressing version from the Advanced window's Encoding tab. For details,
see the "Advanced Settings Dialog Box" on page 154.

How do | enable support for a service or activity that uses
256-bit SSL encoding?

Change the SSL cipher order in Windows Vista so that AES256 precedes
AES128 inthe cipher list.
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Tip: Check with an IT professional before performing the following
actions.

To change the cipher order:

1. Type gpedit.msc ata command promptto open your group policy editor.

2. Choose Computer Configuration > Administrative Templates >
Network > SSL Configuration Settings.

3. Openthe only item—SSL Cipher Suite Order.

4. Select Enabled.

5. The firstitem in the listis TLS RSA WITH AES 128 CBC_ SHA
And the second item is TLS RSA WITH AES 256 CBC_ SHA

6. Change thefirst 128 to 256. Then move the cursor forward and change
the 256 to 128.

7. Move the cursor through the list and change the cipher priorities as in the
above step.

8. Close the group policy editor and reboot.
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Reference

This section includes:

e "Security User Interface" on page 138

e "Security Settings for Port / Operation <Name> Dialog Box" on page 139
e "Web Service Scenario " on page 141

e "WCF Service (Custom Binding) Scenario”" on page 147
e "WCF Service (Federation) Scenario”" on page 149

e "WCF Service (WSHttpBinding) Scenario" on page 151
e "Advanced Settings Dialog Box" on page 154

e "Encoding Tab" on page 155

e "Advanced Standards Tab" on page 156

e "Security Tab" on page 157

e "HTTP and Proxy Tab" on page 160

e "Select Certificate Dialog Box " on page 162
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Security User Interface

This section includes:
e "Security Settings for Port / Operation <Name> Dialog Box" on page 139
e "Advanced Settings Dialog Box" on page 154

e "Select Certificate Dialog Box " on page 162
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Security
<Name>

Settings for Port / Operation
Dialog Box

Using the Security Settings dialog box, you can configure security settings for

all operations

in a Web service port. To set the security for a specific step

within your test, use the Security Settings view in the Properties pane.

To access Do the following:

1. Selectacomponentin the Application Component's tree.

2. SelectlInvoke from the right-click menu.

3. Inthe Web Service Call window, select a Web Service
portin the left pane.

4. In the right pane, click the Security button.

5. In the Security Settings for Operation <operation name>
dialog box, click the Edit port's settings hyperlink to
modify settings for the whole port, or clear the Use the
port's security settings option, to change the security
for this particular operation.

Important e For details about choosing a security scenario type, see
information "Security Scenarios Overview" on page 108.
e Forexamples, see "How to Setup Common Web Services
Security Scenarios " on page 125.
Relevant "How to Set Security for a Specific Web Service Operation”
tasks on page 121

User interface elements are described below:

Ul
Elements

(A-Z)

Advanced

Description

Opens the Advanced Settings dialog box. For details, see the
"Advanced Settings Dialog Box" on page 154.

Note: Available only for WCF type Web services.

Import

Loads security settings from a previously saved .stss file.
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ul Description

Elements

(A-Z)

Save Saves the security scenario settings to an .stss (Service Test
Security Scenario) file, for use in other tests. If you are
connected to ALM, it saves the file together with the test.

Service The type of Web service. After selecting a type, Service Test

Details provides an interface for modifying the relevant security
settings. The service types are:

e "Web Service Scenario "on page 141
e "WCF Service (Custom Binding) Scenario" on page 147
e "WCF Service (Federation) Scenario" on page 149
e "WCF Service (WSHttpBinding) Scenario" on page 151
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Web Service Scenario

The simple Web Service scenario provides the HTTP, WS-Security, and WS-
Addressing tabs.

HTTP tab

The HTTP tab lets you provide the HTTP transport level settings such as user
credentials for sending a message with basic authentication, proxy settings,
message-level settings, encryption, and so forth.

HTTF |\A-"S-Securit_l,l| WS Addlessingl

Uzer name:

Password;

Client certificate:
Uze default prosy:
Praozy URL:

PlDH_',J USEr name:

Proxy passwiord:
Feep alive:

Connection timeout:

?I?|_I___?l___

tanage cookies

User interface elements are described below.

ul Description
Elements

(A-Z)

Client The client credentials required for client certificate
certificate authentication when using two-way SSL scenarios.

The Browse button opens the "Select Certificate Dialog Box "
on page 162.

Connection | The time threshold in which to connect through the proxy
timeout server or with authentication.

Keep alive Keeps the connection persistent.

Manage Enables the writing of cookie information.
cookies
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ul Description
Elements

(A-Z)

Proxy URL | The URL and port of the proxy server through which the
message must pass. For example,
http://myProxy:8888/.To use the default, select Use
default proxy.

Proxy user | The credentials for the proxy server through which the
name, message must pass.

Proxy
password

User name, | The credentials for HTTP authentication such as basic
Password authentication, digest, or NTLM. For example, User name:
myDomain\myUser Password: myPassword

WS-Security tab

The WS-Security tab provides an interface to add message level security
using tokens, message signatures, and encryption.

HTTP  WS-Secuiity | w5 Addressing |
BN B X "

g | Type | Mame -

zermamaT oken UzermameT okenl

2 #A0ACerficataT ... | »xB03CertificataT okenl

a L ke Tl L male Toalinad

Taken name: ILI zernameT okenl
Include nonce: v

Uzer name: I

Pazzword: |

Fazzword type: ITe:-tt

Timestamp format: IC[eated

1| | ©

Exclude Timestamp [

User interface elements are described below. (Unlabeled elements are shown
in angle brackets).
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Ul Elements

(A-Z)

Description

- Security Tokens. Enables you to add one of the following
tokens: User Name, X509, Kerberos, Kerberos2, or SAML.

[ Add Message Signature. Adds a signature to the message.
This requires a token.

E Add Message Encryption. Adds encryption to the message.
This requires a token.

®

Delete. Removes the security element from the list.

Up/Down. Positioning tools that allow you to set the priority
of the security elements.

Important: Make sure the security elements are positioned
in order of their priority.

<Encryption
details
pane>

The details of the encryption token.

e Encrypting token. The token to use for encryption,
usually an X.509 type. You can select from a list of all
previously created tokens.

e Encrypting type. Indicates whether to encrypt the whole
destination Element oronlyits Content.

e Key algorithm. The algorithm to use for the encryption of
the session key: RSA15 or RSAOAEP.

e Session algorithm. The algorithm to use for the
encryption of the SOAP message. You can select from a
list of common values.

e XPath (optional). An XPath that indicates the parts of the
message to encrypt. If left blank, only the SOAP body is
encrypted.

e Token (optional). The name of the encrypted token. A
drop down box provides a list of all added tokens. With
most services, this field should be left empty.
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Ul Elements

Description

(A-Z)
<security A list of the tokens, message signatures, and encryptions.
element
list>
Exclude Removes the timestamp from the element’'s SOAP header
Timestamp |before sending itto the server.
<Signature The details of the digital signature used to secure the token.
details .. Do
S e Signing token. The token to use for signing, usually an

ane
P X.509 type. Select from the list of all added tokens.

e Canonicalization algorithm. A URL for the algorithm to
use for canonicalization. A drop down list provides
common algorithms. If you are unsure which value to use,
keep the default.

e Transform algorithm. A URL for the Transform algorithm
to apply to the message signature. A drop down list
provides common algorithms. If you are unsure which
value to use, keep the default.

e Inclusive namespaces list. A list of comma-separated
prefixes to be treated as inclusive (optional).

e What to sign. The SOAP elements to sign: SOAP Body,
Timestamp, and WS-Addressing.

e XPath (optional). An XPath that specifies which parts in
the message to sign. If left blank, the elements selected in
the Signature options field are signed. For example,
//*[local-name(.)="Body'].

e Token (optional). The target token you want to sign.
Select from the drop down list of all added tokens. W ith
most services, this field should be left empty.

<Token Token details for Kerberos tokens:
details .
e Token Name. A meaningful name for the token.
pane> -
Kerberos
tokens
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Ul Elements

(A-Z)

Description

e Host. The host name of the server against which you want
to authenticate. In most cases, it is the host portion of the
service URL.

e Domain. The Windows domain of the server against
which you want to authenticate.

<Token
details
pane> -
Username

Token details for Username tokens.

e Token name. A meaningful name for the token (you can
use the default value).

tokens e Include nonce. Includes a nonce in the token.
e User name, Password
e Password type: Text, Hash, or None.
e Timestamp format:Full,Created, or None.
<Token Token details for X509 Certificate tokens:
details ,

e Token name. A meaningful name for the token.
pane> -
X509 e Certificate. The path of the server certificate file. The
Certificate Browse button opens the "Select Certificate Dialog Box "
tokens on page 162.

e Reference type: How the token should be referenced:
BinarySecurity Token orReference.When the
certificate is used for encryption, for example, a service
certificate, use Reference. When using it for a signature
(for example, a certificate with your private key) select
BinarySecurity Token.

<Token Token details for SAML tokens:
details .
e Load from file. Enables you to browse to a SAML
pane> - -
certificate.
SAML
tokens e Certificate. The path of the certificate file. The Browse

button opens the "Select Certificate Dialog Box " on page
162.
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Ul Elements Description

(A-Z)

e Certificate reference type. How the certificate should be
referenced— by X509 Data or RSA.

WS-Addressing tab

The WS-Addressing tab indicates whether WS-Addressing is used by the
service, and if so, its version number.

THTTP | ws-Secuity WS Addressing |

Vesion: I - |

Reply to: I
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WCF Service (Custom Binding) Scenario

Use this scenario to test WCF services which require security or transport
configurations. For general details, see "W CF Service (CustomBinding)
Scenario Overview" on page 113.

User interface elements are described below (unlabeled elements are shown

in angle brackets):

ul Description
Elements
Advanced |Opensthe Advanced Settings dialog box. For details, see
"Advanced Settings Dialog Box" on page 154.
Client The identity information for the client windows:
Windows . .
. e Current User. The identity of the user logged onto the
Identity .
machine.

e Custom User. A user with the following credentials:

Username, Password, and Domain.
Encoding Encoding.Text, MTOM, or WCF Binary
Identities The identity information for the bindings and certificate:

e Username and Password

e Server /Client certificate. A certificate that provides
identity information for the server or client. Use the Browse
button to open the "Select Certificate Dialog Box " on page
162.

e« Expected DNS, SPN, and UPN. The expected identity of
the serverin terms of its DNS, SPN, or UPN. This can be
localhost, an |P address, or a server name.

Net The type of stream security: None, Windows stream
Security security,or SSL stream security.

Reliable Enables Reliable Messaging in Ordered or Non-ordered
Messaging | format.
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ul Description

Elements

Security e Authentication mode. A drop down list of possible modes
of authentication, such as AnonymousForCertificate,
MutualCertificate, and so forth.

e Bootstrap Policy. A drop down list of possible bootstrap
policies for Secure Conversation authentication., such
as SspiNegotiated,UserNameOverTransport, and
so forth.

Transport |[Transport type.HTTP, HTTPS, TCP, NamedPipe, Or

AutoSecuredHTTP.
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WCF Service (Federation) Scenario

Inthe WCF Service (Federation) scenario, the client authenticates against
the STS (Security Token Service) to obtain a token. The client uses the token
to authenticate against the application server.

User interface elements are described below (unlabeled elements are shown
in angle brackets). For details, see "WCF Service (Federation) Scenario

Overview " on page 114.

ul Description

Elements

(A-Z)

Advanced Opens the Advanced Settings dialog box. For details, see

"Advanced Settings Dialog Box" on page 154.

Identities The identity information for the bindings and certificate:

e Server certificate. A certificate that provides identity
information for the server. Use the Browse button to open
the "Select Certificate Dialog Box " on page 162.

e Expected DNS. The expected identity of the server in
terms of its DNS. Thiscan be localhost, an |IP address,
or a server name.

Security e Authentication mode. A drop down list of possible modes
of authentication, such as AnonymousForCertificate,
MutualCertificate, and so forth.

e Bootstrap Policy. A drop down list of possible bootstrap
policies for Secure Conversation authentication., such
as SspiNegotiated, UserNameOverTransport, and
so forth.

Server e Transport. The transport type: HTTP or HTTPS.

e Encoding. The server's encoding policy: Text or MTOM.

STS Information about the STS:

(Security . . .

Tok e Endpoint address. The endpoint address of the STS. This

oken
. canbe localhost, an |IP address, or a server name.
Service)
Details
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ul Description
Elements

(A-Z)

e Binding. The scenario which references the binding that
contacts the STS.

Page 150 HP Service Test Management (11.50)



Service Test Management User Guide

WCF Service (WSHttpBinding) Scenario

Inthe WCFService(WSHttpBinding) scenario, you can select from several
types of authentication: None, Windows, Certificate, or

Username (message protection). For details, see "WCF Services

(W SHttpBinding) Scenario Overview " on page 115.

Replace the graphic below, or delete the anchored frame and
print-only line after it.

User interface elements are described below (unlabeled elements are shown
in angle brackets) by the client authentication types:

Ul Elements Description

(A-Z)

Advanced Opens the Advanced Settings dialog box. For details, see
"Advanced Settings Dialog Box" on page 154.

Client Authentication type: None, Windows, Certificate, or
authentication [ Username. For details, see below.
type

Client Authentication Types:

e Client Authentication Type — None

e Client Authentication Type — Windows

e Client Authentication Type — Certificate

e Client Authentication Type — Username (message protection)

Client Authentication Type — None

ul Description
Elements

(A-Z)

Expected The expected identity of the server in terms of its DNS. This
server can be localhost, an IP address, or a server name. It can also
DNS be the common name by which the certificate was issued.

Negotiate Negotiates the Web Service's certificate with the server.

server ) ' ) )
You can also provide the server's DNS information.
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Ul
Elements

(A-Z)

credentials

Description

Specify
service
certificate

The location of the service's certificate. If you select this
option, the Negotiate service credentials option is not
relevant.

For more information, see the "Select Certificate Dialog Box "
on page 162.

Client Authentication Type — Windows

Ul Elements

(A-Z)

Client
Windows
identity

Description

The identity information for the client windows:

e Current User. The identity of the user logged onto the
machine

e Custom User. A user with the following credentials:
Username, Password, and Domain

session

Enable secure |[Enables a secure session using Windows type

authentication.

Expected

server identity

The expected server identity method: SPN or UPN.

Client Authentication Type — Certificate

Ul
Elements

(A-Z)

Client
certificate

Description

The location of the client certificate. The Browse button opens
the "Select Certificate Dialog Box " on page 162.

Enable Enables a secure session usingCertificate type
secure authentication.
session
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Ul
Elements

(A-Z)

Description

credentials

Expected The expected identity of the server in terms of its DNS. This
server canbe localhost, an |IP address, or a server name. It can
DNS also be the common name by which the certificate was issued.
Negotiate Negotiates the Web Service's certificate with the server.
server

You can also provide the server's DNS information.

Specify
service
certificate

The location of the service's certificate. If you select this
option, the Negotiate server credentials option is disabled.

For more information, see the "Select Certificate Dialog Box "
on page 162.

Client Authentication Type — Username (message

protection)

Ul
Elements

(A-2)

Description

Enable Enables a secure session using Username type

secure authentication.

session

Expected The expected identity of the server in terms of its DNS. This
server can be localhost, an IP address, or a server name. It can also
DNS be the common name by which the certificate was issued.
Negotiate Negotiates the Web Service's certificate with the server.
server

credentials

You can also provide the server's DNS information.

Specify
service
certificate

The location of the service's certificate. If you select this
option, the Negotiate server credentials option is disabled.

For more information, see the "Select Certificate Dialog Box "
on page 162.

Username,
Password

The authentication credentials of the client.
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Advanced Settings Dialog Box

This dialog box enables you to customize the security settings for your test.

To access Do the following:

1. SelectaWCF Service scenario type from the
Service Details list.

2. Click Advanced

Important e For details, see "Advanced Security Settings " on

information page 117.

Relevant tasks e "How to Set Security fora Web Service on the Port
Level" on page 119

» "How to Set Security for a Specific Web Service
Operation" on page 121

e "How to Set Security fora WCF Service" on page
124

This section includes:

e "Encoding Tab" on page 155

e "Advanced Standards Tab" on page 156
e "Security Tab" on page 157

e "HTTP and Proxy Tab" on page 160
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Encoding Tab

The Encoding tab lets you indicate the type of encoding to use for the
messages: Text, MTOM, or WCFBinary. The defaultis Text encoding.

The user interface elements are described below:

Ul Elements Description

(A-Z)

Encoding The encoding type to use for the messages: Text, MTOM,
Oor WCF Binary.

WS- The version of WS-Addressing for the selected encoding:
Addressing None, WSA 1.0,0rWsSA 04/08.
version
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Advanced Standards Tab

This tab lets you configure advanced W S- standards, such as Reliable
Messaging and the Via address option.

The user interface elements are described below:

ul
Elements

(A-Z)

Reliable
messaging

Description

Enables reliable messaging for services that implement the WS-
ReliableMessaging specification. The encoding type to use for
the messages: Text, MTOM, or WCF Binary.

messaging

Reliable Indicates whether the reliable session should be ordered.
messaging

ordered

Reliable The version to apply to the messages:

WSReliableMessagingFebruary2005 or

version WSReliableMessagingll.

Specify Sends a message to an intermediate service that submits it to

via the actual server. This may also apply when you send the

address message to a debugging proxy. This corresponds to the WCF
clientVia behavior.
This is useful to separate the physical address to which the
message is actually sent, from the logical address for which the
message is intended.

Via The logical address to which to send the message. It may be the

address physical of the final server or any name. It appears in the SOAP
message as follows:
<wsa:Action>http://myLogicalAddress<wsa:Action>
The logical address is retrieved from the user interface. By
default, it is the address specified in the WSDL. You can override
this address using this field.
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Security Tab

The Advanced security settings correspond to the WS-Security
specifications.

WCF Service (WSHttpBinding) Scenarios

Ul Element (A-2) Description

Enable secure Establish a security context using the WS-

session SecureConversation standard.

Negotiate service Allow W CF proprietary negotiations to negotiate the
credentials service's security.

WCF Service (CustomBinding) Scenarios

Ul Element

(A-2) Description

Allow Enables the reply to send a serialized signing token.
serialized
signhing
token on
reply

Default The algorithm to use for symmetric/
algorithm asymmetric encryption.

suite
The algorithm drop down list gets its values from the

SecurityAlgorithm Suite configuration in WCF.

Default: Basic256

Include Includes a timestamp in the header.
timestamp

Key entropy | The entropy mode for the security key. The possible values
mode are:Client Entropy, Security Entropy, and
Combined Entropy.

Default: Combined Entropy

Message The order for signing and encrypting. Choose from:
protection
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Ul Element

(A-Z)

Description

order e Sign Before Encrypt
e Sign Before Encrypt-And Encrypt Signature
e Encrypt Before Sign
Message The W S-Security security version. You can also indicate
security whether to Require derived keys for the message.
version

Protection

Indicates whether the SOAP Body be encrypted/signed. The

level possible values are: None, Sign,and Encrypt And Sign
(default)
Default: Encrypt And Sign
Require Indicates whether to require the cancellation of the security
security context. If you disable this option, stateful security tokens
context will be used in the WS-SecureConversation session, if they

cancellation

are enabled.

Require
signature
confirmation

Instructs the server to send a signature confirmation in the
response.

Security The layout for the message header: Strict, Lax, Lax
header Timestamp First,orLax Timestamp Last.
layout
X509 When to include the X.509 certificate:
Inclusion .
e Always to Recipient
Mode
e Never
e Once
e Always To Initiator
Note: This and the next three options only apply when using
an X.509 certificate.
X509 key The type of clause used to identify the X.509 key.
identifier

clause type
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Ul Element

(A-Z)

Description

e Any

e Thumbprint

e Issuer Serial

e Subject Key Identifier

e Raw Data Key Identifier

X509
Reference
Style

How to reference the certificate:

e Internal

e External

X509 require
derived keys

Indicates whether X.509 certificates should require derived
keys.
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HTTP and Proxy Tab

This tab lets you setthe HTTP and Proxy information for your test.

HTTP (S) Transport

The following table describes the HTTP(S) Transport options:

Ul Element (A-

Z) Description

Allow cookies |Indicates whether to enable or disable cookies.

Authentication | The HTTP authentication method: None, Digest,
scheme Negotiate,NTLM, Integrated Windows

Authentication,Basic,OrAnonymous.

Bypass proxy Indicates whether to ignore the proxy when the service is

on local on the local machine.
Keep-Alive Indicates whether to enable or disable keep-alive
enabled connections.

Max response | The maximum size of the response before being
size (KB) concatenated.

Default: 65 KB

Proxy address | The URL of the proxy server.

Proxy HTTP authentication method on Proxy: Digest,
authentication [Negotiate,NTLM, Basic, Or Anonymous.

scheme

Realm The realm of the authentication scheme in the form of a

URL.

Require client |Indicates whether to require a certificate for SSL
certificate transport.

Transfer mode | The transfer method for requests/responses. The possible
values are Buffered, Streamed, Streamed Request

and Streamed Response.

Use default Indicates whether to use machine's default proxy settings.
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Ul Element (A-

Z) Description

web proxy
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Select Certificate Dialog Box

This dialog box enables you to search and locate a certificate from a file or

Windows store.

To access Do the following:
1. Selecta WCF Service scenario type from the Service
Details list.
2. Click the Browse button adjacent to the
ServerCertificate box.
Relevant "How to Set Security fora WCF Service" on page 124.
tasks

Select Certificate from File

When you select Import from: File, the dialog box shows the relevant user

elements.

The user interface elements are described below:

Ul Elements

(A-Z)

Description

Browse. Enables you to locate the certificate file with a
.ceror .pfx extension.

File

The complete path of the certificate file.

Import from

The source of the certificate file: Windows store or File.

Password
(optional)

The password required to access the certificate.

Select Certificate from Windows Store

When you select Import from a Windows Store, the dialog box shows the
Windows Store related user elements:
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View Image

4.4 Select Certificate E

Input from: ® Windows store 7 File
Store location: LocalMachine
Store name: CertificateAuthority
Search text:
Find
Subject lssuer Private Store Location Store Name

Password (optional):

Ol Cancel

The user interface elements are described below:

ul Description
Elements

(A-Z)

<certificate | A list of the certificates in the Windows store sorted by

list> Subject, Issuer, Private, Store Location, and Store Name.
Find Begins the search for the certificate based on the Search text.
Import The source of the certificate file: Windows store or File.
from

Password The password required to access the certificate.
(optional)

Search text | The text to match in the certificate name. If left blank, the
Find action retrieves all available certificates.

Store The store location, for example Current User.
location

Store The store name, for example, AuthRoot.
name
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Troubleshooting and
Limitations - Web Service Security

This section describes troubleshooting and limitations for working with Web

services security.

Authentication and proxy security are not supported for Web Services
imported from a UDDI.

For Web Service configured with WCF settings: Configuring different
security settings for operations residing on the same portis not supported.

For Web Service configured with WCF settings, user event handlers cannot
be used.

When testing Web Services that require message-level security, the Web
Service security scenario only supports SOAP version 1.1. For SOAP 1.2
use a WCF type scenario.

When using a SAML security token for Web services security, user-
provided content may contain creation and expiration timestamps. To
extend the life of the test, we recommend that you hard-code an expiration
date in the distant future. In this is not possible, change the timestamp by
implementing the OnBeforeApplyProtocolSettings event.

When using a SAML security token for Web services security, if you edit the
values in Grid mode, they may not be updated in Service Test.
Workaround: To update the values, switch to Text mode and save the test.

Web Service steps are not supported when using a SAML token with a
certificate from the file system.

Workaround: Install the certificate to the Windows store and select the
certificate from the store.

The AfterProcessRequestSecurity and the
BeforeProcessResponseSecurity events are not supported for Web
Service activities configured with WCF type scenarios.

When working with Federation type scenarios that use STS (Security Token
Service), you cannot change the SOAP version.

The OnSendRequest and the OnReceiveResponse events are not
supported for Web Service activities configured with WCF type scenarios.
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Concepts

e "Groups Overview" on page 167

Tasks

e "How to Manage Component Groups " on page 170
Reference

e "New Groups User Interface " on page 173

e "New Group Dialog Box" on page 174

Page 165 HP Service Test Management (11.50)



Service Test Management User Guide

Concepts

This section includes:

e "Groups Overview" on page 167

Page 166 HP Service Test Management (11.50)



Service Test Management User Guide

Groups Overview

In an organization, application components have a context. For example, the
components may be located on the same server, may be exposed as part of
the same application, or may take partin the same business process.

In the Application Components module, you use groups to organize your
components into logical groupings. You might, for example, organize them
into groups representing different physical deployments, business processes,
or application types such as Enterprise Resource Planning (ERP) or
Customer Relationship Management (CRM). After you create the groups, you
can associate components to them, and perform tasks upon all members of
the group.

You can add attachments to a group and send e-mails in a similar manner to
that of individual components. For details, see the HPHP Application Lifecycle
Management User Guide.

This section also includes:
e Associating Components to Groups

e Group Coverage

Associating Components to Groups

Groups help you organize your components into logical units. You might, for
example, organize them into groups representing different physical
deployments, business processes, or application types. After you create
groups, you can associate components to the group, and perform tasks upon
the entire group. The same component can be assigned to multiple groups.

The Modeling tab lets you create and view the associations between the
groups and components. For details, see the "Modeling Tab" on page 39.

& i®
NTLMAuth NTLM_Default
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Group Coverage

You define requirements and tests for individual components—not for groups.
When you associate components with groups, the group reflects the coverage
of all its associated entities. You can view the complete coverage in the
group's Testing Status tab. Click any of the sections in the Testing Status
tab, to see the specific coverage for Aspects, Requirements, or Tests.

Details | Testing Status || Modeling | Aftachments

Dashboard | Aspects | Requirements | Tests | Defects

Aspects Requirements Tests
5 Aspects -
A%

r ! — " ‘1 Tests
£ 7 N ) 12 Tests =%
| B5.7% 7 sts
\ N 4 '._. %

T PEspects ;

1 Aspects o
14.3%
[ Mot Covered ore. [ |Blocked — [ |Blocked o

For details, see "Determining Test Coverage" on page 187
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Tasks

This section includes:

e "How to Manage Component Groups " on page 170
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How to Manage Component Groups

This task describes how to create and manage component groups. It also
describes how to associate components to a group and how to check the
testing coverage for the entire group.

This task includes the following steps:
e Create an application component group

e Add acomponentto agroup

e View and Modify Group Details - optional
e Mail Group Information - Optional

e Results and Coverage

Create an application component group

Create a group at the root level of the component tree or under a specific
folder. Service Test Management displays the groups in the component tree
hierarchy. For details, see "New Group Dialog Box" on page 174.

Add a component to a group
1. Selectagroup inthe Application Components tree.
2. Click the Modeling tab.

3. Click Selectinthe Modeling tab to open the application component
folders in the right pane.

4. Expand the tree and select the application component you want to add to
the group.

5. Click Add > Associate “ to add the component to the group.
6. Drag the entities in the Modeling tab into the desired positions, or click

the Arrange Layout button *: to do this automatically.

Tip: If you cannot see the group layout, try refreshing the window or
expanding it with the splitter bar.

For more details, see the "Modeling Tab" on page 39.

View and Modify Group Details - optional

Select a group in the Application Components tree and click the Details tab.

For further information, see the "Details " on page 30.
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Mail Group Information - Optional

Send group details by e-mail to other users. This enables you to routinely
inform users about the status of a group and its components. The e-mail
message includes a link that enables the recipient to go directly to the group.

For more information about sending e-mails directly from ALM, see the HP
Application Lifecycle Management User Guide.

Results and Coverage

Click the Testing Status tab to view the complete coverage for Aspects,
Requirements, or Tests.

For details, see "Determining Test Coverage" on page 187
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Reference

This section includes:
e "New Groups User Interface " on page 173

e "New Group Dialog Box" on page 174
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New Groups User Interface

This section includes:

e "New Group Dialog Box" on page 174
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New Group Dialog Box

This dialog box enables you to create a new application component group.

A New Group

X |9 B B

T Mame: | by Sample Group |

z Details Details

[ Attachments
Assignedto: | [=] Created by. =]
Creation date: | |v|

-

Diescription

To access Use one of the following:
e Select Components > New > New Group.

e Select New > New Group from the shortcut menu.

Relevant tasks "How to Manage Component Groups " on page 170

The following elements are included:

ul Description
Elements

(A-2)

#® Clear All Fields. Clears all the fields in the dialog box so that
you can redefine the group.
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Ul
Elements

(A-Z)

Description

b= Details module. Enables access to the Details and
Description tabs.

i Attachments module. Allows you to attach a file to the
group. For details, see the HP Application Lifecycle
Management User Guide.

Close Closes the dialog box and cancels any changes you made to

the existing screen.

Description
tab

A description of the group's objective.

Details tab |[Lets you set the following fields:
e Assigned To
e Created By
e Creation Date
Name The name of the group. This field is required.
Submit Creates the group whose details you specified.
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Generating Requirements and
Tests

Concepts

e "Generating Requirements and Tests Overview " on page 178
Tasks

e "How to Generate Requirements and Tests" on page 183
Reference

e "Generate Requirements and Tests Wizard" on page 185

"Troubleshooting and Limitations - Generate Requirements" on page 186

Page 176 HP Service Test Management (11.50)



Service Test Management User Guide

Concepts

This section includes:

e "Generating Requirements and Tests Overview " on page 178
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Generating Requirements and Tests
Overview

To test your application, you can manually create requirements and tests, or
use the Requirement and Test Generation wizard to automatically generate
requirements and test scripts.

The Requirement and Test Generation wizard guides you through the process
of creating requirements and scripts to test your application components.
Through the wizard, you indicate which aspects of the component you want to
test. These aspects include interoperability with different toolkits, boundary
testing, and standard compliance.

After you select the testing aspects, Service Test Management generates a
set of requirements, or requirements and tests linked to the component or to
components in the group. Only requirements are linked to components. The
tests are indirectly linked to components through requirements. These
requirements and tests provide pre-packaged testing methodologies and
component information that specify which components of the application need
to be tested, and what to test in each part.

Generated requirements provide a textual description of the testable feature
and the expected behavior, based on a template of the specified testing
aspects adapted to the selected components. Generated tests describe the
test objective and provide an implementation of that testing objective. They
include the test operations and arguments for specific testing types. After
generating requirements and tests, you should customize them to your
particular requirements.

You can also link components to manually created requirements, and
indirectly to tests through requirements. For details on assigning components
to requirements and tests, see "Linking Components and Requirements " on
page 220.

This section also includes:
e Testing Aspects

e Actions after Creating a Test

Testing Aspects

The Requirement and Tests Generation wizard helps you create requirements
and tests that verify different aspects of your component. Service Test
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Management creates a separate requirement for each aspect and child
aspect, and a separate test for each child aspect.

The following table lists the built-in testing aspects:

Aspect Name Description

Positive Generates a full positive test that checks each operation
Testing of the component.

The wizard creates a separate Positive Testing test for
each of the service's operations.

Standard Checks the component's compliancy with industry
Compliance standards such as WS-l and SOAP.
Service Tests the interoperability of the component's operations

Interoperability | with all supported technological platforms.

Tests that the component is fully interoperable with all
supported technological platforms, by calling all of its
operations with default or expected values.

For Web Services, it contains the following sub-aspects:

e .NET Framework. Tests that the service is fully
interoperable with .NET Framework WSE 2 toolkit.

e Axis/Java Based Web Services. Tests that the
service is fully interoperable with Axis 1.3 Web
Services.

Security Tests security. Contains the following sub-aspects:

Testin
9 e SQL Injection Vulnerability. Checks if the component

is vulnerable to SQL injections by injecting SQL
statements and errors into relevant parameters.

e Cross-site Scripting (XSS). Attempts to hack the
component by injecting code with relevant parameters
that will disrupt its functionality.

Boundary Using the negative testing technique, creates tests to
Testing manipulate data, types, parameters, and the actual SOAP
message to test the component to its limits.

Contains the following sub-aspects:
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Aspect Name Description

e Extreme Values. Provides invalid data types to the
components and verifies they are not accepted.

e Null Values. Provides NULL parameters to the
components to verify they are not accepted.

Performance Contains the following sub-aspects:

Testin
9 e Stress Testing. Tests the maximum load that can be

placed on the application.

e Overload Sustainability Testing. Tests how well the
hardware allocated for the application can support the
number of anticipated users.

e Volume Testing. Tests that the system can handle a
massive data entry.

e Longevity Test. Tests that the system can sustain a
consistent number of concurrent users and executing
transactions using near-peak capacity, over a minimum
24-hour period.

e Scalability Testing. Repeated stress, overload,
volume, and longevity tests with different server or
network hardware configurations.

You can also define custom aspects. For details, see the Customization's
"Aspects Tab " on page 255.

Actions after Creating a Test

After generating requirements or requirements and tests, you can do the
following:
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Action Description

Edit the
generated
requirements

You can modify the details, attachments, component
coverage, test coverage, and defect links for any
requirement to suit your specific testing objectives. For
example, you might want to define customized thresholds
that are not reflected in your component definitions. For
details about defining requirements, refer to the HP
Application Lifecycle Management User Guide.

Edit the You can edit the generated scripts to expand their scope
generated and purpose. You can edit manual tests, scripts designed
tests with Service Test, or those created by a third-party vendor.
Configure You can configure parameters for test instances in the Test
parameters Lab module. For details, refer to the HP Application

for test Lifecycle Management User Guide.

instances

Manually set
requirements

You can manually set requirements for a component. For
details on linking components to requirements, see "Linking
Components and Requirements " on page 220.

Manually
add test
coverage

You can manually add test coverage for a component. For
details, see "Linking Components and Requirements " on
page 220.

Run the test

Run the test from ALM's Test Lab module. For details, see
the HP Application Lifecycle Management User Guide.
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Tasks

This section includes:

e "How to Generate Requirements and Tests" on page 183
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How to Generate Requirements and

Tests

This task describes how to create requirements or tests for checking the
quality of your component.

This task includes the following steps:
Prerequisites

Run the wizard - optional
Review the generated tests

Remove unwanted tests or requirements - optional

Prerequisites

Make sure you have at least one componentin the Application
Components tree. If not, use the Components menu to create one. Select
the component for which you want to create requirements or tests.

Run the wizard - optional

To create aspect-based tests using a wizard, select Components >
Generate Requirements/Tests. For details, see the "Generate
Requirements and Tests Wizard" on page 185.

Review the generated tests

After the generation process, you can review the generated entities in the
Testing Status tab. This tab also provides full coverage information for
each requirement and test. For details, see "Determining Test Coverage"
on page 187.

Remove unwanted tests or requirements - optional

Toremove a test or requirement, selectitin the Testing Status tab and

click the Delete button # . For details, see "Determining Test Coverage"
on page 187.
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Reference

This section includes:

e "Generate Requirements and Tests Wizard" on page 185

Page 184 HP Service Test Management (11.50)



Service Test Management User Guide

Generate Requirements and Tests
Wizard

This wizard enables you to create requirements and/or tests for your
component.

To Select Components > Generate Requirements/Tests.
access

Relevant | "How to Generate Requirements and Tests" on page 183
tasks

Wizard This wizard contains:

ma
P Select Entities to Generate Page > Select Testing Aspects Page

> Select Locations Page > Summary Page > Generate Page

See also | ¢ "How to Check the Testing Status " on page 199

e "How to Check the Testing Status " on page 199
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Troubleshooting and
Limitations - Generate Requirements

This section describes the limitations that apply to the Generate
Requirements and Tests wizard.

e The Interoperability testing aspects are not supported when generating a
test with the Requirement and Test Generation wizard and choosing the
ST11.50 Generator. This includes the .NET Framework and Axis/Java
Based Web Services testing aspects.

e When using the Generate Requirements and Tests wizard for a
application component type other than Web Services, the Select script
generator drop down continues to show the Service Test generator option.
This option is not supported for non-Web Service components, and it may
generate an error.

e When using the Generate Requirements and Tests wizard, you cannot
select the root folder, Subject, as a location for the tests.
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Concepts

e "Coverage Overview " on page 189

e "Rule Violations" on page 190

e "Aspect Coverage" on page 191

e "Requirements Coverage" on page 192

e "Operations Coverage" on page 194

e "Tests Coverage" on page 195

e "Defects Coverage" on page 197

Tasks

e "How to Check the Testing Status " on page 199
Reference

e "Testing Status Tab "on page 203

e "Testing Status Dashboard " on page 204
e "Rules Tab" on page 206

e "Aspects Tab " on page 208

e "Requirements Tab" on page 210

e "Operations Tab " on page 213

e "Tests Tab" on page 215

e "Defects Tab" on page 218
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Concepts

This section includes:

e "Coverage Overview " on page 189

e "Rule Violations" on page 190

e "Aspect Coverage" on page 191

e "Requirements Coverage" on page 192
e "Operations Coverage" on page 194

e "Tests Coverage" on page 195

o "Defects Coverage" on page 197
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Coverage Overview

You analyze the quality of your application components using charts that
display the status of the testing elements: aspects, requirements, tests,
operations, and defects. You can analyze either a specific component or all
the components in a group or folder.

The Testing Status tab shows the coverage of the requirements and tests as
they were defined for the components.

This section also includes:

e "Rule Violations" on page 190

e "Aspect Coverage" on page 191

e "Requirements Coverage" on page 192
e "Operations Coverage" on page 194

e "Tests Coverage" on page 195

e "Defects Coverage" on page 197
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Rule Violations

The Testing Status > Rules tab shows you the rules that were violated by
the component.

The following table describes the rule violations.

Requirement Status Description

Rule name The name given to the rule.

Rule description A description of the rule.

For task details, see "How to Check the Testing Status " on page 199.
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Aspect Coverage

The Testing Status Aspects tab lets you see the coverage of the testing
aspects defined for the component testing. This information is dynamic and
displays the current testing status in percentages. It is useful for the business
analyst or system architect who wants to see the coverage in meaningful

terms.

The following table describes the aspect statuses.

Aspect
Status (A-

Z)

Description

All Failed All the aspect's requirements are assigned the Failed status.
All Passed [ All the aspect's requirements are assigned the Passed status.
No All the aspect's requirements are assigned either the No
Run/Not Run,Not Completed or Not Covered status.
Completed
Not All the aspect's requirements are assigned the Not Covered
Covered status.
Some At least one of the aspect's requirements is assigned the
Failed Failed status.
Some At least one of the aspect's requirements is assigned the
Passed Passed status. All other requirements have either the No
Run, Not Completed, or Not Covered status.
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Requirements Coverage

Requirements coverage is used to connect components to other Application
Lifecycle Management entities (tests, test sets, and defects) through the
requirement. This helps you keep track of the relationship between your
requirements and components, and ensures compliance with your
requirements throughout the testing process. After you have created tests,
you associate assigned requirements with tests and defects. In this way, you
can keep track of your testing needs at all stages of the testing process. If a
requirement changes, you can immediately identify which tests and defects
are affected, and who is responsible.

To test application components in Service Test Management, you must link
them to requirements. When you define a component, you can link it to an
existing requirement or create new requirements.

To use existing requirements, you drag them from the Requirement entities
tree to your component.

To create new requirements, use the Requirement and Test Generation
wizard as described in "Generating Requirements and Tests " on page 176.

The Testing Status > Requirements tab lets you see the coverage of the
requirements that were linked to the component. This information is dynamic
and displays the current status in percentages. It is most useful for advanced
users who understand the ALM coverage model and want to integrate
application components into that model.

The following table describes the requirement statuses.

Requirement

Status (A-Z) Description

Failed At least one test associated with the requirement has
failed.

N/A The terms Passed and Failed do not apply to the

requirement.

No Run All tests associated with the requirement have a No
Run status.

Not Completed All tests associated with the requirement have the Not
Completed status.
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Requirement

Status (A-Z) Description
Not Covered There are no tests associated with the requirement.
Passed All tests associated with the requirement have passed.

To manually link requirements to components, see "Linking Components and
Requirements " on page 220
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Operations Coverage

The Testing Status > Operations tab lets you see the testing status per

operation in chart form. This is useful when the componentis less granular
and its operations may be considered as separate use cases for quality

assurance.

When you expand an operation, you can see the status of the tests associated

with the operation. In this context, association indicates that:

e the testis linked to arequirement which is linked to this component

e the test uses this operation.

The following table lists the statuses:

Aspect

Status (A-Z)

Description

All Failed All of the component's operations had a Failed status for
their tests.

All Passed All of the component's operations had a Passed status for
their tests.

No Run/Not [ Allofthe component's operations had the status of No

Completed Run,Not Completed or Not Covered for their tests.

Not Covered

All of the component's operations had the status of Not
Covered for their tests.

Some Failed

At least one of the component's operations had a Failed
status for their tests.

Some Some of the component's operations had a Passed status
Passed for their tests.
All other's had either the No Run, Not Completed, or Not
Covered status.
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Tests Coverage

The Testing Status > Tests tab lets you see the coverage of the tests that
were linked to the component. This information is dynamic and displays the
current status in percentages.

The following table lists the possible statuses:

Status (A-Z) Description

Blocked The percentage of tests that were blocked from being run.
Failed The percentage of tests that returned a Failed status.
N/A The percentage of tests to which the terms Passed and

Failed do not apply.

No Run The percentage of tests that were not run.

Not The percentage of tests that were not completed.
Completed

Passed The percentage of tests that returned a Passed status.

If there are no tests linked to the application component, Service Test
Management provides links to the Requirements and Test Generation
wizard or to the Tests Tree tab.

Dashboard | Rules | Aspects  Requirements | Operations | Tests | Defects

A | Tests Tree ®

algav-»

Mo linked tests.

Link tests in one of the following ways:

1.lUse the Beguirerments and Tests generstion B-E_ Subject
wizard i-JL Unattached
2. Click Zeled to open the Tests tree and drag an __r__=| BRT

itern into the Tests Coverage gnd. E Integration Testing { [

----- £ Unit Testing (AL

1 Select [ [V & ¥

Tests Coverage:

Test ID Test Hame Descrintion Execut

1 1 p| (14 il 3

Alternatively, you can link components to tests through the Test Plan module.
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Note: You can create automatic coverage between test instances and
components using the ALLOW_REQ_COVERAGE_BY_TEST_
INSTANCE parameter in Site Administration. For details about this
parameter, refer to the Application Lifecycle Management Administrators
Guide.
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Defects Coverage

The Testing Status > Defects tab lets you see the coverage of the defects
that were linked to the component. This information is dynamic and is
displayed in a chart form, based on the severity of the defects.

You do not link a defect directly to a component. Instead, you link a defect to a
requirement or test. If the component was assigned a test that is linked to a
defect, Service Test Management displays the defect status in this tab.

For details, see the Test Plan module documentation in the HP Application
Lifecycle Management User Guide.
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Tasks

This section includes:

e "How to Check the Testing Status " on page 199
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How to Check the Testing Status

This following steps describe how to check the testing status of your
component. You check the testing status by viewing the coverage of the
aspects, requirements, operations, tests, and defects associated with your
component.

This task includes the following steps:
e View the Aspects coverage - optional

e View the Requirements coverage - optional
e View the Operations coverage - optional

e View the Tests coverage - optional

e View the Rule Violations - optional

e View the Defects coverage - optional

To check the testing status, you do not need to check all of the coverage
types. The coverages you need to check depends on how you designed your
test plan and your area of focus. In one instance you may be interested solely
in the testing aspects, while in another scenario, the test requirements may be
the most relevant.

View the Aspects coverage - optional

1. Selecta component, group, or folder in the tree hierarchy.

2. Selectthe Testing Status tab and click its Aspects button. Service Test
Management shows a graphic representation of the coverage in the top
pane, and a list of the required aspects in the bottom pane. The graph only
shows the aspect coverage—not the requirements. For user interface
details, see the "Aspects Tab " on page 208.

3. Expand an aspect to see its associated requirements. Click on a
requirement to open the item in the Requirements module. For details,
see the HP Application Lifecycle Management User Guide.

View the Requirements coverage - optional

1. Selecta component, group, or folder and click the Testing Status >
Requirements tab.

2. Expand arequirement to see its associated tests. Click on a test to open it
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in the Test Plan module. In the expanded grid, you can drag a test from
one parentrequirement to another.

If there are no requirements associated with this component, use the
"Generate Requirements and Tests Wizard" on page 185 to create them.
To add existing requirements to the coverage, click Select to open the
Requirements Tree tab in the right pane, and drag an item into the
Requirements Coverage grid.

Double-click on a requirement in the grid to open itin the Requirements
module. To return to your last view, click on Application Components in
the left pane.

For details about the Requirements tab, see "Requirements Tab" on page
210.

View the Operations coverage - optional

1.

2.

Select a component and click the Testing Status > Operations tab.

Expand an operation to see the status of the tests associated with the
operation.

To view the test details, click on a test in the grid to open itin the Test
Plan module. For details about the Requirements and Test Plan
modules, see the HP Application Lifecycle Management User Guide.

To return to your last view, click the Application Components module
button in the left pane.

For user interface details, see the "Operations Tab " on page 213.

View the Tests coverage - optional

1.

Select a component, group, or folder and click the Testing Status > Tests
tab.

To add more tests to a component's coverage, click Select. Expand the
Tests Tree in the right pane and select the test you want to add to the
coverage. Use the filter button to show only the desired tests.

Drag the test to the Tests Coverage grid, or click the Add to Coverage
button < .
Click on a testin the Tests Coverage grid to open itin the Test Plan

module. To return to your last view, click Application Components in the
left pane.
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Tip: In the grid, use the right-click menu to create new tests or
navigate to an existing test.

For user interface details, see the "Tests Tab" on page 215.
View the Rule Violations - optional
1. Selectacomponentin the Application Components tree.

2. Selectthe Testing Status > Rules tab. Service Test Management shows
a list of the rule violations for the selected component.

3. Toresolve the violations, click Resolve All to open the "Generate
Requirements and Tests Wizard" on page 185.

For user interface details, see the "Rules Tab" on page 206.
View the Defects coverage - optional
1. Selectacomponent or group in the tree hierarchy.

2. Selectthe Testing Status > Defects tab. Service Test Management
shows a graphic representation of the coverage in the top pane, and a list
of the defects in the bottom pane.

3. Click on a defect to view its details in the Defects module. To return to
your last view, click the Application Components module in the left
pane.

4. To refresh the chart, click the Refresh button.
For user interface details, see the "Defects Tab" on page 218.

For more information about the Requirements, Test Plan, and Defects
modules, see the HP Application Lifecycle Management User Guide.
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Reference

This section includes:

e "Testing Status Tab "on page 203

e "Testing Status Dashboard " on page 204
e "Rules Tab" on page 206

e "Aspects Tab " on page 208

e "Requirements Tab" on page 210

e "Operations Tab " on page 213

e "Tests Tab" on page 215

e "Defects Tab" on page 218
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Testing Status Tab

This section describes the interface of the Testing Status sub tabs.
e "Testing Status Dashboard " on page 204

e "Rules Tab" on page 206

e "Aspects Tab " on page 208

e "Requirements Tab" on page 210

e "Operations Tab "on page 213

e "Tests Tab" on page 215

e "Defects Tab" on page 218
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Testing Status Dashboard

The Testing Status dashboard displays a coverage summary of each of the
following items: Aspects, Requirements, Operations, Tests, and Defects.

Dashboard | Rules | Aspects | Requirements | Operations | Tests | Defects
Aspects Reguirements Operations
2 Aspects 2
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[m] ==
[ Mot Covered — [ |Blocked — s T I3 ;Z__ %
fi o9 g oo
Tests Defects
3 Fixed
. : Mew
ye % z d Open
MTests| | 2
20 Tests _ —45% || o 2
Qﬂ.gll/o : e EE;tS ;
£ 1 11
', / =
0
[ |Blacked [Failed 2-Medium
MAre... Severity
To access Do the following:
e Selectthe Application Components module.
e Select an entity in the Application Components
tree.
e Selectthe Testing Status> Dashboard tab.
Important Click on a graph to openitin a separate tab.
information
Relevant tasks "How to Check the Testing Status " on page 199

The graphs are described below. Click on a graph to open it in a new tab.
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Ul Elements

(A-2)

Description

Aspects A graphical representation of the coverage by the testing
aspects.
Defects A graphical representation of the coverage for the defects

associated with the component.

Operations

A graphical representation of the coverage by the
component's operations.

Requirements

A graphical representation of the status of the
requirements associated with the component.

Tests A graphical representation of the status of the tests
associated with the component.
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Rules Tab

This tab enables you to view and manage the rules violated by the selected

component.

Dashboard | Rules | Aspects | Requirements | Operations | Tests 3

Fule Violations
‘[['ﬂ, @‘?* 2 Resolve All
Rule name Rule...
Compatibility..  All component..
Sanity Rule All compaonent..
To access Do the following:
e Selectthe Application Components module.
e Select an application component.
e Selectthe Testing Status> Rules tab.
Important See "Rule Violations" on page 190.
information , L
Note: Available only for Application Component type
entities.
Relevant tasks "How to Check the Testing Status " on page 199

The following

elements are included (unlabeled Ul elements are shown in

angle brackets):

ul
Elements

(A-2)

Description

11 Select Columns. Enables you to select the columns to display
in the Rule Violations grid.

& Refresh. Reloads the list of rule violations.

- Set Filter/Sort. Enables you to set a filter for the rule
violations or sort them by a criteria.
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ul Description

Elements

(A-Z)

<Rule A list of all the rule violations for the selected component.

Violations

. Default: Rule Name and Rule Description columns.

grid>
Available Columns: Alert ID, Alert is active, and Component
name.

Resolve Resolve All. Opens the Generate Requirements and Tests

All wizard to resolve the rule violations. For details, see the
"Generate Requirements and Tests Wizard" on page 185.
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Aspects Tab

This tab displays the coverage per testing aspect in both a graphical

representation and a grid layout.

Dashboard | Rules | Aspects | Requirements | Operations | Tests | Defects

5 Aspects =
71.4% w
' - / “f1 Aspects
] \/ 14.3%
'--"-I—E*;T'Aspeu:ts
14.3%
[ Mot Cavered []aa Failed []3ome Failed [ ]Zome Passed e,
o .
Aspects Coverage:
Hame Status Tested By Summans
#- Perdormance Testing  No RunfMot C. | £ |
Service Interoperability Mo Bunfhot C. a |
Standard Compliance  All Failed P |
Boundary Testing Mo BunMot C. 0 ]
Faositive Testing Mo RunMot C. 1 |
Myhdspect! _renamed  Some Passed | 3 i |
Securty Testing Mo RunMot C. a |

To access

Do the following:
e Selectthe Application Components module.

e Select an entity in the Application Components
tree.

e Selectthe Testing Status> Aspects tab.

Important
information

See "Aspect Coverage" on page 191.

Relevant tasks

"How to Check the Testing Status " on page 199

The following elements are included (unlabeled Ul elements are shown in

angle brackets):
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ul Description
Elements
(A-Z)
= Refresh. Reloads the status of the testing aspects and
refreshes the graph.
= Collapse. Shows the aspect only, but not its tests or
requirements.
Expand. Shows the tests associated with the aspect.
<graph A graphical representation of the requirement coverage
pane>
<grid A list of all aspects associated with the component.
pane> . . ;
e Expand the aspect to see a list of its associated tests.
e Click on atestto openitinthe Test Plan module.
e Click Application Components in the left pane to return to
the mostrecent view of the component.
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Requirements Tab

The Requirements tab displays the coverage per testing requirement in both a
graphical representation and a grid layout.

Dashboard | Rules  Aspects | Requirements | Operations | Tests | Defects

»

| [

DBlDCked .FaiIEd DNM‘ DND Run mare...

Fi Select 3
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Requirements Coverage:
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B re e & Passed 1 test [FPassed]
#=0 Basic mytestingl Tests my tests? W Mot Covered 3
Ll = PR et o | Tocto ratocte 2 TF kot T Py
To access Do the following:

e Select an entity in the Application Components
tree.

e Selectthe Testing Status> Requirements tab.

Important See "Requirements Coverage" on page 192.
information

Relevant tasks "How to Check the Testing Status " on page 199

The following elements are included (unlabeled Ul elements are shown in
angle brackets):

ul Description

Elements

Select Opens the Requirements tree enabling you to add more
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ul

Elements

Description

requirements to your test. For details see "Requirements Tree
Panel" below.

Select Columns. Opens the Select Column dialog box enabling
you to select the columns to display in the grid.

L§]

Refresh. Reloads the status of the requirements and refreshes
the graph.

Remove. Unlinks the requirement and the component. Note that
unlinking a requirement may remove the linkage to all tests and
defects that are associated with the component only through this
requirement.

»

Collapse. Collapses the graph window and show more of the
grid.

4

Expand. Shows the graph window and displays less rows of the
grid.

<graph
pane>

A graphical representation of the requirement coverage.

<grid
pane>

A list of all requirements associated with the component.
e Expand arequirementto see a list of its associated tests

e Click on arequirementto openitinthe Requirements
module.

e Click on atestto openitinthe Test Plan module.

e Click Application Components in the left pane to return to
the mostrecent view of the component.

Requirements Tree Panel

The following elements are included (unlabeled Ul elements are shown in
angle brackets):

Ul Elements Description

Add Coverage. Adds coverage for the selected
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Ul Elements Description

requirement. If you select a parent requirement, it adds

all sub-requirements.

& Refresh. Refreshes the Requirements tree.

Q Find. Opens the Find dialog box for locating a
requirement.

- Set/Clear Filter. Sets or clears the filter.

e Set Filter / Sort. Opens the Set Filter/Sort dialog box
allowing you to filter out and sort the requirements by
any field.

e Clear Filter / Sort. Clears all filters and sorting
settings and displays all requirements.

3 Go to Requirement by ID. Locates the requirement
whose ID you specify.
X Close. Closes the Requirements tree pane.

To reopen this view, click the Select button in the
Requirements tab.

<Requirements | A tree view of all of the requirements by folder and group.
tree> An icon indicates the requirement type.

Tip: If a filter is active, there could be hidden
requirements. To see all requirements, click Clear Filter.
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Operations Tab

This dialog box displays the coverage per operation in both a graphical

representation and a grid layout.

Dashboard | Rules | Aspects  Reguirements | Operations | Tests | Defects

»

7
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inform ation

To access Do the following:
e Selectthe Application Components module.
e Select an entity in the Application Components
tree.
e Selectthe Testing Status> Operations tab.
Important See "Operations Coverage" on page 194.

Note: Available only for Application Component
type entities.

Relevant tasks

"How to Check the Testing Status " on page 199

The following elements are included (unlabeled Ul elements are shown in

angle brackets):
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ul

Elements

Description

& Refresh. Reloads the status of the operations and refreshes the
graph.
= Collapse. Collapses nodes with descendants.
Expand. Shows the operations and their testing status.
<graph A graphical representation of the Operations coverage.
pane>
<grid A list of all operations associated with the component.
pane> . . . .
e Expand the operation to see a list of its associated tests.
e Click atesttoopenitinthe Test Plan module.
e Click Application Components in the left pane to return to
the mostrecent view of the component.

Page 214

HP Service Test Management (11.50)



Service Test Management User Guide

Tests Tab

This dialog box displays the status per testin both a graphical representation

and a grid layout.

Dashboard  Rules  Aspects  Reguirements | Operations | Tests | Defects
T 3 Tests
[ nan
| !
_ 1 Tests
10 Tests . 1%
71.4%

[ |Blocked [JFailed []rusa [ JMa Run [ JMot Compl.. [ |Passed
4] Select | [ & X,
Tests Coverage:
Test ID Test Name Descrintion Execution... Tvne -
36 £hb Positive Te.. Mot Completed  kARNUAL
a7 2h Standard . Mo Run RAAMLLAL =
38 26 MET Fram. Mot Campleted | MANUAL
39 2hb Axis Java . Failed hAAMILIAL
40 2b SOL Injecti.. Mot Campleted | MANUAL
41 2h Cross-site.. Mo Run RAAMLLAL
To access Do the following:

e Selectthe Application Components module.

e Select an entity in the Application Components

tree.

e Selectthe Testing Status> Tests tab.
Important See "Tests Coverage" on page 195.
information
Relevant tasks "How to Check the Testing Status " on page 199

The following elements are included (unlabeled Ul elements are shown in

angle brackets):
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ul Description

Elements

Select Opens the Tests tree enabling you to associate more tests with
your component. For details see "Tests Tree Panel" below.

[ Select Columns. Opens the Select Column dialog box enabling
you to select which columns to show in the grid.

= Refresh. Reloads the status of the test and refreshes the graph.

x Remove. Unlinks the test from the requirement through which it
is associated with the component.

# Collapse. Collapses the graph window and shows more of the
grid.

¥ Expand. shows the graph window and displays less rows of the
grid

<graph A graphical representation of the test coverage.

pane>

<grid A list of all tests associated with the component.

pane> , . .
e Click the test link to go to the test in the Test Plan module.
e Click the Application Components to return to the most

recent view of the component.

Tests Tree Panel

The following elements are included (unlabeled Ul elements are shown in
angle brackets):

Ul Elements Description

=] Add Coverage. Adds the selected test to the coverage of
the component or requirement. If you select a folder or
group, it adds all sub tests.
& Refresh. Refreshes the Tests tree.
Q Find. Opens the Find dialog box for locating a
requirement.
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Ul Elements Description

AT Set/Clear Filter. Sets or clears the filter.

e Set Filter / Sort. Opens the Set Filter/Sort dialog box
allowing you to filter out and sort the tests.

e Clear Filter / Sort. clears all filters and sorting settings
and displays all tests.

5] Go to Test by ID. Locates the test whose ID you specify.

X Closes the Tests tree pane.

To reopen this view, click the Select button in the Tests
tab.

<Requirements | A tree view of all of the tests by folder and group

Tree> . . . . .
Tip: If a filter is active, there could be hidden tests. To

see all tests, click Clear Filter.
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Defects Tab

This dialog box displays the status of the defects in both a graphical

representation and a grid layout. It shows their status and the number of the

defects, and provides direct links to those defects.

Dashboard  Rules  Aspects | Requirements | Operations | Tests | Defects

Defects %
3 Fixed
3 Mew
2 d Open
2
o 2
]
=
E | 1 1
=
] _
2-Medium 3-High 5-Urgent
Severity
S .
Defects Coverage:
Defect ID Detected By  Assioned To  Status Severitv Summary
r admin Open FHigh Failed Sanity
13 admin MNew 2-tdedium Duplicate Fea..
14 admin RN 5-Urgent Missing Featu..
15 admin Fixed 2-Medium Obsolete Feat.
16 admin = 2-hedium Irrelewvant Fea..

To access

Do the following:
e Selectthe Application Components module.
e Select an entity in the Application Components tree.

e Selectthe Testing Status> Defects tab.

Important
inform ation

See "Defects Coverage" on page 197.

Note: Available only for Application Component and
Group type entities.

Relevant tasks

"How to Check the Testing Status " on page 199

The following elements are included (unlabeled Ul elements are shown in

angle brackets):
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ul Description
Elements
11 Select Columns. Opens the Select Column dialog box enabling
you to select which columns to show in the grid.
& Refresh. Reloads the status of the defects and refresh the
graph.
<graph A graphical representation of the defects coverage.
pane>
<grid A list of all defects associated with the component and their
pane> status.
e Click on a defectin the Defect ID column to open itin the
Defects module.
e Click Application Components in the left pane to return to
the mostrecent view of the defects coverage.
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Requirements

Concepts

e "Linking Components Overview " on page 222

Tasks

e "How to Link Components to Requirements and Tests" on page 224
Reference

e "Linking Component User Interface " on page 226

e "Link <test-name> to Requirement Dialog Box" on page 227

e "Application Components Tab - Requirements Module "on page 229
e "Application Components Tab - Test Plan Module " on page 231

e "Application Components Tree Panel "on page 233
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Concepts

This section includes:

e "Linking Components Overview " on page 222
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Linking Components Overview

To test components in Service Test Management, you must link them to
requirements or tests. Requirement coverage is used to connect components
to other Application Lifecycle Management entities such as tests, test sets,
and defects.

Linking components to requirements and tests helps you keep track of the
relationship between your requirements and components, and ensures
compliance with your requirements throughout the testing process.

For information on viewing test and requirement coverage, see "Determining
Test Coverage" on page 187

When working in the Requirements module, you can view the application
components linked to each requirements. The Application Components tab
displays a list of those components, with other basic information.

Using the Test Plan module's Application Components tab (available only
after you enable the Service Test Management extension), you can set and
view the application components linked to each test.

When you link a component to a test, Service Test Management prompts you
to select a requirement. To allow you to track your testing through ALM, you
link tests to the default requirement or to an existing one.
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Tasks

This section includes:

e "How to Link Components to Requirements and Tests" on page 224
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How to Link Components to
Requirements and Tests

This task describes how to link components to either requirement or tests. If
you are linking to a test, you also indicate the requirement to associate with
the test.

This task includes the following steps:
e Link a componentto arequirement - optional

e Linkacomponentto atest - optional

e Results

Link a component to a requirement - optional

Use the ApplicationComponents tab in the Requirements module to link
components to requirements. For details, see "Application Components Tab -
Requirements Module " on page 229.

Link a component to a test - optional

Use the ApplicationComponents tab in the Test Plan module to link a
components to tests. For details, see "Application Components Tab - Test
Plan Module " on page 231.

When you add a test to component coverage, the Link <test-name> to
Requirement dialog box opens and prompts you to choose the Default
Requirement or Linked Requirements. Select a requirement and click OK.
For details, see the "Link <test-name> to Requirement Dialog Box" on page
227.

You can also link a component to a test through the Testing Status tab. For
details, see "Tests Coverage" on page 195.

Results

You can view and modify the linkages in the Application Components tab
within the Test Plan or Requirements modules. For details, see "Linking
Component User Interface " on page 226.
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Reference

This section includes:

e "Linking Component User Interface " on page 226

e "Link <test-name> to Requirement Dialog Box" on page 227

e "Application Components Tab - Requirements Module " on page 229
e "Application Components Tab - Test Plan Module " on page 231

e "Application Components Tree Panel "on page 233
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Linking Component User Interface

This section includes (in alphabetical order):

e "Link <test-name> to Requirement Dialog Box" on page 227

e "Application Components Tab - Requirements Module " on page 229
e "Application Components Tab - Test Plan Module " on page 231

e "Application Components Tree Panel "on page 233
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Link <test-name> to Requirement Dialog
B ox

This dialog box enables you to select a requirement to associate with your
test.

Link Servicel to Requirement

3 Default requirement

#Linked requirement

®lo

Hame Descrintion Direct Cover Status
Servicel Stan.. | Tests that Ser. Mo Run
[ Service]l Posi. Teststhatall. Mo Run

reqd reqd Mot Covered

To access Do the following:

1. Open the Test Plan module, and select the
ApplicationComponents tab (you may need to scroll to
the right).

2. Click Select to open the selection panel, and choose a
entity from the Application Components Tree tab.

3. Click the “ button.

Important This dialog box only opens if the application componentis
information | linked to a requirement other than the default one.

Relevant "How to Link Components to Requirements and Tests" on
tasks page 224
See also "General Tab " on page 249 (Customization)
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User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Elements

(A-Z)

Description

requirement

I Select Columns. Opens the Select Column dialog box
enabling you to select the columns to display in the grid.

= Refresh. Reloads the components in the list.

<Linked A list of the requirements associated with the test.

Requirements . .

list> To modify the columns, click the Select Columns button.

is

Default Default Requirement. Creates a link between the default

requirement of the component and the test, if it does not
already exist. The linked requirements list is not relevant
for this option.

You can set the default requirement in the Customization
section, For details, see "Select Requirement" on page
250.

Linked
requirement

Enables you to select a specific requirement to link to the
test from the Linked Requirements list.

This option is not available if the component or group has
no linked requirements. To link a requirement with a
component, see "How to Check the Testing Status " on
page 199.
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Application Components Tab -
Requirements Module

This dialog box enables you to link components to an existing requirement.

Business Models Link.. | Risk Assessment | Histony |App|icatiDnCDmpD... * 1

Covered Components:

£ Select ¥ | [V & .
Componen... Component... Import... WSDL... Assio... Last undated
tApplication C.. 50 Basic URL EwventSer...
Application C.. | Servicel LRL servicel admin 17202011
Application C.. | Service? URL W5_Echo..

Application C.. | Serviceh URL Twpes3ny

To access Do the following:

e Openthe Requirements module.
e SelectView > Requirement Details.
e Expand the tree and select a requirement.

e Inthe right pane, scroll right to ApplicationComponents

tab.
Relevant "How to Link Components to Requirements and Tests" on
tasks page 224
See also "How to Check the Testing Status " on page 199

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Elements Description

(A-2)

Select Opens the ApplicationComponentsTree tab in the right
pane to link a component to the requirement. For details,
see the "Application Components Tree Panel " on page 233.

# Delete. Unlinks the component and requirement.

Page 229 HP Service Test Management (11.50)



Service Test Management User Guide

Ul Elements

(A-2)

Description

Components
Grid>

11 Select Columns. Opens the Select Column dialog box
enabling you to select the columns to display in the grid.

& Refresh. Reloads the components in the grid.

<Linked A list of the components linked to the selected requirement.

The displayed columns differ per component type. For Web
Services, they are:

e Component folder path. The application component
path in the tree hierarchy.

e Component name. The name of the application
component.

e Import type. For Web Services, the import type: File,
URL, UDDI, Systinet

e WSDL native name. The Web service name as defined
inthe WSDL.

e Assigned to QA. QA engineer responsible for validating
the requirement.

e Last updated. The date the component was last updated
from its original source.

To change the columns displayed, click the ¥ button.
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Application Components Tab - Test Plan

Module

This tab enables you to link components to an existing test.

Linked Defects # | Dependencies | Business Models Link.. | History |App|icatiDnCDmpD... 1

s Select 3¢

Comnonen...
Application C..
Application C.
Application C..
Application C.
Application C..
Application C.

4

o

Name

Echosrr
EchoComplex
EchoComplexl
EchoString
Echodrr
EchoComplex

Cowvered Components:

Operations in Use:

Application Compone... *®

I o R g, "
Comnone...  Imnort tvne WSDL... =R mE
MyComp re.. =5 Application Compo 2] «
NTLM&uth  URL ExtendedECH ®-W Obsolete
%50 NTLM | URL EventService =-E3 3rd Party
Service] LRL servicel E Systermn A =
Services LIRL W'S_EchaSim. --|:_=| Systemn B
Serviced LIEL WebService 5&, Sanity

B Sendcel

B Senice?

B Senviceh

M » 4 [ 3

Comnonen... Comnonen...  Port Descrintion =
WSS Application C..  SimpleSerac...
WSS Application C.. | SimpleSerdc... =
WSES Application C.. | SimpleSerdc..
WSSS Application C.. | SimpleSerdc...
WSES Application C.. | SimpleSerdc..
WSSS Application C.. | SimpleSerdc... -

To access

Do the following:

Open the Test Plan Module.

e Select View > Test Plan Tree.

In the right pane, scroll right to the
ApplicationComponents tab.

Expand tree and select a test in the left pane.

Relevant
tasks

"How to Link Components to Requirements and Tests" on
page 224

See also

"How to Check the Testing Status " on page 199
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User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Elements

Description

(A-Z)

Select Opens the ApplicationComponents Tree panelin the right
pane to enable linking a component to the test. For more
information, see the "Application Components Tree Panel "
on page 233.

*x Delete. Unlinks the test from all requirements that associate
it with the component.

I Select Columns. Opens the Select Column dialog box
enabling you to select the columns to display in the grid.

s Refresh. Reloads the list in the grid.

<Linked A list of components linked to the test. The displayed

Components [ columns may differ based on the component type.

rid>

9 e Component folder path. The path in the tree hierarchy.

e Component name. The name of the application
component.

e Import type. The import type: File, URL, UDDI, Systinet
(Web Services only).

e WSDL native name. The service name as defined in the
WSDL (Web Services only).

e Assigned to QA. QA engineer responsible for validating
the test.

e Last updated. The date the component was last updated
from its original source.

To change the columns displayed, click the ¥ button.
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Application Components Tree Panel

This tab enables you to link components to an existing test.

To access Do the following:
1. Openthe Test Plan or Requirements module.

2. SelectView > Test Plan Tree or View > Requirement
Details.

3. Inthe right pane, scroll right to the
ApplicationComponents tab.

4. Click the Select button.

Relevant "How to Link Components to Requirements and Tests" on
tasks page 224
See also "How to Check the Testing Status " on page 199

The following elements are included (unlabeled Ul elements are shown in
angle brackets):

Ul Elements Description

=] Add Component. Adds the selected component to the
Linked Components grid.

& Refresh. Refreshes the Application Components Tree
panel.

Q Find. Opens the Find dialog box for locating an application
component by its name or another criteria. For details, click
F1in the Find dialog box.

AT Set/Clear Filter. Opens a drop down list with the following

options:

e Set Filter / Sort. Opens the Set Filter/Sort dialog box
allowing you to filter and sort the components.

e Clear Filter / Sort. Clears all filters and sorting settings
and displays all components and groups.
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Ul Elements Description

=53] Go to Application Component by ID. Locates the

application component whose ID you specify.

X Closes the Application Components Tree panel.

To reopen this view, click the Select button.

<Application | A tree view of all of the application components by folder
Components | and group (only visible when you click Select).

panel> . , , . .
Tip: If a filter is active, there could be hidden components.

To see all components, click Clear Filter.
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Customizing Service Test
Management

Concepts

e "Customization Overview" on page 237

e "Customizing the Application Components Module " on page 240
Tasks

e "How to Customize a Project" on page 244

References

"Project Customization User Interface" on page 248
e "General Tab "on page 249

e "Rules Tab " on page 253

e "Aspects Tab " on page 255

e "Component Types Tab" on page 257

e "Project Entities Pane" on page 260

e "Groups and Permissions " on page 263

e "Module Access Pane" on page 266
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Concepts

This section includes:
e "Customization Overview" on page 237

e "Customizing the Application Components Module " on page 240
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Customization Overview

Service Test Management adds settings to several of the customization
entities:

For task details, see "How to Customize a Project" on page 244.

Alert Rules

By default, Service Test Management issues an alert when a Service Test or
UFT-API Test has unresolved steps as a result of a Web Service application
component update. Using this module, you can disable or enable the alert.

For details about updating an application component, see the "Update Linked
Tests Dialog Box" on page 99

Application Components

This section lets you specify default values for components stored in secure
locations and on a proxy server, the default Systinetand UDDI server
information, the default Requirement folder, user-defined testing aspects,
component types, and rules. For details, see "Customizing the Application
Components Module " on page 240

Business Views

Business views are a semantic data layer that can be used for reporting. You
can create data relations between different ALM entities, using only those
entities that are relevant to you. Service Test Management enables
application component entities, such as the application component groups and
folders, and operations.

e Reports are generated according to the permission levels of the user
generating them. Therefore, information that is included in a business view
that is not available to a user will not appear in any report that the user
creates.

e For ALM 11.50, you can only use business views as a basis for graphs.

For details, see the Project Customization section in the ALM Administrator
Guide.

Groups and Permissions

In this section you can customize the permission settings for user groups and
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folders and the ability to link relating to their access to application
components, linkage to requirements, and ability to associate application
components with groups.

For task details, see "How to Customize a Project" on page 244.

For user interface details, see "Groups and Permissions " on page 263

Module Access

In the Module Access section you can grant or deny access to the Application
Components module. For details, see the "Module Access Pane" on page 266

Project Entities

This section lets you customize the system fields and create new user-defined
fields for Application Components, Application Component Changes, and
Application Component groups. You can create new fields and indicate
whether or not a field is mandatory.

If you define a field as required, the Details tab shows it as mandatory for all
component types. The following example shows a mandatory custom field
defined for an Application Component group.

Details

* Custom_Info: ‘ ‘ Assigned to: | ‘v ‘

Created by ‘ admin ‘@‘ - ‘ Creation date: | ‘v ‘

Description

For details, see the "Project Entities Pane" on page 260
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Project Report Templates

This section lets you upload and create report templates for application
component information and changes to the components.

Note: This chapter describes the customization options that apply
specifically to Service Test Management. For details on Project
Customization, refer to the Application Lifecycle Management

Administrators Guide.
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Customizing the Application
Components Module

You can customize general project data in the Application Components
module. This includes specifying default values for components stored in
secure locations and on a proxy server, the default Systinet and UDDI server
information, the toolkit parsing order for importing component definitions, the
default requirement folder, user-defined testing aspects, component types,
and rules.

This section also includes:
e Testing Aspects
¢ Rules

e« Component Types

Testing Aspects

Testing aspects are criteria you choose for testing an application component.
You can indicate the testing aspects to which the component must comply in
order it to receive a Passed status in testing. For example, you can specify
Positive Testing and Standard Compliance. For a list of the available aspects,

see "Generating Requirements and Tests Overview " on page 178.

When using the Requirement and Test Generation wizard (Components >
Generate Requirements/Tests), you select the aspects you want to test and
the wizard creates all of the necessary tests and requirements. For details
about the wizard, see the "Generate Requirements and Tests Wizard" on
page 185.

Service Test Management's customization section lets you control which
aspects to display in the wizard.

The customization's Aspects tab also lets you add new aspects, modify the
properties of system and user-defined aspects, and delete user-defined
aspects.
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General  Rules | Aspects | Component Types

~Aspects ~Froperties

< Aspects -

boecg

®-<4 Standard Compliance Aspect name: Fositive Testing
i Service Interoperahility -

---qi MET Framework Aspect description:
i "L" AXI_S;’JEI.VEI.BELSECI Weh Senvic Generates a full positive test for the selected components. It tests each
e Securlty'l'.esh_ng - operation of the selected component.

- S0L Injection Yulnerakbility

E-<l Cross-site Scripting (X55) =
Bl Boundary Testing

--qi Extrame Walues

- MNull Values Requirement Type: | Testing -
et Performance Testing _ - - -

--qi Stress Testing Reguirement Name: *service_name Positive Testing

-_H

= Owerload Sustainability Testin Requirement description:

H-= Wolume Testing
-« Longewity Test Tests that all of the cormponent operations are fully functional using positive
- Scalahility Testing data only: 1. Call every operation with positive data and check for expected
28 MyAspect!_renamed results. 2. Call the operations seguentially, and use the operation response
s o - data as input for other operation requests. 3. Parameterize all data.
4 L 4

In the Aspects tree hierarchy, the 4 icon indicates a system-defined aspect.
The & icon indicates a user-defined aspect.

In the Rules tab, you select the aspects for user-defined rules. Application
components that were not tested for these aspects, generate a rule violation
and appear with an alert in the application component tree. For details, see
the "Rules Tab " on page 253.

For task details, see "How to Customize a Project" on page 244.

Rules

Rules let you define the testing aspects to which your component must
comply. They help you make sure your testing standards are satisfactory and
that the aspects relevant to the component are covered.

You define a rule through filters and aspects:

o Filters. Filters indicate the components to which the rule will be applied.
For example, if you indicate a filter: Assigned To=john_qa, any
component not assigned to john_qa, will not be bound by the rule. You can
set arule for a component based on a variety of filters. You can use the
conditional and logical operators that are used in all ALM filters. For details,
see the HP Application Lifecycle Management User Guide.

e Aspects. The testing aspects that must be covered for the application
component.
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If your application component was not covered by the required aspects,
Service Test Management creates an Alert. The Testing Status > Rules tab
lists the violations, and lets you resolve the problems. For details about
defining rules, see "How to Customize a Project" on page 244.

Component Types

The customization lets you define new component types. The built-in types
are General, Web Service, and JMS.

You can specify the following information for your component: Name,
Assigned Icon, Supported file extensions, Contract parser ID, and the
fields to display in its Details and Interaction tabs. The Contract parser ID
instructs Service Test Management that if a a parser has this unique ID and is
registered on the client machine, use it to parse contract files of this type.

For details, see "How to Customize a Project" on page 244.
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Tasks

This section includes:

e "How to Customize a Project" on page 244
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How to Customize a Project

This task describes how to customize your ALM project as it relates to
components. You can create rules, assign aspects, and set permissions for
entities related to your application component. You can also create both
mandatory or optional fields to the Component Details.

All of the customization settings are optional.

Open Project Customization

e Choose Tools > Customize to open the Customization module.

e Click the Return button, located in the top right corner, to return to the main
ALM window.

Customize the General settings - optional

Click Application Components in the left pane. Select the General tab. Define
the parsing order for toolkits, and the default servers that host the WSDL,
UDDI registry, or Systinet registry. You can also define the authentication
details for accessing WSDL files, the default requirement and whether to
allow fuzzy imports.

For user interface details, see the "General Tab " on page 249.
Customize the component rules - optional
Click Application Components in the left pane. Select the Rules tab.

Click New to define new rules. Select the testing aspects to which the
components in the current filter, must comply. If the component is not covered
by the specified aspects, it issues a rule violation. For details, see "Rule
Violations" on page 190.

For user interface details, see the "Rules Tab " on page 253.

Customize the aspects - optional

Click Application Components in the left pane. Select the Aspects tab.
Manage the built-in testing aspects or click New to create new ones.

For user interface details, see the "Aspects Tab " on page 255.

Manage the component types - optional

Click Application Components in the left pane. Select the Component Types
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tab.

Manage the built-in component types General, WebServices, and JMS. You
can indicate the fields that will be available for each of the built-in types. Mark
required fields as mandatory and indicate whether to display them in the
Details or Interaction tab.

Click New to create a new component type. Specify a Name, Assigned Icon,
Supported file extensions, and Contract Parser ID. Select the fields to
display for the new component, for example in its Details tab. You can also
mark fields as mandatory and indicate whether they will be visible in the
Interaction tab.

For user interface details, see the "Component Types Tab" on page 257.

Customize group permissions - optional

Assign the permissions for the component-related tasks per user group. For a
list of the component-related tasks that you can configure, see "Groups and
Permissions " on page 263.

1. Click Groups and Permissions in the left pane.

2. Click New Group to open the New Group dialog box. Specify a name and
permission level. Click OK.

3. Selectthe Permissions tab and click the Application Components
subtab. The subtabs are in alphabetical order.

4. Modify the permission levels as required.

5. Click Save.

Customize application component module access -
optional

Indicate which user groups will have access to the Application Components
module.

1. Click Module Access in the left pane.

2. Expand the window or scroll to the right to view the Application
Components column.

3. Selectthe check boxes as required. To enable or disable permissions for
an entire column, select or clear the check box in the header row.

4. Click Save.
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Customize project entities - optional

Use the Project Entities section to define new fields for the application

component, changes, and groups.

1.

2.

6.

Click Project Entities in the left pane.

Expand the node to which you want to add or modify an entity.
Application Component, Application Component Changeor
Application Component Group.

To modify a built-in field, expand the System Fields node and select a
field. You can modify the label and indicate if the field should be required.

To create a new field, select the User Fields node and click the New Field
button. Provide a label, type, and maximum string length for String type
fields. Select any other relevant options as described in the "Project
Entities Pane" on page 260.

To create a new Memo type field, expand the New Field button and select
New Memo Field.

Click Save.

Customize the business views - optional

Use the Project Entities section to modify the built-in business views and

create new ones.

1.

2.

Click Business Views in the left pane.

Clear or select the check boxes in the Output column to indicate which
columns to show in the final view.

Use the interface to create new views or import existing ones. For details,
refer to the HP ALM Administrators Guide.
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Reference

This section includes:

e "Project Customization User Interface" on page 248
e "General Tab " on page 249

e "Rules Tab " on page 253

e "Aspects Tab " on page 255

e "Component Types Tab" on page 257

e "Project Entities Pane" on page 260

e "Groups and Permissions " on page 263

e "Module Access Pane" on page 266
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Project Customization User Interface

This section includes (in alphabetical order):
e "General Tab "on page 249

e "Rules Tab " on page 253

e "Aspects Tab " on page 255

e "Component Types Tab" on page 257

e "Project Entities Pane" on page 260

e "Groups and Permissions " on page 263

e "Module Access Pane" on page 266
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General Tab

This tab enables you to customize the settings for parsing contracts and
importing WSDLs. You can enter a default server and credentials, so that you
will not need to enter the information each time you import a service.

General | Rules | Aspects | Component Types

-Connection Settings

Mo connection settings were specified.

Default Connection Settings... |

-Default UDDI Server

URL: |
‘ersion: ﬂ

- Default Systinet Server

SERVYEN Name: | |

- Default Beguirements

Location: | Requirements%pplicaﬂnnE
Requirement type: | |"r |
-Fuzzy Import

Wl Use fuzzy logic on import

Numper of attempts: |5 ||

To access Do the following:
1. Select Tools > Customize.

2. Select Application Components in the left
pane.

3. Selectthe General tab.

Important Toresume work in the ALM modules, click the
information BEZE b utton in the top right corner.
Relevant tasks "How to Customize a Project" on page 244

User interface elements are described below:
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Default Connection Settings. Opens the Connection

General Tab Description
Sections

Connection .

Settings

Setting dialog box for setting the default connection
settings. For details, see "Connection Settings Dialog
Box" on page 76.

Default UDDI .

URL. The default address of the UDDI server when a

Requirements

Server user opens the "Select Service from UDDI Dialog Box"
on page 74, for example http:/<my_server>.<my_
domain>:8090/juddi/inquiry.

e Version. The UDDI version: 2 or 3.
For details, see "Select Service from UDDI Dialog Box" on
page 74.

Default Server Name. The default path of the Systinet server when

Systinet a user opens the "Select Service from Systinet Dialog Box"

Server on page 72.

Default e Location. The default requirement to use when linking a

componentto a test. The Browse button opens the
"Select Requirement" below dialog box.

Requirement Type. One of the standard requirement
types: Undefined, Functional, Testing, Performance,
or Business Model.

Fuzzy Import | e

Use fuzzy logic on import. For .NET services, use a
looser set of criteria for parsing the contract.

Number of Attempts. The number of attem pts to try
parsing the contract before aborting the import. The
default is 5.

Select Requirement

This dialog box lets you select a default requirement.

User interface elements are described below (unlabeled elements are shown

in angle brackets):
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Ul Elements Description

(A-2)

& Refresh All. Refreshes all of the requirements in the
tree.
T - Set/Clear Filter. Opens a drop down list with the
following options:
e Set Filter / Sort. Opens the Set Filter/Sort dialog box
allowing you to filter and sort the requirements.
e Clear Filter / Sort. Clears all filters and sorting
settings and displays all requirements.
For details, see "General Tab " on page 249
| New Requirement. Opens the New Requirement dialog
box for defining a new requirement.
7 New Requirement Folder. Creates a new requirement
folder, under the selected folder.
Note: This is only available when selecting a folder— not
arequirement.
<Requirements [ A tree hierarchy of all the requirements.
Tree>

Filter Requirements Dialog Box

You open Filter Requirements dialog box from the Select Requirement dialog

box. User interface elements are described below:

ul

Elements

'Zi

Description

Clear Filter. Clears all conditions to which the rule should apply.

Bny Copy filter. Copies the current filter settings onto the clipboard.
You can paste this filter for another rule or save it to a text file
for later use.

[ Paste filter. Uses a filter from the clipboard.

Filter tab | A list of field names and their conditions. The field names

correspond to the component fields in the Project Entities list.
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ul

Elements

Description

Tip: Click the down arrow in the right side of the row, to open
the Select Filter Condition dialog box. You can manually type
the condition that must be met and use asterisks (*) as

wildcards.
Cross Allows you to filter the following entities within the Application
Filter tab | Components module: Groups, Requirements, Tests, Defects,
Application Changes, and Alerts.
For Alerts: Enable the Show application components with
alerts option to hide all components without alerts.
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Rules Tab

This tab lets you define rules for the application components in your project.

~Froperties

-Fule

Fule narme:

CustamPule_1 |

-Components

The rule applies to components that satisfy the following condition(s):

Edit..

Created by[admin]

-Aspects

Must be covered by the following Test aspect(s):
Security Testing, Positive Testing, Standard Compliance Edit

-Description

lwl Use automatic text

All components that meet this condition: Created by[admin] must be covered by
the fallowing testing aspects: Security Testing, Positive Testing, Standard

Rule Description (This text will be displayed whenever a component does not foll

Compliance

To access

Do the following:
1. Select Tools > Customize.

2. Select Application Components in the left
pane.

3. Selectthe Rules tab.

Important
information

Toresume work in the ALM modules, click the

button in the top right corner.

Relevant tasks

"How to Customize a Project" on page 244

See also

"Alerts Dialog Box" on page 28

User interface elements are described below:
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ul Description

Elements

Toolbar e Save. Saves the changes to the Rules tab.
buttons

e New. Opens the Create New Rule dialog box.

e Delete. Removes the selected rule.

Properties | The properties of the rule:

e Rule. The rule name. If a component violates a rule, the
Alert box lists it by this name.

e Components. The rule is only applied to components that
meet the selected conditions. To set a condition, click the
Edit button to open the "General Tab "on page 249. To
create a global rule that will apply to all components, specify
a filter condition thatis common to all components, for
example, Component ID > 0.

e Aspects. The testing aspects that must be covered for the
component. To select the aspects, click the Edit button to
open the Select Aspects dialog box described on page
"Customization Overview" on page 237. Note: You can only
select a direct descendent of the root aspect.

e Description. Text describing the rule. To allow Service Test
Management to generate a description based on the
selected aspects and conditions, select Use autom atic
text. If the rule is violated, the Alerts dialog box shows this
text.
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Aspects Tab

This tab lets you define the properties of the built-in aspects and define new

ones for the project.

This dialog box enables you to run a spot test for an individual operation. You

can set up arequest and view the SOAP response to verify if an individual

operation is functional.

General | Rules | Aspects | Component Types

~Aspects

o4 Aspects

@i Positive Testing

@« Standard Compliance
B4l Service Interoperability

MET Framework!

Bl Security Testing

E-«¢ S0L Injection Vulnarahility
E-4i Cross-site Scrigting (X55)
Bkl Boundary Testing

E-« Extreme Yalues

E-a Null Values
Fertormance Testing

Stress Testing

o

R R R
4 4 4 & &

I Yolume Testing
Longewvity Test
Scalability Testing

--qi Axis!lava Based Web Services F

Cwerload Sustainahbility Testing

~Froperties

Aspect name: MET Framewaork

Aspect description:

Tests the interoperability of the semice's
operations using .NET Framewark.

Requirement Type: |Testing

Requirement Marne: Fsenice_nama®s N

Requirement description:

Tests that %service_name% is fully
interoperable with \MET Framewoark by calling
all of its operations with default/expected

28" MyAspect!_renamed |
B8 MyAspect?_renamed values.
B9 Myhspect3
1 i
To access Do the following:

1. Select Tools > Customize.
2. Select Application Components in the left pane.

3. Selectthe Aspects tab.

Important Toresume work in the ALM modules, click the
information button in the top right corner.

Relevant tasks ["How to Customize a Project" on page 244

See also "Alerts Dialog Box" on page 28

User interface elements are described below:
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Ul
Elements

Description

[& Save Saves the Rule settings.

Mew Opens the Create New Aspects dialog box.

Delete Removes the selected aspect from the list. You can only delete
user-defined aspects—not built-in ones.

Aspects A list of the aspects that are available for the current project.

Properties

The properties of the aspect:

e Aspect Name. The aspect name as it will appear in the tree.
For predefined system aspects, this field is read-only.

e Aspect Description. Text describing the goal of the aspect.

e Requirement type. The requirement type:—a drop down
list of predefined requirements, such as Business, Group,
or Performance, and any user-defined requirements. For
details, see the ALM User Guide.

e Requirement name. A name for the requirement. To
include the component name, use the variable % service_
name% . The Requirement and Test Generation wizard
will use this name when creating a requirement for this
aspect.

e Requirement description. Text describing the
requirement. To include the component name, use the
variable % service_name%.
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Component Types Tab

This tab provides information about the different application component types.
You can control which fields will be available in the Details and Interaction
tabs for each component type and if they are mandatory. You can also define
new component types.

General | Rules | Aspects || Component Types

~Component Types —
General
YWeh Service
JMS

memol
memo?
memod

~Froperties

Mote: this type cannot be deleted because this is a built in type or there are existing cormpong

Mame: |Web Service |
Assigned icon: | Keep currentimage | - |

Supparted file extensions: | |

Contract parser 1D | B67CDEAG-0052-446+B59C-3EFDE34A7 494, |
~Fields

Field Name Included in Tvne Reauired in... Interaction field -
i Assigned to Dew
Assigned to OA
Comments

Component name
Contract Description
Description
Dewvelopment status
Has changed

JMS connection factory
JMS destination

JMS provider

JMS request queue
JMS response queus

O0OOOORKEEE®EE K K
OO0O0O0oooOoomOoon
OoOOoOoooooomOooOon

To access

Do the following:
1. Select Tools > Customize.
2. Select Application Components in the left pane.

3. Selectthe Component Types tab.

Relevant tasks "How to Customize a Project" on page 244

ul
Elements

Description

New Adds a new component type to the list. To rename the component,
enter textin the right pane's Name field.
Delete Removes the selected non- built-in component from the list.
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Ul
Elements

Description

Note: You cannotremove a type if a component of that type exists
in the repository.

Component
types

A list of the built-in and custom component types. The built-in types
are General, Web Service, and JMS.

Properties

The component type details:
e Name. The name of the component type as it will appear in ALM.

e Assigned icon. The icon representing the component of this
type in the application components tree. A drop-down includes
several options. For details, see "Application Components
Module Icons " on page 51.

e Supported file extensions. The file extensions supported as a
contract for components of this type, for example, WSDL.

e Parser type. A type string for the parser to use for parsing a
contract definition file, such as a WSDL. The syntax is the
namespace and type followed the parser DLL, separated by a
comma. For example, the standard We b Service parser string is
HP.STM.SOAPParser.Parsing.WSParser,WSParser.dll

Note:

= Make sure to add any custom parser DLLs to the GAC or to the
folder of the ALM client.

= Only .NET DLLs are supported.

Fields

The fields that will be available in the component's Details and
Interaction tabs. These settings are specific for each component
type—both built-in and user-defined.

e Included in Type. Show the field in the components's Details
tab, but do not make it mandatory.

e Required for Type. Show the field in the components's Details
tab, and make it mandatory.

e Interaction Field. Show the field in the Interaction section of
the Add New Component dialog box and Interaction tab.

For details, see the "New Application Component Dialog Box" on
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ul Description

Elements

page 47.
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Project Entities Pane

This pane lists the project entities. Each entity contains system fields and
user-defined fields:

e System fields. These are ALM default fields. You cannot add or delete
system fields—you can only modify them.

e User fields. Customizable user-defined fields. You can add, modify, and
delete user-defined fields.

For detailed information on ALM entities and fields, refer to the HP ALM
Database Reference.

This dialog box enables you to run a spot test for an individual operation. You
can setup arequest and view the SOAP response to verify if an individual
operation is functional.

Project Entities

[B Save ‘ op Mew Field - 3 Delete Field

B Application Compaonent & | | Settings
-3 System Fields
=B User Fields
-G MEMON Name: o USER 01
-G7 MEMO2 - -
e Label | 3v_USER_01
e
E;}"i" Application Compaonent Type: |String
=S Application Component
B System Fields Length: |4|J
- gl Assignedto '
E‘a Created by ] )
-lgd Creation date L History 0 Required
g3 Description
- g Name
“FF User Fields
#-Lg Baselines
-5k Business Component

[+l | Fnecinoce Prorocs bdned

1 Il ’

O Masked O Searchakle
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To access

Do the following:
1. Select Tools > Customize.
2. Select Project Entities in the left pane.

3. Expand the Application Component, Application
Component Group,or Application Component
Change entities.

Important
information

You can only create and delete User fields, but not System
fields. For System fields, you can modify the label and select
some additional options, depending on the field.

Relevant "How to Customize a Project" on page 244
tasks
See also "Modeling Tab" on page 39

User interface elements are described below and in greater detail in the HP
ALM User Guide.

Ul
Elements

Description

&b Mew Field ~| Opens a drop down list allowing you select New Field or a
New Memo Field.

% Delete Field| Removes the selected user-defined field.

Name A read-only field name used in the ALM database table.

Label The name of the field to display in the Project Entities tree and
the component's Details tab. This label is referenced
anywhere the field is used, such as in the filter criteria, error
messages, and graphs.

Type The type of data valid for the field:

e Number. Enables integer entry only.
e String. Enables the entry of any character string.
e Lookup List. Displays the Lookup List area and enables
the selection from a drop-down list.
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ul Description

Elements

e User List. Enables the selection of a user name from your
ALM users list.

e Date. Enables the selection of a date.

e Memo. Enables the entry of blocks of data. Note that you
can add up to 5 memo fields to each ALM entity (available
by selecting New Field > New Memo Field from the
toolbar).

Length The field size (available for String type only).

Note: The maximum field length is 255 characters.

Goto List Displays a predefined list. (Available only when the Lookup
List type is selected.) To open a predefined list, select a list
from the Lookup List box and click the Goto List button.

History Preserves a log of values entered in the selected field.

Masked The input data mask for the field (available only when the
String type is selected).

New List Creates a new list (available only when the Lookup List type
is selected). To associate a field with a new list, click the New
List button. The Project Lists dialog box opens.

Required Indicates that a user must enter a value for the field.

Searchable | Indicates a searchable field (available only when the Text
Search option is enabled in the DB Servers tab).

Lookup A list of predefined lists (available only when the Lookup List
List type is selected). To associate a field with a predefined list,
select a list from the Lookup List box. To view or modify the
selected list, click the Goto List button.

Verify Limits the user to select a value only from the items that are

value listed in the list box (available when Lookup List or User List
is selected).

Allow Allows the user to select more than one value in any field that

multiple is associated with a predefined lookup list (available only

values when selecting a Lookup List type field).
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Groups and Permissions

This customization section lets you define new user groups and set their
permissions.

Groups and Permissions

[E Save | oy Mew Group Rename Group 3¢ Delete Group

Developer kembership | Permissions | Data-hiding

Froject Manager o - — - :
Administration | Application Compone.. | Business Models | Business Frocess Te. 3

OATester
; Permission Level g~ Options
B~ Application Change
E Create
B ElUpdate
E Delete
Bl Application Compaonent
E Create
E‘ 1 Update
1 (i 3
Impacts

Rt et e i el

To access Do the following:

1. Select Tools > Customize.

2. Click Groupsand Permissions in the left pane.
3. Selectagroup and click the Permissions tab.

4. Selectthe Application Components tab (the subtab
names are in alphabetical order).

Important Toresume work in the ALM modules, click the
information button in the top right corner.

Relevant "How to Customize a Project" on page 244

tasks

The Application Components tab displays the following permissions for
elements available in the Application Components module:
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Element /

Entity

ar Mew Group

Permission Level

Opens the New Group dialog box for creating a new
permission group.

Rename Group

Allows you to rename the selected user-defined group.

¥ Delete Group

Removes the selected user-defined group.

Alert. This icon indicates that selecting or clearing the
current permission, will impact other permissions. The
mouseover message provides the impact details.

¥ Create G

Permission
Levels -
Application
Change

Lets you set the group's permissions for handling changes

in an application component. You can enable or disable
the following capabilities:

e Create. Create a new change.

e Update. Update fields in an existing change. For
details, expand the node and see "Application Change
Details Dialog Box " on page 287

e Delete. Delete a change.

Permission
Levels -

Application
Component

Lets you set the group's permissions for creating and
modifying application component details. You can enable
or disable the following capabilities:

e Create. Create a new change.

e Update. Update fields in an existing component. For
details, expand the node and see "New Application
Component Dialog Box" on page 47.

e Delete. Delete a component.

e Link to Components. Link to another application
component.

e Link to Groups. Linka componentto an Application
Component group.

e Link to Requirements. Link a component to existing
requirements.
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Element /

Entity Permission Level

e Update Contract. Update a component's contract
from its source.

Permission Lets you set the group's permissions for creating and
Levels - Folder |removing folders in the application components tree. You
can enable or disable the following capabilities:

e Create. Create a new folder.

e Update. Update fields for an existing folder. The
available fields are: Attachment, Description, Father
ID, Folder ID, Logical Path, Name, and UDF.

e Delete. Delete a folder.

Permission Lets you set the group's permissions for creating and
Levels - Group | modifying Application Component groups. You can
enable or disable the following capabilities.

e Create. Create a new group.

e Update. Update fields in an existing group. For details,
expand the node and see "New Group Dialog Box" on
page 174.

e Delete. Delete a group.

e Link to Requirements. Link a group to existing
requirements.

e Update Contracts. Update the contracts in a group's
components from their source.

Permission Provides the members of the group access to the
Levels - Application Components section in Customization.
Customize
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Module Access Pane

This pane lists the module access per group. You can control access for the

various ALM modules.

For detailed information on module access, refer to the HP ALM Database

To access

Select Tools > Customize and click Module Access in the
left pane.

Relevant
tasks

"How to Customize a Project" on page 244

The Module Access pane contains a table indicating each group's permission

per module.

Module Access

4

[ Save .
Users Grouns ¥l ¥ Del¥ Te ¥ Te ¥ Re ¥ Da ¥ Colvl Rel ¥ M [ L & Annlication Components

TODAdmin ] [wl [v] [w] [w] [w] [w] [s] vl vl [w]

OATester W b W vl vl ] ] ] b | b ]

Froject Manager M W M M M M M [ bl | [ v

Ceveloper bl [l [l [l [l [l ™ W [ ]

YWiswer ]| [w] [w] [w] ] ] vl W | vl

l r

Selecting the check box in the header row, checks all rows in that column.

Clearing the check box in the header row, clears all rows in that column.

For more details about Module Access permissions, see the HP Application
Lifecycle Management User Guide.
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Concepts

e "Change Analysis Overview " on page 269

e "Change Notifications" on page 270

e "Reporting Changes Manually " on page 271

e "Automatic Change Detection Through Updates" on page 272
e "Contract Comparison" on page 273

Tasks

e "How to Perform Change Analysis " on page 276
Reference

e "Changes User Interface" on page 281

e "Changes Tab" on page 282

e "New Application Change Dialog Box " on page 284

e "Application Change Details Dialog Box " on page 287
e "Create Change Impact Test Set Wizard" on page 292
e "Tests Tree Panel "on page 293

"Troubleshooting and Limitations - Changes" on page 295
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Concepts

This section includes:

e "Change Analysis Overview " on page 269

e "Change Notifications" on page 270

e "Reporting Changes Manually " on page 271

e "Automatic Change Detection Through Updates" on page 272

e "Contract Comparison" on page 273
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Change Analysis Overview

Change impact analysis helps you assess the impact of changes to the
application components. For each change, Service Test Management displays
a description of the change, an assessment of the change-risk, and the
change status.

Service Tests Management provides an interface for comparing different
versions of document literal Web services and related XML schemas. You can
also introduce changes manually and specify the change details. If you know
of changes in the component's contract, you manually insert a new change
and provide its details.

This section includes:

e "Change Notifications" on page 270

e "Reporting Changes Manually " on page 271

e "Automatic Change Detection Through Updates" on page 272

e "Contract Comparison" on page 273
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Change Notifications

Service Test Management also generates a change list automatically. When
you update an application component or group, it compares the latest
definition with the definition stored in ALM. If an operation was added or
removed, or if there were changes to the operation's data structure or at the
signature level, Service Test Management lists them in the Changes tab.

Service Test Management flags changed application components, groups, or
folders (prior to version 11.00), in the Application Components tree with an
Alert icon ! .

Tip: A green asterisk on the Changes tab indicates a new change.

To verify the changes, you can generate a test set. These test sets can contain
all tests linked to the updated component, or only tests that use the operations
affected by the changes.

Each test set must be linked to a requirement. If a component does not have
requirement coverage, Service Test Management lets you link it to a default
requirement.

After creating or generating change-based requirements and a test set, you
can run the linked or affected tests in the test set to verify whether these
changes caused regression in functionality or performance. You can then
determine which entities were affected and who is responsible for them.

To determine if a change violates a rule associated with a component, see the
"Rules Tab" on page 206.
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Reporting Changes Manually

Service Test Management allows you to define changes manually. This
change can indicate an update in the contract file or other changes that
affected the contract file.

You can also add descriptions and comments, and assign the change to
developers or QA personnel. For details, see "New Application Change Dialog
Box " on page 284.
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Automatic Change Detection Through
Updates

You can use the Update Component feature to automatically check for
changes in a component. If changes are found in the Web service:
e the component's definition is updated in Service Test Management.

e the Application Components tree displays an alert adjacent to the
component.

o the Changes tab lists the changes.

You can update the definition from the original location or from a custom
location.

For application components that reside on secure locations or those accessed
through proxy servers, you specify the authentication credentials. For details,
see the "Secure Services and Proxy Servers " on page 64.

For task details, see "How to Perform Change Analysis " on page 276.

Note:

e When updating a Web service from a UDDI or Systinet server, it must
have the same name as the one in the original WSDL used to import the
service.

e If Keep up to date is setto Yes in the Details tab, the component
definition is autom atically updated from the original source each time it
is loaded.
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Contract Comparison

The Technical Details view of the Application Change Details dialog box,

displays the contract files side by side, allowing you to visually compare them.
The window highlights the differences between XSD schema versions for the

selected change, using different colors for additions, deletions, and changes.

Each node indicates the nature of the change, for example, The 'xyz'
element was removed from 'My operation'. The comparison
window displays the changes for the selected node. If the changes were in th
input or output properties, it indicates this in the Subject box.

e

H Application Change Details !E
SIS ’
Change ID: | 437 T Bubject: | 5 schema changes detected inWSHttpBinding_|Semrvice1:GetDatalsingDataCo D|
2| | =92 T1 (G changes) il
& 48 Element 1" was removed from camplex type T1°.

ia Element B2 was removed from complex type T17.
53 The '51' element of type "String’ was added to complex type T1°.
-5g The '52' element of type "String’ was added to complex type T1°. ﬂ
Before char ISENiCB'I swcTxsd=xsd3 Aftar chan ISewice1.svc?xsd=xsd3
1 <¥giconplexType name="T1" xjali] <¥s:complexType name="T1" xmla
q 2 <HIsSedquence = <HS . Zedquencel
4 < <xs:element mindccurs 3
4 = <xs:element minOccur: 4
5 <xs:element mindccurs; 5 <xsielement minCoocurs="
f <xs:element mindccours: a] <¥z:element minCccurs="
7 <xs:element mindccurs: 7 <xsielement minCoocurs="
B a pd <¥g:element minQocurs=
=] g = <xs:element mindccurss=
10 200 > <ws:elemant. minOoonrs=—
JE | o el »

For user interface details, see "Application Change Details Dialog Box -
Technical Details Tab" on page 290.

By studying the changes, you can decide how to set the Change Status in the

Application Change Details dialog box's Details view. You can set the status

toIn test,Verified,orObsolete. For details, see "Application Change

Details Dialog Box - Details Tab" on page 288.

To verify the functionality of the component after the changes, you can run an

existing test set, or create a new one. To create a new test, click the Create
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Test Set button in the Changes tab. For details, see "Create Change Impact
Test Set Wizard" on page 292.
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Tasks

This section includes:

e "How to Perform Change Analysis " on page 276
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How to Perform Change Analysis

This task describes how to create and review the changes for your application

component.

This task includes the following steps:

e Define a New Change - optional

e Update a Component - optional

e Review the changes

e View and/or modify the change details

e View the technical details

e Evaluate the tests

e Create aregression test set - optional

e Run the test sets

e Check the test status

e Update the change status

1. Define a New Change - optional

To manually define a change in the Changes list:

a. Inthe Application Components tree, select a component.

b. Selectthe Changes tab and click the New Change button % .

c. Inthe New Application Change dialog box, make sure that the following

mandatory fields have values:

(e]

Subject. A meaningful name for the change.
Affected part. The name of the affected application component part.

Affected part type. The type of part affected by the change:

Component, Field, Interface,Or Operation.

Change Status. The change's current status: In Test, New,
Obsolete,OorModified.

Change type. The nature of the change: Added, Updated, or
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o Risk. The risk of the change: High, Medium, or Low.

d. Enter values into the optional fields, such as Description, Assigned

to, and so forth.

2. Update a Component - optional

To automatically generate a list of changes, update the component
contract stored in Application Lifecycle Management with the latest
contract file. Service Test Management flags the changed componentin

the Application Components tree.

a. In the Application Components tree, select the Web service component

you want to update.
b. Choose one of the following update options:

o Toupdate acomponent using the same contract location, choose
Components > Update Component > Update Component.

o Toupdate a component using a different location, choose
Component > Update Component > Update Component from.
Browse for a newer version of the contract in another location.

The update process begins. Service Test Management checks for
changes in the contract and informs you if the component was
updated.

3. Review the changes

Select an application component that has been updated, indicated by an

alerticon ! . Click the Alert icon to open the Alerts dialog box and view a
list of the alerts. Click Show to open the selected change in the Changes
tab. The grid lists the changes that were made to the component.

4. View and/or modify the change details

a. Selecta change in the grid, and click the Change Details button £ .
b. Click the Details link in the left pane (selected by default).
c. View and modify the field values.

For details, see the "Application Change Details Dialog Box - Details

Tab" on page 288.

5. View the technical details

a. Click the Technical Details link in the left pane.
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b. Expand the changes tree in the upper pane and select a change. The
bottom pane highlights the change within the schema.

c. Click OK to close the Application Change Details dialog box.

For details, see the "Application Change Details Dialog Box - Technical
Details Tab" on page 290.

6. Evaluate the tests

Evaluate the tests that are associated with the componentin the Testing
Status tab, and add additional tests if necessary. For more information
about tests linked to components, see "How to Check the Testing Status "
on page 199.

7. Create a regression test set - optional

To analyze the impact of the changes, click CreateTest Set in the
Changes tab, to invoke the wizard. For details, see the "Create Change
Impact Test Set Wizard" on page 292.

Tip: The Create Change Impact Test Set wizard does not allow you
to enter values for required Test Set fields. To enter values for
these fields, open the Test Lab module, go to the test set, and
enter values for the required fields.

8. Run the test sets

Run the test sets from the Test Lab module. You can verify the
component behavior and analyze the test results using ALM graphs,
reports, and documents. For details on running test sets and analyzing test
results, refer to the HP Application Lifecycle Management User Guide.

9. Check the test status

Review the coverage status of the parentrequirement created for the
changes setin the Testing Status tab, to verify that the coverage includes
the latest changes. For details, see ""Requirements Coverage" on page
192.

10. Update the change status

Verify the behavior of the changed component and manually update the
change status in the Changes tab through the following steps:
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a. Selectan updated componentin the Application Components tree, and
click the Changes tab.

b. In the list of changes, select the change whose status you want to
update.

c. Selecta change in the grid, and click the Change Details button &

d. Inthe Details tab's Change Status box, setthe change status. For
example:

o Verified. if the change was tested and did not cause a regression.
o Obsolete. if the change does not affect the component.

For details about change status, see the "Application Change Details
Dialog Box " on page 287.
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Reference

This section includes:

e "Changes User Interface" on page 281

e "Changes Tab" on page 282

e "New Application Change Dialog Box " on page 284

e "Application Change Details Dialog Box " on page 287
e "Create Change Impact Test Set Wizard" on page 292

e "Tests Tree Panel "on page 293
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Changes User Interface

This section includes:

"Changes Tab" on page 282

e "New Application Change Dialog Box " on page 284
e "Application Change Details Dialog Box " on page 287
e "Create Change Impact Test Set Wizard" on page 292

e "Tests Tree Panel "on page 293
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Changes Tab

This tab allows you to view and manage the changes made to the application
component.

Detals | Interaction | Changes # | Testing Status | Modeling | Attachments
Changes list

fo b B | M & | T ~| 4 Create Test Set...

Subject Affected part type Affected part Change type  Risk
{dschemachanges.  Operation GetDatallsing.. Updated High

3 schemachanges..  Operation GetDatallsing..  Updated High

4 schemachanges..  Operation GetDatalJsing.. Updated High

3 schemachanges.  Operation UsinghdyStruct  Updated High

4 [ 3

Details | Interaction | Changes # | Testing Status | Modeling | Aftachments
Changes list

Ly L B | M | T ~| 4L Create Test Set...

Gy

Subject Affected part type Affected part Change type  Risk
dschemachanges.  Operation GetDatallsing.. Updated High

3 schemachanges.  Operation GetDatallsing.. Updated High

4 schemachanges.. | Operation GetDatallsing..  Updated High

3 schemachanges.  Operation UsinghdyStruct  Updated High

4 [ 3

Click thumbnail to view full size image.
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To access

Do the following:
1. Selectthe Application Components module.
2. Select an entity in the Application Components tree.

3. Clickthe Changes tab.

Relevant
tasks

"How to Perform Change Analysis " on page 276

User interface elements are described below (Unlabeled Ul elements are

shown in angle brackets):

ul
Elements

Description

New Change. Opens the New Application Change dialog box
to create a new change upon your component. See the "New
Application Change Dialog Box " on page 284.

-3

Change Details. Opens the Application Change Details for
viewing and editing. See the "Application Change Details
Dialog Box " on page 287.

® Delete. Removes a change from the Changes grid.

I Select Columns. Enables you to select the columns to display
in the Changes grid.
For a description of the columns, see the "Application Change
Details Dialog Box " on page 287.

s, Refresh. Reloads the list of changes.

AT Set Filter/Sort. Enables you to set a filter for the changes or
sort the changes by a criteria.

Create Opens a wizard for creating a test set. For details, see "Create

Test Set Change Impact Test Set Wizard" on page 292.

<Changes | A list of all the changes for the selected component to which the

grid> filter applies. To clear the filter, use the Set/Filter sort button.

To arrange the columns, use the Select Columns button.

Default:Subject,Affected part type,Affected
part, Change type,Risk,Change status,Creation
date,Assigned to,Release,andCycle.
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New Application Change Dialog Box
This dialog box lets you define a new change for your application component.

& New Application Change !E

X |9 B #

Change 1D: I:I * Subject: ||\.u1y Mew Change |

& Details Details |
*afected.. | Servce! | rafected.. |Component B3 =
* Change 5. |New |v| * Change t... |Updated |v|
* Risk: | Mediumn |v|  Assignedto; | B3
Change ID: | | Createdhby.  |admin |+
Creation d... Creation fi...
é | | | | B
Description | Risk description
B I UAS|EE==|[n|se|lm .
A description of the change...
{m[=]3]
To access Select the Changes tab and click the New Change
button.
Relevant tasks |"How to Perform Change Analysis " on page 276
See also "Changes Tab" on page 282

User interface elements are described below:

ul Description

Elements

(A-Z)

3¢ Clear all Fields. Clears all the fields in the dialog box.
o Editing buttons: Spell Check, Thesaurus, and Spelling

Options. For details, see the HP Application Lifecycle
Management User Guide.
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ul Description

Elements

(A-Z)

Affected The name of the part affected by the change, such as the
part component name or operation name.

Affected The part type affected by the change: Component, Field,
part type Interface, or Operation.

Assigned The user name of the person who is responsible for the
to change.

Change ID | A unique identification string for the change. This field is
read-only and is generated when you save a new change.
This is visible in the Application Change Details dialog box.

Change The current status of the change. By default, the change
status status is New. Update the status throughout the change
analysis process as follows:

e In test. The change is being tested.
e New. Thereis a change in the component.
e Obsolete. The change does not affect the component.

e Verified. The change was tested and did not cause a
regression.

Change The type of change is indicated as follows:

type . .
e Added. New functionality was added.

e Removed. Functionality was removed.

e Updated. Changes were made to existing functionality.
Details of these changes are displayed in the Description
column.

Created by | The user name of the person who created the changes.

Creation The date on which the change was made. By default, the
date creation date is set to the current database server date. This
field is read-only and is generated when you save a new
change.
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Ul
Elements

(A-Z)

Description

Creation The time at which the change was made. This field is read-

time only and is generated when you save a new change.
Default: The current database server time.

Cycle The testing cycle in which the change was introduced or in

which the change needs to be verified.

Description

A description of the change and suggested tests to verify
them.

For operation changes (where Part Type is Operation and
Change Type is Updated), the change description contains
details of the argument that was added or removed from the
operation.

Release

The planned release version.

Risk

The business risks and costs associated with the change. A
change can have one of the following risk levels:

e High. Changes that are likely to affect functionality and fail
any test that is not updated. High-risk changes include
operation removal and parameter changes.

e Medium. Changes that may affect functionality, but may
not necessarily fail existing tests. Medium-risk changes
include component changes (notification that some of the
component files have changed).

e Low. Changes that are unlikely to fail or affect existing
functionality or implemented tests. Low-risk changes
include operation additions (as they do not affect existing
functionality), service address changes (deployment only),
and port type changes.

Risk
Description

A textual description of the risk.

Tip: Click Add Comment to create a remark with a name,
time, and date stamp.

Subject

A short title describing the change. This field is mandatory.
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Application Change Details Dialog Box

This dialog box enables you to view and manage the changes applied to the
component. You can view both the general and technical details of the
change.

E Application Change Details !E

SRR A

-

Change 1D " Subject: |1 schema change detected in W3HtpBinding_IServicel:GetDatalUsingDataCaon D|
5 Details Details |
&% Technical Details 2
*affected.. | GetDataUsingData | *Affected.. | Operation B3
*Change s... |New |#] ~changet.. |updated =]
* Risk: |High |+|  Assignedto: | |=|
Change ID: |238 | Created by |admin | v |
g Creationd... |5/2/2011 | Creationti.. [4:34:17 PM . E

Description | Risk description

B I U 4 ay =

=

42‘01111{]‘ (J‘@’%

1 schema change detected in WSHttpBinding_|Servicel:GetDataUsingDataContract. These
schema changes are likely to affect the logic of the operations that use
W3HHpBinding_Servicel: GetDatalsingDataContract. Verify whether the logic was affected by
running tests that cover the service usage flow: |

This sections contains the following information:

Application Change Details Dialog Box - General
Information

To access Select the Changes tab and click the Change Details %
button.

Relevant tasks |"How to Perform Change Analysis " on page 276

See also "Changes Tab" on page 282.

User interface elements are described below:
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Ul
Elements

(A-Z)

Description

3 < o ¢ Change Navigation. Enables navigation between the changes
for display in the Application Change Details dialog box. The
buttons perform the following actions, from left to right:

e Go to first change
e Go to previous change
e Go to next change
e Go to last change
5 Hy 4B Editing buttons: Spell Check, Thesaurus, and Spelling

Options. For details, see the HP Application Lifecycle
Management User Guide.

Change A unique ID for the change (read-only).
ID

Subject A short title describing the change.

= Details tab. For details, see below.

-
ik

Technical Details tab. For details, see "Application Change
Details Dialog Box - Technical Details Tab" on page 290.

Application Change Details Dialog Box - Details Tab

The Details tab allows you to view and modify all of the fields describing the
change. User interface elements are described below:

ul

Description

Elements(A-

Z)

Affected The component part affected by the change.
part
Affected The part affected by the change: Component, Field,
part type Interface, or Operation.
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ul
Elements(A-

Z)

Description

Assigned to | The user name of the person responsible for the change.
Change ID A unique ID for the change (read-only).
Change The current status of the change. By default, the change
status status is New. Update the status throughout the change
analysis process as follows:
e In test. The change is being tested.
e New. There is a change in the component.
e Obsolete. The change does not affect the component.
e Verified. The change was tested and did not cause a
regression.
Tip: To eliminate the Alerticon next to the component,
change the status of all changes to Verified or Obsolete.
Change The type of change is indicated as follows:
type . .
e Added. New functionality was added.
e Removed. Functionality was removed.
e Updated. Changes were made to existing functionality.
Details of these changes are displayed in the Description
column.
Created by The user name of the person who ran the update that created
the change.
Creation The date on which the change was made. By default, the
date creation date is set to the current database server date.
Creation The time at which the change was made.
time
Default: the database server time at the time of the change.
Cycle The testing cycle in which the change was introduced or in

which the change needs to be verified.

Description
tab

A description of the change and suggested tests to verify.
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ul

Elements(A-

Z)

Description

For operation changes (where AffectedPart Type is
Operation and Change Type is Updated), the change
description contains details of the argument that was added
orremoved from the operation.

Release

The planned release version.

Risk

The business risks and costs associated with the change. A
change can have one of the following risk levels:

e High. Changes that are likely to affect functionality and fail
any test thatis not updated. High-risk changes include
operation removal and parameter changes.

e Medium. Changes that may affect functionality, but may
not necessarily fail existing tests. Medium-risk changes
include changes (notification that some of the component
files have changed).

e Low. Changes that are unlikely to fail or affect existing
functionality or implemented tests. Low-risk changes
include operation additions (as they do not affect existing
functionality), service address changes (deployment only),
and port type changes.

Risk
Description
tab

A textual description of the risk.

Tip: Click Add Comment to create aremark with a name,
time, and date stamp.

Application Change Details Dialog Box - Technical Details Tab

The Technical Details tab lets you compare the contract files and understand
the changes. For details, see "Contract Comparison" on page 273.

User interface elements are described below:
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ul Description

Elements(A-

Z)
<change e Main branch. A hierarchal display of the changes in the
data> schema. The changes are grouped by their type. For

example, allremoval type changes are grouped together.

e Affected derived types. A sub-node showing the
schemas affected indirectly by the changes.

When you expand the tree and select a change, the
comparison window highlights the affected lines in the
original and current schemas.

The tree displays changes in the input and output properties
in separate nodes.

Before The name of the schema file before the change.

change

After The name of the schema file after the change.

change

<original A snapshot of the original XML, showing the changed type or
schema> element.

<changed A snapshot of the changed XML, showing the modified
schema> fragment. The snapshot highlights the modified lines using
the following color scheme:

e Yellow. Changed entity
e Green. Added entity

e Pink. Removed entity
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Create Change Impact Test Set Wizard

This wizard enables you to create a test set for determining the impact of
changes made to an application component.

To access Select Changes tab > Create Test Set.
Relevant tasks |"How to Perform Change Analysis " on page 276
Wizard map The Create Change Impact Test Set wizard contains:

Coverage Page > Test Set Page
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Tests Tree Panel

This tab allows you to add tests to a test set.

Tests Tree ®

algav-»

B Subject
=-JL, Unattached
®=-£5 BPT
H-E5 Integration Testing (5T)
E-E5 Tempaorary Tests
. e w50 Basic Load Testing
L.F3 Unit Testing (AL

To access Do the following:
1. Selectacomponent and click the Changes tab.

2. Selectachange in the list and click the Create Test Set
button.

3. Inthe Create Change Impact Test Set wizard, specify the
coverage details.

4. Click Next to advance to the Test Set wizard page.

5. Click the Select button.

Relevant "How to Perform Change Analysis " on page 276

tasks

See also "How to Link Components to Requirements and Tests" on
page 224

The following elements are included (unlabeled Ul elements are shown in
angle brackets):

ul Description

Elements

=] Add to Coverage. Adds the selected test to the test list.
& Refresh. Refreshes the Tests tree.
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ul Description

Elements

Q Find. Opens the Find dialog box for locating a test by its name
or another criteria. For details, click F1 in the Find dialog box.

AT Set/Clear Filter. Opens a drop down list with the following
options:

e Set Filter / Sort. Opens the Set Filter/Sort dialog box
allowing you to filter and sort the tests.

e Clear Filter / Sort. Clears all filters and sorting settings and

displays all tests.

=] Go to Test by ID. Locates the test whose ID you specify.

X Closes the Tests Tree panel.

To reopen this view, click the Select button.

<Tests A tree view of all of the tests.

tree>
Tip: If a filter is active, there could be hidden components. To

see all components, click Clear Filter.
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Troubleshooting and
Limitations - Changes

This section describes the limitations that affect change analysis.

e The XSD schema comparison detects changes in these common element
types and attributes:

Element

» ComplexType

= Sequence

= SimpleType

= Simple and Complex Extensions

= Enumeration (Restriction - Simple Type)

s Attributes: Name, Type, Ref, MaxOccurs, MinOccurs, Nillable, Id, and
targetNamespace

= Include

Import

e The XSD Schema comparison tool does not detect:

= |f a derived type's data type or name was changed. It only detects changes
that occur in a direct reference to a type—not those derived through
inheritance.

= Changesin RPC-encoded WSDLs.

» Changes within elements that have the same name and context, such as
Sequence.

e When defining a new change in the Changes tab, and selecting
Operation as the Affected part type, the Affected part field does not
provide a drop down list of the available operations.

Workaround: Manually type in the operation name.
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Concepts

e "Service Test Management Reports and Graphs Overview" on page 298
Tasks
e "How to Create and Generate Reports" on page 307

e "How to Generate Graphs" on page 309
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Concepts

This section includes:

e "Service Test Management Reports and Graphs Overview" on page 298
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Service Test Management Reports and
Graphs Overview

ALM's Dashboard module provides you with several ways to generate
summary reports.

Using the standard Document Generator, you can create summary reports of
your test plan and requirements. Use the Tools menu to open the Document
Generator. For details, see the HP Application Lifecycle Management User
Guide.

This section describes the Excel reports that you can generate through ALM,
that are specific to Service Test Management.

Using the capabilities of Excel, you can create data tables and display the
results in graphical form. You can also create custom reports, by designing
Excel-compatible SQL queries.

You can use the data you extract from a query for external applications, such
as running a Visual Basic script to process and analyze the data.

This section also includes:
e Built-in Reports

e Application Component Query Builder Entities
e Application Component Graphs
e Application Changes Graphs

Built-in Reports

Service Test Management provides the following pre-defined reports for
application components:

Report Name Description

Active Changes Exports the project's application components and their
list of active changes.

Application Exports the project's application components and the
Component list of new or open defects which are linked to them.
Defects

Application Exports the project's application components and the
Component list of tests which either use or cover them.
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Report Name Description

Tests

Application Exports the count of application components per a
Components Per |responsible user and displays this data as an Excel
Responsible User | chart

Coverage Exports the requirement coverage of each application
component and the total coverage. The results are
displayed in a table and in a pie chart.

Outstanding Exports the list of changes in the application
Changes components which are in the 'New' or 'In Test' status.
Rule Violations Exports the list of all rules together with components

which violated them.

Web Service Exports the distribution of toolkits which are used by
Components by the Web services.

Toolkits

Web Service Exports the distribution of Web service import types:
Components by File, URL, UDDI, or Systinet.

Type

You can generate the reports as is, or modify them as necessary in the Query
Builder. For details, see "How to Create and Generate Reports" on page 307.

Application Component Query Builder Entities

You can create custom queries on the project's database by choosing
application component related entities from the Entities list. You can add
these queries to an existing report, or create a new one.

Service Test Management adds the following entities to Query Builder's
Entities View: Component Change to Defects, Component Change to
Requirements, Component Folder, Component Param, Component
Step, Component Type, Component Type to Field Relation, Service
Aspect, Service Dependency, Service Folder, Service Group to
Requirement Relation, Service Operation to Component Relation,
Service Operation to Test Relation, Service to Group Relation, Service
to Requirement Relation, WSDL Operation, WSDL Operation

Page 299 HP Service Test Management (11.50)



Service Test Management User Guide

Dependency, and WSDL Operation Parameters. You can create both
private queries or public ones that you can share with other users.

Il Excel Report Query Builder — |EI|5|
5 = =l | % TestGuery S Run Query | oA | ‘ Fincl: I:I e~
Guery2

Entities “iew =

[+

tH Analyzis ttem Folder (AkALY S|~
| Analysiz tems (ANALYSIS_ITE

[+

SELECT SERVICE.3V TOOLEIT /#Service. Toolkit#/ |4 | Asset Relations [ASSET_RELA,

as Toolkit, COUHT [ *)  bsact Fonaator foma (ASSE
H FH

[FROM SERVICE /#Services/ gset Repostory ftems (

=]

| Azsociated (LINK)

| Audit Log (AUDIT_LOG)

| Audit Properties (ALDIT_PROPE
| Bazelines (BASELINES)

| BPT tteration (BP_ITERATION)

| BPT tteration Param (BF _ITER_F
| BPT Step Param (BP_STEP_PAF
| Business Component (COMPON

GROUF BY SERVICE.3V TOOLEIT /#Service. Toolkit#/

|
ElE]

-
4
H &

ol I

Guery Parameters Guery Results

Show results of sheet: Query2

[+

%]
H

[+

E— | | Comimon Step Params (COMPOI
[as]
1 | Comparizon (COMPARISONS)
MET 11 | Comparizon Mode (COMPARISC
s 7 £ Component Folder (componl%a

I Ok || Cancel || Help |

For example, you could create a pivot table to summarize component-related
data, such as to display in tabular format the status count for the different
coverage statuses.

Once you generate an Excel report, you can use the full capabilities of Excel
to display the results in graphical form, such as bar or pie charts.

For task details, see "How to Generate Graphs" on page 309.

Application Component Graphs

You can create custom graphs for the Application Component module using
Service Test Management's built-in graphs. You can create Progress,
Summary, and Trend graphs for the application components and for the
application component changes.

The graph's Configuration tab lets you customize the graphs by setting the x
and y axis, filtering the data, and grouping the results.

Summary Graphs

In Application Component Summary graphs, you can configure the x-axis to
display one the following fields: Assigned to Dev, Assigned to QA,
Authentication default credentials, Created by, Development status, Has
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changed, Import type, JMS provider, JMS transport, JNDI initial context
factory, Keep up to date, Messaging model, Override address, Proxy default
credentials, Toolkit, Use authentication, Use proxy, Visibility, QC Project, or
other fields that you defined in customization.

You can configure the y-axis to display
e A Count of the Application components
e A Sum of the custom fields, defined in the Customization module

Service Test Management also allows you to filter the graph by all system and
UDF fields defined for the Application Component entity.

The following Summary graph shows the number of components assigned to
QA as a function of the total number of components.

Sample Summary

120 114
M General[1]

2 100 W ms[3]
o 1 Web Service[7]
2
£ a0
L]
=
e
S 60
o
o
E
5 40
5
=
S
= 20

=unknown= ||

Assigned to QA

Progress Graphs
You can setup a Progress graph to plot the number of application
components against a time interval.

You can configure the x-axis to display a time interval: Last 7 days, Last 5
weeks, Last 12 months, or All days.

You can configure the y-axis to display
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e A Count of the Application components
e A Sum of the custom fields, defined in the Customization module

You can group the results by the following criteria: Assigned to Dev,
Assigned to QA,Authentication default credentials,
Development status, Has changed, Import type, JIJMS provider,
JMS transport,JNDI initial context factory, Keep up to
date,Messaging model, Override address, Proxy default
credentials, Toolkit,Use authentication,Use proxy, and

Visibility.

The following Progress graph shows the time interval of the application
components as a function of the total number of components. The colored
lines indicate the various types of application components: General, JMS,
Web Service, and so forth.
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Trend Graphs
You can setup a Trend graph to plot the trend of application components
against a time interval.

You can configure the time period to: Last 7 days, Last 5 weeks, Last 12
months, or All days.
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You can configure the groupingto: 211 fields,Assigned to Dev,
Assigned to QA,Authentication default credentials,
Development status,Has changed, Import type, JMS provider,
JMS transport,JNDI initial context factory,Keep up to
date,Messaging model,Override address, Proxy default
credentials, Toolkit,Use authentication,Use proxy, and

Visibility.

The following Trend graph shows the different component types as a function
of their creation dates.

Trend Sample
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Application Changes Graphs

You can create graphs to plot the application's changes using Service Test
Management's built-in graphs. You can create Progress, Summary, and
Trend graphs for the application components and for the application changes.

Summary Graphs

In Application Changes Summary graphs, you can configure the x-axis to
display one the following fields: Affected part type,Assigned to,
Change status,Change type,Created by,Cycle,Release, Risk,
and QC Project.

The y-axis displays the number (Count) of application changes.

You can filter the graph by all of the fields, including all system and UDF fields
defined for the entity, suchasAffected part type,Assigned to,
Change ID,Change status,Change type,Created by,Creation
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date,Creation time,Cycle,Release,Risk, Subject, or custom
fields.

You can group the results by the following criteria: Affected part,
Affected part type,Assigned to,Change status,Change type,
Created by,Creation date,Creation time,Cycle, Release,

Risk,orQC Project.

The following ChangesSummary graph shows the number of risks, grouped
by the risk level, as a function of the total number of changes.

Changes Summary Sample
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Progress Graphs

You can setup a Progress graph to plot the number of application changes
against a time interval.

You can configure the x-axis to display a time interval: Last 7 days, Last 5
weeks, Last 12 months, or All days.

The y-axis displays the number (Count) of application changes.

You can group the results by the following criteria: Assigned to, Change

status,Cycle,Release, Or Risk.

The following ChangesProgress graph shows the time interval of the
application components as a function of the total number of components. The
colored lines indicate the various levels of risk: High, Low, and Medium.
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Changes Progress Sample
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Trend Graphs
You can setup a Trend graph to plot the trend of application changes against
a time interval.

You can configure the time period to: Last 7 days, Last 5 weeks, Last 12
months, or All days.

You can configure the groupingto: A11 fields,Assigned to,Change
status,Cycle,Release, and Risk.
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Tasks

This section includes:
e "How to Create and Generate Reports" on page 307

e "How to Generate Graphs" on page 309
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How to Create and Generate Reports

This task describes how to create reports using ALM's built-in reports for
application components.

This task includes the following steps:
e Generate a pre-defined report
e Create a custom report based on a pre-defined report

e Create new Excelreports

Generate a pre-defined report

Use the Dashboard module to generate pre-defined Excel reports.
1. Openthe Dashboard > Analysis View module.

2. Selectareport from the Public/stm-reports folder.

-l 2 P [ ‘ b 4 ‘ & B Generate

3 Private

=5 Public

B stm-reports

-5 Application Components Sample Repa
e Application Components Sample Repo
-5 Application Components Sample Repo
-5 Application Components Sample Repo
-[5 Application Companents Sample Repo
~[5 Application Companents Sample Repo
-[5 Application Components Sample Repo
-[5 Application Components Sample Repo
----- [5 Application Compaonents Sample Repo

4 il b
3. Click Generate. Specify a location for the Excel report.
Create a custom report based on a pre-defined report
You can use an existing report as a basis for creating a custom report.
1. Openthe Dashboard > Analysis View module.
2. Selectareport from the Public/stm-reports folder.

3. To customize a built-in report without providing access to other users,
copy it to the Private folder and rename it.
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7.

8.

To customize a built-in reports and allow everyone to access your report,
keep itin the Public folder.

Open the Configuration tab in the right pane, and click the Query
Builder button.

Select an entity in the right pane's Entities View and expand it.

Drag the desired parameter to a location within the SQL statement. Modify
the SQL as required.

Click OK to save it and close the Query Builder.

Click Generate and specify a location for the Excel report.

Create new Excel reports

You can design a new report without basing it on a pre-defined one.

1.

2.

Open the Dashboard > Analysis View module.

Click on the target folder and subfolder:

» Private: Reportis only available to current user.

= Public: Reportis available to all users of the project.

Choose Analysis > New Excel Report. Specify a name for the report.
Click Query Builder. ALM opens the Entity View in the right pane.

Select an entity in the right pane and expand it to view the parameters. For
a list of entities, see "Service Test Management Reports and Graphs
Overview" on page 298.

Drag a parameter to a location within the Query Builder editor. Modify the
SQL as required.

Use the Test Query and Run Query button to test and run the query.

Click OK to save the report. You can open this report and run the query at
a later time.

For details on how to customize the Excel reports, see the HP Application
Lifecycle Management User Guide.
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How to Generate Graphs

This task describes how to create graphs for your Application Components
and the changes associated with them.

This task includes the following steps:

e Openthe New Graph dialog box

Configure the graph

Select different projects - optional

View the Graph
Open the New Graph dialog box
Use the Dashboard module to generate pre-defined graphs.
1. Openthe Dashboard > Analysis View module.
2. Select Analysis > New Graph (Ctri+G).

Entity:

|App|icati0n Components | - |
Graph Type:

| Summary Graph | - |

Graph Name:
|Samp|e Graph |

3. Select an Entity - Application Components or Application Changes.

4. Selectagraph type: Summary Graph, Progress Graph, or Trend
Graph.

5. Specify a graph name and click OK.
Configure the graph
1. Click the Configuration tab in the right pane.

2. Select values for the relevant fields.
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Details Cunfiguratic:n| e

X-Axis |Assigned to Dew | - |
r-Aus: |Cuunt | |App|i|:atic:n Components |
Grouped By |CDmpDnentlype | - |

For details about the configuration options, see "Service Test Management
Reports and Graphs Overview" on page 298.

Select different projects - optional

To plot graphs using data from other projects, click Select Projects in the
bottom right pane, and select the relevant project.

View the graph
Click the View tab to view the graph.

For more information on graphs, see the HP Application Lifecycle
Management User Guide.
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